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1 Introduction

1.  Introduction

This user-friendly  software  provides  a  powerful  tool  to  access  information  and  analyze
data. As soon as Serviceware Performance Analytics (Performance  Analytics)  is  installed
on  your  computer,  you  will  be  able  to  understand  data  in  new  ways.  You  will  view
information from different perspectives, as often as you like, with the  latest  up-to-date
figures. You can analyze  information in many ways and focus on key result areas of  your
own choice. With growing familiarity you will  be  able  to  customize  your  own  reports  or
have Performance Analytics do  dynamic  analyses  of  results  important  to  your  decision-
making.

Data is made available in views that are organized in a folder structure. Depending on the
security set by your system administrator,  it is possible  to create  new folders and views.
You  can  keep  folders  and  views  to  yourself  or  make  these  available  to  others.  It  is
possible  to create  exception reports and customize these  with  colors  to  focus  attention
and trigger action. You can quickly generate  calculations  using  timely,  up-to-the-minute
data,  make  charts,  drill  up  or  down  to  investigate  your  financial  or  operational
information or drill through to your relational  data. You can then save or discard these as
you wish.

Performance Analytics client is available  as an ActiveX edition  and  an  HTML  edition  and
contains the Performance  Analytics  client  to  display  views.  A  view  item  is  displayed  in
Performance  Analytics  client,  showing  the  data  stored  in  the  OLAP  database.  The  AL
Anywhere version does not use the ActiveX control but has a reduced functionality.

This  document  is  intended  for  use  with  Performance  Analytics.  Performance  Analytics
provides  you  with  a  powerful  tool  to  improve  business  results.  Your  systems
administrator  or  supervisor  will  give  you  access  to  one  or  more  sources  of  your  data
residing in the database of your organization.

Audience
Performance Analytics is meant for  users  who  are  familiar  with  the  Microsoft  Windows
environment,  but  not  interested  in  programming  or  working  up  detailed  spreadsheet
calculations.

Forward-looking statements
This  documentation  describes  the  current  functionality  of  the  product.  References  to
items  that  are  not  currently  available  may  be  included.  No  implication  of  any  future
availability should be inferred. Any such references  are  not  a  commitment,  promise,  or
legal obligation to deliver any material, code, or functionality. The development, release,
and timing of features or functionality remain at the sole discretion of cubus.

Accessibility features
Accessibility features help users who have a physical disability, such as restricted mobility
or limited vision, to use  information  technology  products.  This  product  has  accessibility
features.  For  information  on  these  features,  see  the  accessibility  section  in  this
document.  HTML  documentation  has  accessibility  features.  PDF  documents  are
supplemental and, as such, include no added accessibility features.
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Samples disclaimer
The Great Outdoors Company, GO Sales,  any variation of  the  Great  Outdoors  name,  and
Planning Sample  depict fictitious business operations with sample  data used to  develop
sample  applications  for  cubus  and  cubus  customers.  These  fictitious  records  include
sample  data  for  sales  transactions,  product  distribution,  finance,  and  human  resources.
Any resemblance to  actual  names,  addresses,  contact  numbers,  or  transaction  values  is
coincidental.  Other  sample  files  may  contain  fictional  data  manually  or  machine
generated,  factual  data  compiled  from  academic  or  public  sources,  or  data  used  with
permission  of  the  copyright  holder,  for  use  as  sample  data  to  develop  sample
applications.  Product  names  referenced  may  be  the  trademarks  of  their  respective
owners. Unauthorized duplication is prohibited.
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2.  System overview

Performance Analytics is an intuitive  and powerful  tool  that  gives  access  to  information
from analyzed data.  Performance  Analytics  allows  you  to  understand  data  in  new  ways
and from different  perspectives  using  the  most  recent  data.  Performance  Analytics  can
receive information in many ways in order to focus on key result areas of your choice. You
can  customize  reports  or  have  Performance  Analytics   do  dynamic  analyses  of  results
important to the decision-making process.

System introduction

Performance Analytics has the following components or  items  to  display  information  in
either graphical or tabular formats:

Views display the requested data that is stored in the OLAP database.

Canvases contain panels. The panels contain views that can communicate  with each
other, enabling you to create dashboard applications.

Dimensions group related data together in a View.

Members are single types of data. Members are grouped together in a Dimension.

Canvases

Canvases  contain  panels.  The  panels  contain  views  that  can  communicate  with  each
other, enabling you to create dashboard applications.

Views

The view is the work space that is defined by the user. The view is the primary place that
data is made available and resolved into purposeful information. A view is a collection of
dimensions. Many related views share  common dimensions, for example, time intervals,
is the unique dimension that gives purpose to the view.

The OLAP database is represented by a cube. The cube is a subset of  the data in the OLAP
database.

The  view  shows  the  data  from  the  cube  that  is  stored  in  the  OLAP  database.  A  view
connects to a database. A database connects to a data source.

Views  can  be  organized  in  folders  and  stored  in  the  repository  where  the  data  source
items  and  database  items  are  stored,  as  well  as  locally  on  your  own  system.  It  is  also
possible to export views to a workbook in Microsoft Excel.  There are  various printing and
formatting options for views.

Warnings
A warning is shown in a view when Performance Analytics  encounters a problem or when
important items have changed. For example  when the connection to the server is lost or
when dimensions have been added to or removed from the database.

Warnings can be saved and displayed later.
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Notes
The OLAP administrator can add database notes to the OLAP database. When a view is on-
screen, any information that is relevant to the view can be displayed as a note. A note  can
be used to provide information about the status of the database and the contents.

There are various printing and formatting options for notes.

Dimensions

A  dimension  contains  the  related  items  that  describe  either  the  context  of  a  fact  or  a
measure of  a fact.  Context  dimensions  can  include  time,  product,  person,  and  location.
Measure dimensions can include quantity and value. Dimensions can form a  hierarchical
structure,  for  example,  the  dimension  location  can  include  country  or  region,  city,
building, and floor.

The maximum number of  dimensions and hierarchies is 512. If  dimensions contain more
than  8.000.000 members,  then  the  maximum  number  of  dimensions  is  decreased  with
one for each of these dimensions.

Attribute dimensions (Essbase only)
Attributes  are  characteristics  of  your  data  such  as  size,  and  are  added  as  separate
dimensions. The purpose of attributes is that you can view the details of an attribute from
the perspective of the connected dimensions.

You can view available attribute dimensions in the Member Select dialog.

Members

A dimension is subdivided into members. A list of members in the same hierarchy form a
dimension. For example, the months January, February, March are  members that belong
to the member "Quarter 1". Quarters 1, 2, 3 and 4 are aggregated into the member "Year".
All  are  part  of  the  time  dimension.  Members  are  divided  into  inspread  members  and
offspread members.

The maximum number of members is 16.000.000.

Inspread members
The  inspread  members  are  the  members  that  show  directly  in  the  visible  table.  For
example,  if  the  members  for  time  and  product  show,  the  inspread  members  can  be
month plotted against product type.

Offspread members
The offspread members are  those members to be evaluated. If  month and  product  type
show directly in the table as inspread members, the offspread member can be a location.
For  example,  if  "Germany"  is  the  offspread  member,  the  table  will  show  time  against
product sales for the member "Germany". If  the offspread member is changed to "Italy",
the table shows time against product sales for "Italy".

Substitution members (Essbase only)
For substitution members you can set a substitution variable that will allow you to change
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the  name  of  the  substitution  member  directly  from  the  database.  For  example,  the
substitution  member  "CurrentMonth"  can  be  populated  with  the  name  "August".  Next
month,  if  the  value  of  the  substitution  variable  is  changed  in  Essbase,  the  same
substitution member will then be populated with the name "September".

Member properties (SSAS only)
In  Microsoft  Analysis  Services  it  is  possible  to  define  one  or  more  properties  for  a
member  in  a  dimension.  Properties  may  include  information  such  as  market  type,
geographical region etc. It is possible to search on properties.

Alias tables
The Performance Analytics server can use unique member names for the members of  an
OLAP database. The member names shown in  Performance  Analytics  do  not  have  to  be
the same as these unique member names. An alias table  tells the Performance Analytics
server how to match the member names in the database to the member names shown in
Performance Analytics.

Folders

Folders  are  used  to  organize  items  in  a  structure,  for  example  views.  Folders  can  be
stored in the repository where the data source items  and  database  items  are  stored,  as
well  as locally on your own system. A folder can contain  child  items  of  all  defined  item
types to organize views and other items in the repository.

System requirements Serviceware Performance Analytics client

To install the Performance Analytics Client the system requirements should be met.

For more information see "Performance Analytics Client requirements" in the Serviceware
Performance Analytics Server Installation and Administration Guide.
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3.  Getting started

This  section  describes  how  to  get  started  with  Performance  Analytics.  Performance
Analytics is used to analyze data from an OLAP data source.

Figure 1 : Ribbon User Interface

Figure 2 : Backstage of Ribbon Style User Interface
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The  Ribbon  contains  the  set  of  commands  for  working  in  a  view  or  canvas  while  the
Backstage part is the set of commands you use to do things to a view or canvas.

Start the Performance Analytics client to see the Backstage.  The  Backstage  is  where  the
views  and  canvases  are  managed,  for  example,  create,  save,  export,  print  views  and
more.

The following chapters describe the functionality of Performance Analytics.

Working with connections in Performance Analytics client

Each view must be connected to a data source before it can be used.

Starting the Performance Analytics client

Performance Analytics client can be installed in several ways.

For more information, see the Serviceware Performance Analytics Server  Installation  and
Administration Guide.

After an express installation, you can start Performance Analytics from the start menu.

Note: When you run Performance Analytics on Microsoft Windows Server 2012, then you
can get the following message: 
"An add-on for this website failed to run. Check the security settings in Internet Options for
potential conflicts.". 
To solve this, you have to add the Performance Analytics Server URL to the trusted sites in
your internet browser.

Procedure AL Client
Click Start > All Programs > Serviceware Performance Analytics > AL Client.

Procedure AL Desktop
Click Start > All Programs > Serviceware Performance Analytics > AL Desktop.

Making a new view

You have the possibility, to make a new view.

Procedure
1. Click the New command.

2. Select the Shared Templates section.

3. Select the View template to create an empty view.

4. In the Connection Information dialog box, select a Server.

5. In the Connection Information dialog box, select a Database.

If there is more than one cube in the selection list, select the cube you want.

Click OK.

6. Save  the  view  either  by  selecting  Save  in  the  Backstage  or  the  Save  in  the  mini
ribbon toolbar in the upper left area of the screen.
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Changing connections of a view

After you have made a new view, you need to make a connection to a valid cube.

Procedure
1. In the backstage click the Open command.

2. Select a view or folder from one of  the locations Local  Views,  My  Views  or  Shared
Views  and select  the  view  by  clicking  on  it.  If  you  move  the  mouse  over  a  folder
than click on Open all views or do a double click, all views in the folder are opened.

3. Select the SOURCE tab from the ribbon.

4. Select the Connection button.

5. Select  a  database  from  the  Database  list  on  the  Connection  Information  window
and click OK.

6. In the Credentials window, enter your security credentials to access the server and
click OK.

Opening more connections

You can connect to a different cube from the Performance Analytics client.

Procedure
1. Select the SOURCE tab from the ribbon.

2. Select the Connection button to connect to a different cube

3. On the toolbar click the Connection button to connect to a different cube.

4. On the Connection Information window, select the cube to change the  connection
to the server.

5. To  clear  the  credentials,  including  passwords,  for  the  server,  click  Forget
Credentials.

Connecting to an MS.cub file (SSAS only)

A  cub  file  is  an  extract  from  a  Microsoft  Analysis  Services  database  in  the  format  of  a
portable, multi-dimensional  database. This feature  facilitates the use of  Microsoft cubes
without the need for a full installation of Microsoft Analysis Services.

When connecting to a cub file that is not located in the Default Location directory, include
the path of the cub file in the Connection Information dialog.

Note: Only one connection at a time can be made to a cub file.  This is a restriction of  the
cub files. Only local views can connect to a cub file.

Procedure
1. Open or create a new view.

2. Select the SOURCE tab from the ribbon.

3. Select  the  Connection  button  to  connect  to  a  different  cube.   In  the  Connection
Information window, type <cub file name>.cub.
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Click on Login.

4. The available database shows in the Database section.

5. Select a database and click OK.

Working with views, folders, and canvases

Views,  folders,  and  canvases  can  be  stored  either  on  your  own  computer,  or  in  the
Performance Analytics repository.

For  information  about  canvases  see  Dashboards.  You  can  create,  rename,  and  delete
views, folders, and canvases in the backstage or on the Views dialog box.

The Open section in the Backstage contains the following locations:

Recent Views
Contains a list of  views and canvases that have been opened recently or pinned as
favorites.

Local Views
Contains  a  list  of  views  and  canvases  stored  locally  on  your  client  system.  Local
views are not supported in Recent Views and Favorites.

My Views
Contains a list of views and canvases stored in the private folder of the server.

Shared Views
Contains a list of shared views and canvases stored in the server repository.

My Templates
Contains a list of predefined templates only available for the logged in user.

Shared Templates
Contains a list of predefined templates available for all users.

Open Views
Contains a list of all the views and canvases that are currently open.

Note: 

The  folders  "Recent  Views",  "My  Views"  and  "My  Templates"  are  only  visible,  if  the
permission is set for the user  role.  For  more  information  see  "Available  Permissions"  in
the Serviceware Performance Analytics Server Installation and Administration Guide.

The Open Views dialog box contains three tabs:

Local Views
Contains a list of views and canvases stored locally on your client system.

Shared Views
Contains a list of shared views and canvases stored in the server repository.

Open Views
Contains a list of all the views and canvases that are currently open.

The Views dialog box shows the following icons:
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Icon Description

Folder icon

Closed view icon

Canvas icon

Setting the local views location

To change the address of the default folder for Local Views, follow these steps.

Procedure
1. Select the Open section in the backstage.

2. Select the location Local Views.

3. Select the Location button in the upper right corner of the screen.

4. The location is the directory on your PC or on your network where your Folders and
Views are stored.

5. Change the location as required.

6. Click OK.

Creating a new view, folder, or canvas

You can create new views, folders, or canvases.

Procedure

Create a view or canvas

1. Select the  New section in the backstage.

2. Select the template location either My Templates or Shared Templates.

3. Select one of the existing templates to create a view or canvas.

Create a view from within an opened view

1. On an already opened view rightclick the title bar of the view

2. Click on Insert New

3. A new view will be created in the current folder with the name New View.

Create a folder

1. Select the Open section in the backstage.

2. Select the location where you want to create the folder.

3. Select the Create new folder icon to create a new folder.

4. Type the name for the folder. 

5. Click on OK.
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Create a custom view or canvas template

1. Follow the steps defined in Create a view or canvas out of a template.

2. Define some formats in the  FORMAT  ribbon.  For  instance  background  colors,  font
styles, borders, etc.

a. All the settings that are made in the FORMAT ribbon (e.g. in the sections Format,
Default  Styles,  Scaling,  Headers,  etc.)  will  be  stored  in  the  template.  Other
settings of  the view (like  Chart Options or Suppress Rows)  will  not be stored  in
the template. 

3. Click on VIEW > Save As

4. In the Save View / Canvas As dialog activate the checkbox Save as template 

5. Define a name and click OK.

Renaming a view, folder, or canvas

You have the possibility to rename views, folders, or canvases.

Procedure
1. Select the Open section in the backstage.

2. Select the location where you want to rename the view, canvas or folder.

3. Move the mouse pointer over the view, canvas or folder  you  want  to  rename  and
select the Rename item icon.

4. Type the new name for the item.

5. Press Ok.

Deleting a view, folder, or canvas

You have the possibility to delete views, folders, or canvases.

Procedure
1. Select the Open section in the backstage.

2. Select the location where you want to delete the view, canvas or folder.

3. Move the mouse  pointer  over  the  view,  canvas  or  folder  you  want  to  delete  and
select the Delete item icon.

4. Confirm the deletion by pressing Ok.

Saving a view or canvas with a different name

You have the possibility to save a view or canvas with a different name.

Procedure
1. Select the Open section in the backstage.

2. Select the view or canvas.

3. Click the Save As command in the backstage.

4. Type the new name of the view or canvas and define the location

5. Click OK.
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Copying a view, folder, or canvas

You have the possibility to copy views, folders or canvases.

Procedure
1. Select the Open section in the backstage.

2. Select the source location where you want to make a copy of a view or canvas.

3. Move the mouse pointer over the view or canvas you want to  copy  and  select  the
Copy item icon.

4. Move the mouse pointer over the  destination  folder  where  you  want  to  save  the
view or canvas and select the Paste item here icon.

Procedure (View context menu)
1. On an already opened view rightclick the title bar of the view.

2. Click on Insert Copy.

3. A copy of that view will be  created in the current folder with the name prefix  Copy
of.

Note: Views that  are  created  via  Insert  Copy  are  not  temporary,  but  will  remain  in  the
folder structure, even if they are not saved.

Go back to the last saved view

You can always return to the view as it appeared when it was last saved.

Procedure
1. Using the Reload function. This function is available via the Views dialog, by clicking

the Views button.

2. Select the view you want to reload and click Reload.

3. After clicking Reload, the view is reloaded.

Working with Subscriptions

The Subscriptions section in the Backstage enables users to configure  reports  which  will
generated and sent by Email  at the scheduled  times.  This  functionality  is  only  available
when a mail server was configured. Detailed information about configuring a mail  server
can  be  found  in  the  Serviceware  Performance  Analytics  -  Setup,  Installation  and
Administration Guide.

The configuration of  a subscription is divided into three tabs, which will  be  explained in
the next chapters.

The following buttons are available above those tabs:

Save

Saves the newly created or updated subscription. 
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Delete

Deletes the currently selected subscription.

Open all views

Opens all Views that are part of the currently selected subscription.

Execute

Executes  the  currently  selected  subscription  immediately  (independent  from  the
defined schedule). Only saved subscriptions can be executed.

Document Options

General

Subscription Name

Name of the subscription 

Document Name

Name of  the file  that will  be  attached to the mail.  If  document format is  PDF,  also
the title of the front page.

Username

User for authenticating against the database(s) accessed by the configured views.

All views of a subscription will be opened with the user defined here. If you want to
include views from different databases, make sure  the same user is configured for
all databases.

Password

Password of the database user.

Options
Document Format

Format of the file that will be attached to the mail. Choose between PDF (*.pdf) and
Excel (*.xlsx).

Table of Content

Adds a table of content to the beginning of the document.

Front Page (PDF only)

Adds a front page to the beginning of the document.

Headers & Footers (PDF only)

 Adds headers and footers to the document.

Paper Size (PDF only)

Defines the paper size of the document.

Orientation (PDF only)

Defines the page orientation of the document (Portrait or Landscape).

Schedule & E-mail

E-mail

To

Addressee(s) for the subscription mail. Multiple mail addresses can be separated by



14Getting started

comma or semicolon.

From

Sender address of the subscription mail.

Subject

Subject of the mail.

Body

Message, that will be sent with the mail. 

Schedule

Enabled

Defines whether the subscription shall  currently be executed at the defined times
or not.

Start At

Defines the time for the execution of the subscription on the days defined.

Scheduling 

Defines on which days the subscription shall  be  executed (a subscription mail  shall
be  sent).  Schedules can be on a daily,  weekly,  monthly or yearly  basis.  Depending
on the chosen option, more detailed settings can be configured (e.g. weekly,  every
2 weeks, on Monday and Friday).

Views & Print Range

Views

One  or  multiple  views  can  be  selected  for  the  generation  of  the  report  that  will  be
attached to the subscription mail. Views can be selected in the following areas:

Shared Views

My Views

Open Views

Note: Local Views cannot be attached to subscription mails.

Print Range

The print range can be configured in one of the following ways:

Use as stored in view

Use view print range

Use subscription based print range
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4.  Using Serviceware Performance Analytics

The language of the client is determined by the browser language.

Non-supported languages will default to English.

The language can be overwritten with the URL parameter culture.

Example: https://<SERVERNAME>/EVServer?ToolBar=true&TabBar=True&culture=en

Supported languages are:

Language Parameter
Danish da
German de
English en
French fr
Dutch nl
Spanish es

User interface and appearance

Ribbon
The  ribbon  style  contains  the  ribbon  and  backstage  instead  of  the  toolbar.  All  other
sections are identical.

Figure 3 : Ribbon Style User Interface

Ribbon

The ribbon consists of the following tabs:

NAVIGATE

https://<SERVERNAME>/EVServer?ToolBar=true&TabBar=True&culture=en
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MEMBER

LAYOUT

FORMAT

SOURCE

COMMENTS (if user authorized)

CANVAS (if canvas selected)

All buttons, list boxes, check boxes and menus provide tooltips describing their functionality.

View Context Menu

When right clicking the view tab, a context menu will show up, that provides a fast access to
several actions that are also provided by the ribbon.

Database
o Database Connection...

o Choose Alias Tables...

o Refresh Data

o Execute...

o Database Notes...

o Audit Report...

o Warnings...

Save
Save As...
Insert New
Insert Copy
Delete
Rename...
Close
Move View to new Panel
Print...
Export to Excel Workbook...
Copy
Copy without headers
Paste
View Comments
About Serviceware Performance Analytics...

Theme settings

You can change the way a view looks by either manually changing the individual items, for
example colors and fonts, that are used or by specifying a theme.

A theme offers a predefined set visual  settings. There are  several  themes from which to
choose from.

Changing the theme
For the Ribbon style you can choose from the following themes:

Cubus 
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Classic     

Ocean

Desert

Forest

Olive

Silver

Sky

The theme can be set with:

The theme property of  the Performance Analytics Client API.  For more information
see the Serviceware Performance Analytics Client Integration Guide.

A specified URL: Add &Theme=<ThemeName> to your URL, e.g. $Theme=Forest.

Setting the data window

The  number  of  rows  and  columns  that  appear  in  the  table  depend  on  the  selected
members of the inspread dimensions.

In order to enhance the performance of  a view, the number of  rows and columns can be
set to a maximum. The default values are  1000 rows and 250 columns. If  there  are  more
rows or columns to be shown than the specified rows and columns, arrows that  indicate
there are still more rows and columns.

Changing the data window

You can change the data window by using the arrows on screen.

Procedure
1. Click the arrows to expand the rows or columns by the specified amount.

2. Shift-click the arrows to show all rows or columns. The number of rows and columns
now depends on the selected members of the inspread dimensions.

Note:  When  printing  or  exporting  to  Microsoft  Excel  the  data  window  setting  is
ignored. All rows and columns are processed.

Setting the number of rows and columns for the data window

You can specify the number of rows and columns that are displayed.

Procedure
1. Open the Options dialog box.
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2. Click the Data tab.

3. In the Data Window section of the tab, enter the number of  rows and columns that
you want visible in the Data Window table.

If  you  want  to  display  all  available  rows  and  columns  in  the  data  Window  table,
enter 0 for both Rows and Columns.

Choosing Alias Tables

You can choose between available alias tables in a view. You do this via the Choose Alias
Tables dialog box.

Procedure
1. To open the Choose Alias Tables dialog box either:

Right-click the view tab and choose Database > Choose Alias Tables or

Right-click a cell in the view and choose Extra > Choose Alias Tables

2. In the Choose Alias Tables dialog box move the alias tables from the Available Alias
Tables list to the Selected Alias Tables list.

Changing the order of stacked alias tables

If  there  are  multiple  alias tables available  in  the  database,  you  can  change  the  order  in
which the alias tables are used.

The following rules apply for the assignment of aliases to member names:

The order in which the tables in the Selected Alias Tables list are  used, is from top
to bottom.

If  an  alias  table  has  no  alias  defined  for  a  member,  the  next  alias  table  in  the
Selected Alias Table list will be used.

The member name is used if there is no alias for that member in any of  the selected
alias tables.

Procedure
1. Open the Choose Alias Tables dialog box.

2. Use the up and down buttons to change the order in which the alias tables are used.

This enables  you  to  use  combinations  of  alias  tables  to  assign  aliases  to  member
names.

3. Click OK to confirm the settings for alias tables.

Note:

If you want to display the Essbase server member names (not the aliases),  move all
alias tables to the Available Alias Tables list.

When  connecting  to  other  OLAP  Servers,  Performance  Analytics  uses  unique
member names. The (unique)  member names are  displayed  when  all  Alias  Tables
are moved to the Available Alias Tables list.
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Changing the backgrounds of headers and cells

You can use gradient backgrounds to change the appearance in headers and cells.

The  headers  are  the  areas  in  the  view  that  show  the  names  of  the  dimensions  and
members. The cells show the actual data.

Procedure
1. Open the Options dialog box.

2. Click the Format tab.

3. In the Background section, you can choose whether you want the cells and headers
to use gradient colors.

Changing the zoom percentage

In order to enlarge the view, you can set the zoom percentage.

Only data in the cells can be zoomed into. Charts are  not affected by changing the zoom
percentage.

The zoom factor is independent of the formatting applied (for example the font size).

Procedure
1. Open the Options dialog box.

2. Click the Layout tab.

3. Set the Zoom Percentage.  You can use values from 10 to 400%. The default value is
100%.

4. Set the Chart Zoom Percentage. The Chart Zoom Percentage is used to set the zoom
percentage of the chart only. You can use values from 10 to 400%. The default value
is 100%.

Displaying database notes

Database notes can be used to display information about the status of  the database  and
its contents. The OLAP administrator  or  supervisor  can  add  database  notes  to  the  OLAP
Database.

Procedure
1. Right-click in a view and choose Extra > Database Notes.

The database notes and description will be displayed.

Adding a title to a view

A title describing the content of a view can be added.

The title consists of two lines: a main title and a sub title. 

Every title line has individual formatting properties (e.g. font size, text color).

Printing codes can be used to make the title dynamic (e.g. name of the current member of
an offspread dimension with the code  #o()).  The  list  of  codes  can  be  found  in  Defining
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Headers and Footers.

Note: Not all codes from the printing can be used. Valid codes are  displayed in the dialog
menu next to the lines.

Procedure
1. To add or change the title  on your view select the LAYOUT ribbon and click  on  the

expander to open the Options dialog with the layout settings.

2. Click the Show Title check box to enable the title in the view.

Rowset action on cells

With the actions feature in Microsoft Analysis Services you can attach an action to a cube
or a portion of a cube can be attached.

Performing a rowset action on cells
If rowset actions are created in Microsoft Analysis Manager and drill through is enabled in
Microsoft Analysis Services, you can run the rowset action in a view.

When creating an action in the Microsoft Analysis Manager, the type for this action can be
selected. Rowset actions, attached to cells in a cube, are  supported in a  view.  A  rowset
action is an action that returns a set of  data rows that  a  view  shows  in  the  drill  through
pane. An MDX statement defines which rows are returned.

Procedure
Right-click  a  cell  in  a  view  and  choose  Actions  >  Drill  Trough  <rowset  action  name>.
Where <rowset action name> is the action name that is defined in MS Analysis Manager.

You have now drilled through to the relational data source.

It is also possible  to select the available  rowset actions from the Script drop-down menu
in the Drill Through pane.

Enabling audit reports

You  can  keep  an  audit  report  in  a  view  in  order  to  see  a  description  of  the  actions
performed to achieve the current member selection.

The audit report gives an explanation of the current view. It is not meant to be a log file of
the actions performed in a view. It allows you to verify the interpretation of the report.

Initially the following information is shown:

Database, Server and User, including date and time

Inspread and offspread selections as well as hidden dimensions

Date and time of data retrieval

Relevant options, such as group size, decimal separator and Thousand separator.
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All  information that is necessary to understand the way the current  view  was  created  is
added to the audit report.

Procedure
1. On the Data tab of the Options window, select Audit Report.

2. To  view  the  audit  report,  right-click  the  table  and  click  Extra  >  Audit  Report.  The
Audit Report dialog box is displayed.

3. To reset the audit report, click the Reset button on the Audit Report dialog box. The
list of Undo actions are also reset.

Named sets (SSAS only)

The  Find  Members,  dialog  box  lets  you  locate  and  select  members  based  on  specific
criteria.

When connected to Microsoft Analysis Services, you can also use the dialog box to search
on Named Sets.

Note:  Performance  Analytics  only  searches  Named  Sets  that  contain  members  from  a
single dimension.

Procedure
1. Open the Find Members dialog box.

2. Select Named Sets from the list of Match options.

Note: Named Sets is available  only  when  Named  Sets  are  defined  for  the  current
dimension.

3. Choose a Named Set from the pull-down menu.

4. Click Find to locate  the first member in the selected Named Set. You can then click
Find Next to find subsequent members

5. Click Find All to find all members in the Named Set at once

Opening the About Dialog

The about dialog provides the currently installed Performance Analytics Client version and
copyright notice.

Procedure
1. To open the About Dialog perform the following actions:

Click on VIEW in the ribbon.

Click on About in the backstage menu, which is on left hand side of  the screen to
open the About Dialog.

Members

The  selected  members  determine  the  data  that  is  displayed.  The  charts  also  are
dependent on the selected members.
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Initial member selection

When a database  is  initially  opened,  one  dimension  is  placed  on  the  columns  and  one
dimension is placed on the rows.

This  is  referred  to  as  the  inspread  selection.  All  other  dimensions  are  placed  in  the
offspread  area. In the following image, the members Measures  and Year  are  part  of  the
inspread  selection.  The  dimensions  Product,  Market  and  Scenario  are  part  of  the
offspread area.

When a database is opened, Performance Analytics checks if  a  time  and  a  measures  (or
account) dimension are  available. If  these dimensions are  available, the time dimension
is placed on the columns and the measures (or account)  dimension is placed on the rows.
The first level of children of these dimensions is selected.

If no time and no measures (or account) dimensions are  available, the first dimensions in
the OLAP database outline  order on the rows and the  columns  are  displayed.  The  other
dimensions are placed in the offspread area. The members selected in these dimensions
are the default members.

Depending on the database, a default member can be set for a dimension. Otherwise, the
default member is the top-level member, unless this member is a label.  In that case, the
first child member that is not a label will be displayed in the view.

Selecting individual members

You  can  use  the  Select  Member  dialog  box  to  select  new  dimension  members,  which
allows you to change or expand your view of data in the data window.
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Procedure
1. Click a member (either inspread or offspread) in the data window.

The  Select  Members  dialog  box  displays,  showing  the  parent  dimension  of  the
member that you clicked. Selected members are highlighted.

2. To select a member, click its name.

When  you  click  a  member  that  has  children  then  click  the  +  symbol  next  to  the
member name, all children of the member are automatically selected.

Click the - icon to collapse children of the member under the - icon. 

Click Expand All to expand the children of all members.

Click Collapse All to collapse the children of all members.

3. Click Select All to select all members of the dimension.

Click Deselect All to clear all selections.

4. Click All Lowest to select all the lowest (leaf) members of the dimension.

5. To select all the lowest members below a specific parent member, click the desired
parent member, then click Lowest From.

6. To apply the member selection to all  open  views  containing  the  same  dimension,
select the option Apply to all open views using the same dimension.

Note: Using one  of  the  following  options,  only  one  instance  of  a  shared  member
will be selected:



24Using Serviceware Performance Analytics

Select All (button)

All Lowest (button)

Lowest From (button)

Select Lowest (context menu)

Note: Use the Display Type drop down list to switch between showing the member name,
alias name or both.

Note: The option Apply to all  open views using the same dimension is only available  for
offspread dimensions.

Selecting members by group

If you want to select all members, that have similarities, you can select those members by
group.

Procedure
1. Click a member in the Data Window

The  Select  Members  dialog  box  displays,  showing  the  parent  dimension  of  the
member that you clicked.

2. Right-click a member in the Select Members dialog box.

3. Select a group by clicking one of the selection options, as described in the following
table.

Note: When selecting a group of members, shared members are selected as well.

Selection Option Description

Select  Level  <Level  Name>  or
Select  Generation  (option
name  varies  according  to  the
OLAP server you are using)

Selects all members of the same generation/level
as the current member.

Select Children Selects  members  one  level  below  the  current
member.

Select Descendants Selects  all  members,  without  regard  to  level,
below the current member.

Select Lowest Selects  the  lowest  members  below  the  current
member.

Select Ancestors Selects all members above the current member.

Select Siblings Selects  members  of  generation/level  of  the
current  member  that  share  the  same  parent  as
the current member.
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Selecting multiple offspread members (SSAS and TM1 only)

By default you cannot select multiple offspread members.

If you want to select multiple offspread members, you have to enable the Select Multiple
Members option in the Select Member dialog box.

Note: Select multiple  members in the offspread is only available  if  you use SSAS or TM1
as a data source.

When you select multiple  offspread members, the  values  of  the  selected  members  are
aggregated.  The  member  name  displays  as  Aggregate,  and  a  calculator  icon  is  inserted
next to the associated dimension name, indicating that the values displayed  in  the  data
window are aggregates of multiple offspread members.

Note: The Select Multiple  Members option is only available  if  you use SSAS or  TM1 as  a
data source. The option is not available when working with a measures dimension.

Procedure
1. Click an offspread member.

The Member Select dialog box displays.

2. Click the Select Multiple Members option.

3. Using the features available  on  the  Member  Select  dialog  box,  select  the  desired
multiple members.

4. Click OK.

You immediately see the aggregate value of the selected members in your view.

Finding named sets (SSAS only)

You  can  use  the  "Find  Members"  dialog  box  to  locate  and  select  members  based  on
certain  criteria.  If  connected  to  Microsoft  Analysis  Services,  it  is  possible  to  search  on
named sets.

Procedure
1. In the Find Members dialog box, click Named Sets.

2. Click the pull-down menu and select the named set you want to search.

3. Click Find to locate the first member in the selected named set.

4. Click Find again to locate the next member in the selected named set.

You can also click Find All to find all members in the Named Set at once.

Note: Only named sets that contain members from a single  dimension are  searched
for.
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Showing member names and aliases

Both OLAP server member names and alias names can be displayed in a row or column at
the same time.

Procedure
1. Right click inside the grid and select Options... from the context menu.

2. Click the Headers tab on the Options dialog box.

3. Select either or both of the following options:

Member Names and Aliases in Rows to display both member names and aliases
in rows

Member  Names  and  Aliases  in  Columns  to  display  both  member  names  and
aliases in columns

4. Click OK.

The row and/or column headers now display the member names as well  as member
aliases.

Subsets (IBM Cognos TM1)

A subset is a definition of  members for a specific dimension. Subsets are  used to narrow
the number of rows and columns.

Selecting by subset
If subsets are available for a dimension, the Subsets tab is enabled in the Member Select
dialog box. You can use this tab to select one of the available subsets.

Note: When you open the Select Member dialog box to select an offspread member, the
Subsets tab is not available.

Procedure
1. Open the Select Member dialog box.

2. Click the subset you want to use in the data window.

To view the members of given subset, double-click the subset.

3. Click Set.

4. Click OK.

Note: If you apply a subset that has the same name as a member in the dimension,
an error message warns you that it is not possible  to  apply  the  selected  subset.  A
subset  cannot  use  the  same  name  as  a  member  or  attribute  in  the  current
dimension.

Finding subsets
You can use the Find Members dialog box to locate  and select members based on certain
criteria.

Procedure
1. In the Find Members dialog box, click Subsets.

If subsets are available for a dimension, the Subsets option is enabled.
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2. Click the pull-down menu and select the subset you want to search.

3. Click Find to locate the first member in the selected subset.

4. Click Find again to locate the next member in the selected subset.
You can also click Find All to find all members in the subset at once.

Note: Only subsets that contain members from a single dimension are searched for.

Selecting chart members

It is possible to select and deselect which members will be visible in a chart.

Procedure
1. Open the Select Member dialog box.

2. Click on the 'Chart' tab to show a list of valid chart members. 

3. To select and deselect a member, click on it.

4. Click OK.

Note: At least one member needs to be selected in the chart.

Only members that appear in the table can be selected and deselected for the chart.

If chart members are required to be shown that do not exist in the table, it is
recommended to use a canvas item to create a dashboard.

Default members SSAS only)

When  using  Microsoft  Analysis  Services,  you  can  define  a  default  member  for  a
dimension. When a default member is defined, it displays as the selected member when
initially opening the database in Performance Analytics.

Attribute Dimensions (Essbase Only)

Attribute  dimensions  are  dimensions  that  represent  the  possible  attribute  values  of
members of  a certain dimension in the outline. For instance, if  a product  in  the  product
dimension has five  attributes, it means that the dimension has  five  associated  attribute
dimensions.

Using and ignoring attribute dimensions
By  default  all  attribute  dimensions  are  ignored  in  a  view.  By  ignoring  the  attribute
dimensions,  the  offspread  is  populated  with  only  the  dimensions  and  not  with  the
attribute dimensions.

In the Dimensions dialog box dimensions that have attribute  dimensions are  indicated by

the  icon. The attribute dimensions are indicated with the  icon .  A red cross indicates
that the attribute dimension is ignored.

If a dimension Products is available it is by default not ignored. The attribute  dimensions
of the dimension Product are by default ignored.

Procedure
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1. Open the Dimensions dialog box.

2. On the Dimensions tab you can click an attribute dimension and select either Use  or
Ignore.

Switching between attribute dimensions
If  a  dimension  is  an  attribute  dimension  or  has  attribute  dimensions  you  can  switch
between these attribute  dimensions  using  a  drop-down  list  that  is  added  to  the  Select
Member dialog box.

To  be  able  to  switch  between  attribute  dimensions,  the  attribute  dimensions  must  be
ignored. See Using and ignoring attribute dimensions.

Procedure
1. In a view, click a member that has attribute dimensions.

The Select Member dialog box is displayed.

2. Click  the  menu  button   to  see  the  available  attributes  and  select  the  desired
attribute dimension.

An attribute  dimension that  is  used,  is  indicated  by  the    icon.  A  used  attribute
dimension cannot be chosen.

An  attribute  dimension  that  is  ignored,  is  indicated  by  the   icon.  An  ignored
attribute dimension can be chosen.
If  an  attribute  dimension  is  shown  on  screen  or  hidden  (not  ignored),  this
dimension is disabled in the drop-down list and  cannot  be  chosen  from  the  drop-
down list in the Select Member dialog.

Drill up and down

Members can consist of  parents,  children,  ancestors  or  siblings.  In  order  to  analyze  the
data in a view you can choose to display less or more members of  the inspread members.
This is called drill up or drill down.

In  a  view  you  can  use  the  Easy  Drilling  arrows  to  drill  up  and  down  on  members.  This
increases the speed of changing the displayed members.

Drilling down
Drill down on a member to display the children of an inspread member.

Procedure
1. Right-click the inspread member.

2. Click Drill Down.

Drilling up
Drill up on a member to display the parent of an inspread member.
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Procedure
1. Right-click the inspread member.

2. Click Drill Up.

Easy drilling
Easy  drilling  allows  you  to  drill  up  or  drill  down  on  an  inspread  member  with  a  single
mouse click.

Enabling easy drilling
In order to use easy drilling you have to enable it in the Options dialog box

Procedure
1. Open the Options dialog box.

2. Click the Headers tab.

3. Click one of these Easy Drilling options:

No  Drill  Buttons  removes  the  drill  buttons  from  the  inspread  members.  Easy
drilling is disabled.

Hover Drill  Buttons displays drill  buttons on members only when you move  the
pointer over a member name. This is the default setting.

Permanent  Drill  Buttons  permanently  displays  drill  buttons  on  inspread
members.

4. Click OK

Options for easy drilling
You can specify whether easy drilling expands up or to parents only.

You can set the following additional options for easy drilling:

Expand Up

By default,  when you right-click a hover drill  button  to  drill  down,  the  children  of
the  member  are  inserted  after  the  parent  member.  With  the  option  Expand  Up
selected,  the  children  of  the  parent  will  be  inserted  before  the  parent  member
instead of after when you right-click on the hover drill button to drill down.

Drill Up To Parent Only

By default,  when drilling up on a member, the selection one level  higher than  the
level that is selected is displayed. With the option Drill  Up To Parent Only checked,
you can drill up to the single parent member of  a selection on screen when clicking
the hover drill button to drill up.

Using easy drilling
When  Easy  Drilling  is  enabled,  an  up  and  or  down  arrow  displays  next  to  inspread
members, indicating that you can drill up or down.
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Procedure
If  you have enabled hover drill  buttons, move over an inspread member and click  an  up

arrow   to drill up, or a down arrow to drill down.

If  you  have  enabled  permanent  drill  buttons,  just  click  a  visible  arrow  on  an  inspread
member.

The following right-click options are also available when easy drilling is enabled:

If  you  right-click  a  hover  drill  down  button,  the  member  and  the  children  of  a
member are included.

If you right-click a hover drill up button, the children of a member disappear.

If  you right-click a hover drill  up button on a member with no children,  the  parent
member is selected.

When right-clicking on a level 0 member, the member and its siblings will disappear

Member information

The Member Information dialog box displays the properties or attributes of  the member,
formula (from both the database and the view), a comment,  and  additional  information
about the member.

Additional information can include:

Generation and Level names

Consolidation  types

Original member name

Share  information

Expense tags

Time Balance information

Number of children and descendants

Showing member information
You can show information for each member.

Procedure
Right-click a member name, then click Member Information on the shortcut menu.

The Member Information dialog box displays, showing detailed member information.

Alternatively, you can move the pointer over a member name to view a tooltip containing
member information.

The order of members

The default order by which the members are  displayed are  determined by the outline. In
a view you can change the order of members.

Changing the order of members by dragging and dropping
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You change the order of  members by moving the members from the initial  location  to  a
new location.

Procedure
1. Click and hold a member.

2. Drag the member to the place where you want it to  go.  The  following  options  are
available:

Move  the  member  between  two  other  members.  For  moving  a  member  your

mouse cursor should look like this:   .

Replace the member with another member. You have to press either the Ctrl  key
or the Shift key while dragging the member. For replacing a member your mouse

cursor should look like this:  .

Changing the order of members by using the Select Members dialog box
You can change the order of members by using the Select Members dialog box.

Procedure
1. Click a member.

The Select Members dialog box displays.

2. Click the Order tab.

3. Click the member that you want to move.

4. Click the up or down arrow buttons    to move the selected member to
its new position.

You can select multiple members and change their order.

Note:  Changing  the  order  of  members  is  not  possible  in  combination  with  a
DynaSelect.

There are also some predefined order algorithms:
Outline Order

Reverse Outline Order

Sort

Reverse Sort

Sort within Hierarchy

Reverse Sort within Hierarchy

Sorting the order of members

There are several ways to sort the order of members.

All sorting options are available in the Select Members dialog box.
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Procedure
1. Click a member in the data window.

The Select Members dialog box displays.

2. Click the Order tab.

3. To sort members alphabetically, click the Sort button.

4. To apply a different sort order, click the down arrow on the Sort button and  select
one of the available options.

5. Click OK.

Option Description

Outline Order Sorts members according to the outline order in the OLAP
database.

Reverse Outline Order Sorts members in a reverse way according to the outline order
in the OLAP database.

Sort Sorts members alphabetically.

Reverse Sort Sorts members in reverse alphabetic order.

Sort within Hierarchy Sort members in ascending or descending order, while
respecting the dimension hierarchy.

Reverse Sort within
Hierarchy

Members are sorted in reverse alphabetical order within their
hierarchies.

Sorting members within a hierarchy
Sort within hierarchy means it is possible  to sort a dimension in ascending or descending
order, while respecting the dimension hierarchy.

The  Sort  within  hierarchy  option  is  only  available  while  sorting  in  ascending  or
descending order.

Procedure
1. Click the Sort Select button in the ribbon MEMBER.

The Sort & Select dialog box displays.

2. Click Sort within Hierarchy when performing a sort action.

3. Click OK.
If the dimension is sorted, the children are  sorted underneath their parents. In the
result, the dimension hierarchy is still intact.

Sorting members by value
Members can be sorted in ascending or descending order according to the values in rows
or columns.

Procedure
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1. To  sort  row  members  according  to  values  in  a  specific  column,  right-click  the
column, then click Sort Ascending or Sort Descending.

2. To sort column members according to values in  a  specific  row,  right-click  the  row,
then click Sort Ascending or Sort Descending.

Dynamic Time Series (Essbase Only)

Dynamic Time Series (DTS)  can be added  to  an  Essbase  database  outline  to  dynamically
calculate period to date values, for example Year to Date and Quarter to Date.

There are  several  standard periods  to  date  functions  available  in  Essbase.  The  result  of
the calculations is called Dynamic Time Series.

DTS members are  calculated based on the  value  of  the  lowest  level  members  from  the
periods dimension. Essbase does not calculate DTS values for period members on a higher
level.

In Performance Analytics Dynamic Times Series are treated as a separate  dimension.  This
allows  you  to  quickly  set  up  views  where  you  can  review  single  period  values  next  to
period-to-date values in columns or in rows.

In a view Dynamic Times Series are indicated by the following icon:  .

Substitution Members (Essbase Only)

Substitution  variables  are  treated  as  members  of  the  dimension  for  which  they  are
defined. This means you  can  perform  the  same  actions  on  these  substitution  members
that you can perform on other members, such as selecting these members in a table  or a
chart, making calculations, performing data entry and so on.

In  the  Member  Select  dialog  the  Substitution  Variables  are  added  as  substitution
members to the dimension.

The Substitution Member names are  the names of  the Substitution Variables.  The  value
of  the  Substitution  Variables  are  added  in  the  default  Alias  names.  The  Substitution
Members are indicated by an arrow icon .

When  the  value  of  the  Substitution  Variables  is  changed  in  Essbase,  the  default  Alias
Names of the substitution members will change accordingly.

When  changing  the  alias  table  to  No  Alias  Table  in  the  Connection  Information  dialog,
only the names of the Substitution Variables are shown.

The Member Information dialog box displays the member information of the Substitution
Member.

Note:  It  is  possible  to  enable  or  disable  the  option  Add  Substitution  Members  in
Performance  Analytics  Explorer.  See  the  Serviceware  Performance  Analytics  Server
Installation and Configuration Guide for more details.
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Navigation

There  are  many  ways  in  which  you  can  navigate  through  your  data  in  a  view.  You  can
switch between dimensions and change the order of dimensions.

You can modify a view by dragging and dropping dimensions from one location to another
in a view.

Swapping dimensions

You can drag a dimension from the inspread area and drop it on the offspread  area.  The
member that you move remains selected.

Similarly,  you can drag a dimension from the offspread area and drop it on  the  inspread
area. When dragging a dimension to the inspread area, the previous member selection in
that dimension displays. You can move dimensions without losing member selections.

When you drag  a  dimension  from  one  location  in  a  view  and  drop  it  directly  on  top  of
another dimension, the two dimensions switch positions in the view.

You can also drag and drop dimensions in a chart.

Procedure
1. Click the dimension that you want to move.

2. Drag and drop the dimension to a different location in the view.

3. The swap icon    appears next to your mouse pointer.

Stacking dimensions

In  a  view  you  can  display  multiple  dimensions  on  either  the  rows  or  columns.  This  is
called stacking dimensions.

Stacking dimensions allows you to see greater detail in a view, as each stacked dimension
can display multiple members.

Note: For asymmetric selections see Asymmetric selection.

Follow these steps to stack multiple dimensions in a view.

Procedure
1. Click the dimension that you want to stack.

2. As you move your pointer  over  the  current  dimension,  the  mouse  cursor  changes
and a line  appears  showing  where  the  dimension  will  be  inserted.  You  can  move
the cursor until the line appears in the desired position.

3. Release the mouse button to drop and stack the dimension.

Renaming dimensions

If you want to change the display name of a dimension you can rename it.  You can change
only the display name and not the actual name of the dimension.
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Procedure

1. Open  the  Dimensions  dialog  box  by  clicking  the  Dimensions  button   in  the
NAVIGATE ribbon.

2. Identify the dimension you want to rename and click Rename.

The Change Dimension Display Name dialog box opens.

3. Change the dimension name and click OK.

In the Dimensions dialog box  the  new  display  name  precedes  the  actual  name  of
the dimension:

renamed display name [actual dimension name]

If you want to remove the display name and thus only show the actual  name of  the
dimension, click remove while  the  Change  Dimension  Display  Name  dialog  box  is
open.

Using multiple hierarchy dimensions (SSAS only)

Multiple  hierarchy dimensions are  dimensions that provide similar yet alternative  views
of cube data.

For example, a Time dimension with two hierarchies can have a regular calendar hierarchy
and a  fiscal  calendar  hierarchy,  or  a  Market  dimension  can  have  a  market  and  a  region
hierarchy.

In Performance Analytics,  all  hierarchies of  a multiple  hierarchy dimension are  added  as
dimensions to the outline structure of the database shown in Performance Analytics.  The
hierarchy  dimensions  that  are  not  the  default  will  be  ignored  when  the  database  is
initially opened.

When  using  a  multiple  hierarchy  dimension,  you  can  switch  between  the  available
hierarchies.

Procedure
1. Open the dimension in the Member Select dialog box.

If the dimension is a multiple hierarchy dimension, an arrow button is added to the
top right of the Member Select dialog box.

2. Click  the  arrow  button    to  see  the  available  hierarchies  and  select  another
hierarchy. You can choose between:

Custom  hierarchies   

Attribute  hierarchies  

Ignoring multiple hierarchy dimensions (SSAS only)

To be able to switch between hierarchies,  the hierarchies must be ignored. If  a hierarchy
is shown on screen or hidden (not ignored),  this dimension is disabled in the drop-down
list and cannot be chosen.

Procedure
1. Open the Dimension dialog box.

2. Click a dimension and in the Usage section select Use or Ignore.
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Alias tables

Alias tables allow you to show alternative names for members. You can use alias tables to
show for example  the  full  names  or  the  translations  of  members.  Alias  tables  are  only
available in a view if the database, to which the view connects, contains alias tables.

The following rules apply for the assignment of aliases to member names:

Alias tables are applied in the order (top to bottom) that is set in the Selected Alias
Tables list.

If  an  alias  table  has  no  alias  defined  for  a  member,  the  next  alias  table  in  the
Selected Alias Table list will be used.

The member name is used if there is no alias for that member in any of  the selected
alias tables.

This way you can use combinations of alias tables to assign aliases to member names.

Choosing alias tables
This section explains how to choose alias tables.

Procedure
1. Open the Choose Alias Tables dialog box using either of the following procedures.

Right-click the View tab, then click Database > Choose Alias Tables.

Right-click  a  cell  in  the  current  View,  then  click  Extra  >  Choose  Alias  Tables.  The
Choose Alias Tables dialog is displayed

2. Select an Alias Table in the Available Alias Tables list.

3. Click    to move the Alias Table to the Selected Alias Tables list.

4. Repeat steps 3 and 4 for all Alias Tables you want to use.

Alternatively,  you can click  to move all  Alias Tables  from  the  Available  Alias
Tables list to the Selected Alias Tables list.

5. If there is more than one Alias Table  in the Selected Alias Tables list,  select a table
name and then use the Up and Down arrow buttons to change the ordering  of  the
Alias Tables.

6. Click OK to confirm your selection and set the order of Alias Tables
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Note: If  you  want  to  display  the  Essbase  server  member  names  (not  the  aliases),
move  all  alias  tables  to  the  Available  Alias  Tables  list.  When  connecting  to  other
OLAP  Servers,  Performance  Analytics   uses  unique  member  names.  The  (unique)
member names are displayed when all Alias Tables are moved to the Available Alias
Tables list.

Showing and hiding dimensions

You  can  use  the  Dimensions  dialog  box  to  determine  which  dimensions  are  visible  on
your screen.

Opening the dimensions dialog box

Procedure
Right-click the table, then click Dimensions.

The Dimensions dialog box displays. This dialog box contains three tabs:

Dimensions shows all used and ignored dimensions

Offspread shows all offspread dimensions

Print Range is used to configure printing. See Printing Views.

Setting used and ignored dimensions
Follow these steps to set used and ignored dimensions for a table.

Procedure
1. Right-click the table, then click Dimensions.

The Dimensions dialog box displays.

2. Click the Dimensions tab.
For each dimension that you want to use, select the dimension name then click Use.
Alternatively, you can click Use All to use all dimensions shown in the list.

3. For each dimension that you want to ignore, select the dimension name then click
Ignore.

4. If  you want to remove your selections  and  restore  the  original  used/ignore  status
for each dimension to what it was when you opened the database, click Reset All.

5. Click Apply to immediately apply your changes to the table.

Setting offspread dimensions
Follow these steps to set offspread dimensions for a table.

Procedure
1. Right-click the table, then click Dimensions.

The Dimensions dialog box displays.

2. Click the Offspread tab.
This  tab  displays  a  list  of  shown  and  hidden  offspread  dimensions.  The  shown

dimensions   appear  at  the  top  of  the  list  in  the  order  specified  by  the  user,

followed by the hidden dimensions  in alphabetical order.
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3. For  each  dimension  that  you  want  to  show  in  the  Offspread  area,  select  the
dimension name then click Show.

4. Alternatively, you can click Show All to show all dimensions in the list.

5. For each  dimension  that  you  want  to  hide,  select  the  dimension  name  then  click
Hide.

6. To change the position of a shown dimension in the list, select the dimension name
then click the Up or Down arrow.

7. To change the selected member for any Offspread dimension, click  the  dimension
name, then click Select.
The Select Offspread Member dialog box appears.

8. Choose the member you want, then click OK to set the member and close the Select
Offspread Member dialog box.

9. If you want to discard your selections and restore  the original  show/hide status for
each dimension to what it was when you opened the database, click Reset All.
Note: Reset All does not reset the order of dimensions.

10.Click Apply to immediately apply your changes to the table.

Undoing previous actions

You can undo and redo actions in a view.

You should be aware of the following limitations when using the Undo and Redo features:

The Undo and Redo buttons do not apply to changes made in a dialog box, such as
creating a calculation or changing options on the Options dialog.

Undo and Redo operations are lost when reconnecting to a different database.

To undo or redo more steps in one action, use the pull down arrows next to the Undo and
Redo buttons.

Procedure

1. To undo the most recent action, Click Undo .

2. To reapply an undone action, click Redo .

Asymmetric selection

When dimensions have been stacked, it is possible to make an asymmetric selection.

See  Stacking  dimensions  for  an  explanation  of  stacked  dimensions.  An  asymmetric
selection allows you to show only those members in which you are interested.

For  example,  if  you  want  to  change  the  products  that  are  shown  only  for  a  region  you
create an asymmetric selection.
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Figure 1 - Symmetrical selection

Figure 2 - Asymmetrical selection

There are several ways to create asymmetric selections:

Using the Select Members dialog box.

Drilling up and down on members while holding the Alt key.

Using the Select Members dialog box to create an asymmetric selection
You can create an asymmetric selection by using the Select Members dialog box.

Procedure
1. Click the stacked dimension for which you want to create  an asymmetric selection.

The Select Members dialog box is displayed. Double clicking, or pressing the Alt key
when  clicking  on  any  of  the  members  behind  the  stacked  member  will  open  the
Select Members dialog box.
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2. You can change the member for which you want to create  the asymmetric selection
by clicking on that member. The member that will  have an asymmetric selection is
indicated by a different color. See the image above.

3. In  the  Select  Members  dialog  box  change  the  selected  members  to  create  the
asymmetric selection.

4. Click OK.

The asymmetric selection is displayed.

Creating an asymmetric selection by drilling up and down on members while
holding the Alt key
You  can  create  an  asymmetric  selection  by  drilling  up  and  down  on  members  while
holding the Alt key.

Procedure
1. Identify  the  stacked  dimension  for  which  you  want  to  create  an  asymmetric

selection.

2. Hold the Alt key and click either the up or the down arrow    to the right of  the
member names.
The asymmetric selection is displayed.

Creating an symmetric selection
If you want the selection to be asymmetric, no group should be selected.

Procedure
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1. Click the asymmetric group. The Select Members dialog box is displayed.
Only the asymmetric group is selected.

2. Click the asymmetric group.
In the Select Members dialog box the members for the original  symmetric selection
are selected.
If  you  now  change  the  member  selection,  a  symmetric  selection  for  all
combinations will be made.

Changing the order of members in an asymmetric selection
If  you  want  members  in  an  asymmetric  selection  to  be  in  a  different  order  than  the
symmetric selection, you can change their order.

Procedure
1. Press  and  hold  the  Alt  key  and  click  the  member  you  want  to  move  in  the

asymmetric selection.

2. Drag the member to the place where you want it to  go.  The  following  options  are
available:

Move  the  member  between  two  other  members.  For  moving  the  member  your

mouse cursor should look like this: .

Replace the member with another member. You have to press both the Alt and the
Shift key while dragging the member. For replacing the member your mouse cursor

should look like this: .

Drill through

Drill through allows you to drill  through to the relational  data sources, which are  used to
populate the multidimensional database.

Setting drill through options
Follow  these  steps  to  enable  drill  through  and  set  several  options  that  determine  the
appearance and behavior of a drill through.

Procedure
1. Right click inside the grid and select Options... from the context menu.

2. Click the Layout tab on the Options dialog box.

3. Select the Show Drill Through option.

4. Using the adjacent pull  down  menu,  select  the  location  where  you  want  the  Drill
Through table to appear on the screen.

5. Click the Actions tab.

6. Set the Drill Through options, as described below.

7. Click OK.

Option Description

Highlight Active Cell Highlights  the  active  cell  (the  cell  for  which  the  drill
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through data is shown) in the main table.

Color Alternating Rows Applies a background color to alternating rows in the drill
through  table  to  improve  readability.  When  you  select
this  option,  you  must  also  specify  the  number  of
adjacent  rows  to  which  background  coloring  should  be
applied.

Limit Rows Limits the number of  rows to display in the drill  through
table. When you select  this  option,  you  must  also  set  a
maximum row value.

Print All Combinations If this option is selected, all  combinations of  the data for
every cell in the table will be printed.

Limit Rows Printed Limits the number of drill through table  rows that can be
printed.  When  you  select  this  option,  you  must  also
specify  the  maximum  number  of  rows  that  can  be
printed.

Currency Settings Displays a currency symbol for values in the drill  through
section. 

The following values are possible:

None
No currency symbol is shown.

Auto
If you select the value Auto, then the regional  settings of
the  system,  on  which  the  client  software  runs,  are
applied.

The name of a region

If you specify a region, then the currency of that region is
displayed for values in the drill through section.

Using drill through (TM1 only)

This feature allows you to drill through to relational data.

Procedure
Right-click a cell in the data table,

then click Cell  Actions > Drill  Through.  A drill  through pane appears showing the table  of
this relational data.

A drill through script can be selected.

Only Relational scripts will work when using Drill Through. View scrips will not work.

Drilling through relational data
Drilling through relational  data allows you to display a drill  through pane that shows the
table  of  the  relational  data.  The  drill  through  pane  gives  you  information  about  how
values in the view are derived from the relational data.
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Procedure
1. Right-click a cell, then click Actions > Drill Through.

2. Click  any  cell  in  the  data  table  to  view  the  associated  relational  data  in  the  Drill
Through table.

3. To view the next or previous cell  for a  particular  member,  click  the  arrow  buttons
 .

To view the next or previous cell for all members, click the arrow buttons  on the
bottom right of the drill through table.

Formatting the drill through table
You can change the way the drill through table is displayed by changing its format.

Procedure
1. Right-click the Drill Through table, then click Formatting > Styles.

2. Click Drill Through.

3. Set formatting options for font type, background color, borders, and so on.

Modifying columns in the drill through table
You  can  change  the  position  of  columns  in  the  drill  through  table,  and  set  display
properties for columns.

Procedure
1. To  change  the  position  of  a  column  in  the  drill  through  table,  click  the  column

heading, then drag and drop the heading to a new position.

2. To set display properties for columns, click the Columns button on the drill  through
table.
The Drill Through Columns dialog box displays.

3. Use the options on the dialog box to:

Rename a column

Change the alignment

Change the order of the columns

Show all columns   

Hide all columns   

Reset all columns

4. Click OK.

Copying data from the Drill Through table
You can copy the rows with relational data to the clipboard.
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Procedure
1. To copy all  rows of  relational  data  to  the  clipboard,  click  the  Copy  button  without

selecting any rows in the table.

2. To copy specific rows to the clipboard, press and hold the Ctrl key and click each row
you want to copy, then click the Copy button

Using drill through (SSAS only)

This  feature  allows  you  to  drill  through  to  relational  data.  To  use  this  feature,  Drill
Through should be enabled and allowed.

Procedure
Right-click a cell  in the data table, then click Cell  Actions > Drill  Through.  A  drill  through
pane appears showing the table of this relational data.

Using drill through, row set actions (SSAS only)
With the actions feature in Microsoft Analysis Services, you can attach an action to a cube
or a portion of a cube can be attached.

When creating  an  action  in  Microsoft  Analysis  Manager,  the  type  for  this  action  can  be
selected.

Rowset actions, attached to cells in a cube, are supported in a view.

A rowset action is an action that  returns  a  set  of  data  rows  that  Performance  Analytics  
shows in the Drill Through pane. An MDX statement defines which rows are returned.

When Drill Through is enabled in MS Analysis Services, the option drill through allows you
to drill through to the relational data sources.

Procedure
1. Right- click a cell, then click Cell Actions > Drill Through <Rowset action name>.

2. You can also select the available Rowset actions from the Script drop-down menu in
the Drill Through pane.

Actions (SSAS only)

Actions is a feature from Microsoft Analysis Services that allows you to link an object to a
cell.  Actions  allow  you  to  link  an  action  type  to  a  target.  A  target  can  be,  for  instance,
some or all members of a dimension or a database.

This can be (for example):

A Screenshot

A URL to a website

A spreadsheet file

A text document

A  blue  triangle  in  the  cell  indicates  the  presence  of  a  linked  reporting  object.  You  can
choose to show this indicator on the Actions tab of the Options dialog.

Actions can also be used from the offspread bar, the chart bar, charts and the drill  through
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bar.

The available actions depend on the area clicked:

Cell and cube actions are available when clicking on a cell

Member and cube actions are available when clicking on a member

Note: Actions of the type rowset on members or on a database are not supported.

Procedure
1. Right-click a cell, then click Actions.

The available  objects are  displayed, and will  open with the application that is registered
in Microsoft Windows as the default application for the type of file the object contains.

Linking reporting objects (Essbase only)

Linked reporting objects is a feature from Essbase that lets you to link an object to a cell.

This can be (for example):

A screenshot

A URL to a website

An Excel file

A text document

A  blue  triangle  in  the  cell  indicates  the  presence  of  a  linked  reporting  object.  You  can
choose to show this indicator on the Actions tab of the Options dialog.

Procedure
1. Right-click a cell, then click Actions.

The available  objects are  displayed, and will  open with the application that is registered
in Microsoft Windows as the default application for the type of file the object contains.

Canceling long running processes to an IBM Cognos TM1 database

A  cancellation  of  process  is  made  available  for  Performance  Analytics  when  used  with
IBM Cognos TM1.

About this task
IBM Cognos  TM1 has  a  cancel  feature  that  can  cancel  long  running  processes.  During  a
process in Performance Analytics, the following notice can appear:

Please wait while the operation is in process. To cancel the operation, press the Escape key.

Procedure
To cancel the operation, press the Escape key.
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Create view link

A view link can be generated by either clicking the Create Link button in the Navigation ribbon
tab or by using the context menu and selecting Extra and then Create Link. The link is
automatically copied to the clipboard.
In addition, a link can be generated by clicking on the Send Mail button in the ribbon area.

It can be used to generate an URL which represents the current view with all selections and
formatting settings but no data. This link can be shared with other users, who are able to see
the exact same view as the creator.

View links are read-only and can not be modified.

Tables

After you make the preliminary selection of members and dimensions, you can refine the
data selection and formatting for the table.

Finding members within a table

A member can belong to an extensive list of members.

The Search for  or  Compare  with  features  can  help  locate  an  exact  member  or  group  of
members from such a list.

A member search can be used as a filter to select  discrete  members  from  a  large  list  of
members. You can search for an exact member name or part of a member name.

A  member  search  can  be  made  by  using  a  comparison  table.  You  can  compare  values
against values that are greater or less than the search criteria.

Members can be set with either a property or an  attribute  as  meta  data.  The  meta  data
can be used to find the members.

You can  conduct  multiple  searches  simultaneously.  For  example  you  could  first  find  all
members  whose  alias  name  starts  with  New,  and  then  within  that  group  locate  all
members with the named set Major_Markets, by selecting one of the following buttons in
the Members section of the Find Members window:

All

Selected

Last Found

Finding members by using search

You can find members by searching.

Procedure
1. Click a member tag in the Table View.

2. In the Select Members for dialog box, click Find.

3. In the Find Members window, select Search for from the drop down menu.

4. Type the word or part of the word for which you want to search.

5. Select the first criteria of the search from the Match list:

Member name

Alias name

Attributes 
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Levels

Subsets

6. Select the second criteria of the search from the How list:

Containing

Exact match

Starting with

Ending with

7. Click Find Next or Find All.

8. Click Keep Found to clear any members that are not part of the search criteria.

9. Click Select to keep the selection.

10.Click Close.

11.Click OK.

Results
The members that meet the search criteria are shown in the table.

Finding members by using compare with

You can find members by using compare with.

Procedure
1. Click a member tag in the Table View.

2. In the Select Members for window, click Find.

3. In the Find Members window, click Compare with.

4. Type the word or part of the word for which you want to search.

5. Select the first criteria of the search from the Match list:

• Member name

• Alias name 

• Attributes

• Levels

• Subsets

6. Select the second criteria of the search from the How list:

• <   All member names less than the search criteria.

• <= All member names less than or equal to the search criteria.

• >= All member names greater than or equal to the search criteria.

• >   All member names greater than the search criteria.

7. Click Find Next or Find All.

8. Click Keep Found to clear any members that are not part of the search criteria.

9. Click Select to keep the selection.

10.Click Close.

11.Click OK.
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Finding members by using attributes or properties

You can find members by using attributes or properties.

Procedure
1. Click Select Members > Find.

2. In the Find Members window, select Search for.

This option is disabled if there are no properties for the dimension.

3. Select Attributes or Properties.

The options are disabled if there are no attributes or properties for this dimension.

4. Click Find, Find Next, or Find All.

Finding members by using generation or level

You can find members by using generation or level.

Procedure
1. To  find  members  by  Generation  or  Level  or  just  by  Level,  in  the  member  select

window, click Find.

Note: The availability of Levels and Generations depends on the data source type to
which you are connected.

2. For generations or levels, click Search for.

3. Click Find, Find Next or Find All.

4. Select or deselect the found members.

Finding members by using multiple search

You can find members by using multiple search.

Procedure
1. Create your first search.

2. Select the found members for which you want to search.

3. Click Find All.

Sorting dimensions

You  can  sort  a  dimension  in  ascending  or  descending  order,  while  respecting  the
hierarchy of the dimensions.

Procedure
1. Click Sort Select from the toolbar.

2. Click Sort within Hierarchy.

If the dimension is sorted, the children are sorted underneath their parents.

3. To sort within a hierarchy:

• Click a member to open the Select Members window.
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• Select the Order tab and click the Sort button.

• Click Sort and select an option.

When  sorting  the  members  in  reverse  alphabetical  order  while  respecting  the
hierarchy, choose Reverse Sort within Hierarchy from the pop-up menu.

Note: Reverse Sort within Hierarchy does not create  the exact reverse  order of  Sort
within  Hierarchy  but  sorts  the  members  in  reverse  order  within  their  parent
members.

Missing data

Often data is missing from a table.

There can be various reasons for this  and,  depending  on  the  reason,  you  can  choose  to
either ignore the missing data or include the missing data as a zero value.

Ignoring dimensions

When ignoring a dimension, the influence of this ignored dimension depends on the type
of dimension.

In the case of  Multiple  Hierarchy dimensions (Microsoft Analysis Services)  and  Attribute
dimensions (Essbase), the dimensions do not influence the values displayed in the table
when these dimensions are  ignored. In the case  of  dimensions  needed  to  make  up  the
value  in  the  table,  the  default  member  is  used  (for  example  if  the  Time  dimension  is
ignored). When hiding a dimension, that dimension is not visible  on screen. The member
selection in the hidden dimension still makes up the values in the table together with the
visible dimensions.

Procedure
1. To ignore a dimension, select NAVIGATE ribbon and click the Dimension  button  or

click the Dimensions button on the toolbar.

2. Click the dimension you want to ignore and click Ignore.

On the Offspread tab, the ignored dimension is no longer listed.

When  initially  opening  the  database,  all  Attributes  (Essbase)  are  ignored.  In  the
case of Multiple Hierarchy dimensions (Microsoft Analysis Services)  the hierarchies
that are not the default are ignored.

3. To show or hide a dimension, select the dimension and select either Show or Hide.

4. Click Apply.

Tip:  The  Reset  button  resets  the  selection  for  the  dimensions  and  resets  the  visibility
status (Show,  Hide,  or Ignore)  to the status the dimensions had  when  the  database  was
initially opened. The order of dimensions is not reset.

Suppressing missing rows and columns

When all  values in a row or a column are  missing, you  can  automatically  suppress  these
rows  and  columns  from  your  display.  The  cells  containing  grid  comments  or  member
attributes will  not be considered when using Suppress missing rows or Suppress missing
columns.
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Procedure
1. Right click inside the grid and select Options... from the context menu.

2. Click the Data tab.

3. Select  the  option  Missing  below  Suppress  Rows  Containing  and/or  Suppress
Columns Containing.

Removing missing values

You can choose to remove cells with missing values.

Procedure
1. To  display  only  the  members  with  data,  right-click  the  table  and  select  Remove

Missing Rows from Selection or Remove Missing Columns from Selection.

2. The missing rows or columns are removed from the selection.

When using the options Remove Missing Rows from  Selection  or  Remove  Missing
Columns  from  Selection,  the  members  you  originally  selected  are  changed  and
members with missing values are forgotten.

Suppressing no access rows and columns

When you do not have access to certain members you can  automatically  suppress  these
members from your display.

When  this  option  is  enabled,  columns  and/or  rows  with  no  access  will  always  be
suppressed automatically. The originally selected members are retained.

In  some  cases,  enabling  this  option  can  decrease  performance.  In  the  case  of  stacked
dimensions, this option can result in an asymmetric view.

If you want to suppress columns and/or rows with no access,  you can also personalize  the
database  in  combination  with  Essbase  filters.  When  connecting  to  Microsoft  Analysis
Services,  the  outline  will  be  limited  according  to  the  user  rights  in  Microsoft  Analysis
Services.

The cells containing  grid  comments  or  member  attributes  will  not  be  considered  when
using either Suppress  no access rows or Suppress no access columns.

Procedure
1. Right click inside the grid and select Options... from the context menu.

2. Click the Data tab.

3. Select  the  option  No  Access  below  Suppress  Rows  Containing  and  Suppress
Columns Containing.

Suppressing rows and columns with zero values

When all values in a row or a column have the value zero, you can automatically suppress
these rows or columns from your display. The cells containing grid comments or member
attributes will  not be considered when using either Suppress rows  or  Suppress  columns
with zero values.
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Procedure
1. Right click inside the grid and select Options... from the context menu.

2. Click the Data tab.

3. Select  the  option  Zero  below  Suppress  Rows  Containing  and  Suppress  Columns
Containing.

Including zero values

This feature is used to display a list of members that have zero values in the database. For
example, it can be used in your search to include customers who did not buy products or
products that did not sell in a given period.

Procedure
1. Click the Sort & Select button in the ribbon MEMBER.

2. Click the inspread member you want to sort.

3. Select either Ascending or Descending from the Sort field.

4. Select the Include Missing Values from the Options field.

5. Select the option from the Retrieve Data From field.

6. Click OK.

Table formatting

Data can be formatted and displayed in many ways.

Formatting is set in layers that are  processed  in  a  specific  order  from  low  level  general
format  rules  to  high  level  specific  rules.  Every  rule  in  a  higher  layer  concatenates  and
appends with the rules in lower layers.

Formatting can be done at the following levels:

Themes - lowest level

A theme is a setting  with  several  pre-defined  colors  that  changes  the  look  of  the
client system.

Backgrounds

Backgrounds  are  the  colors  of  different  areas.  By  default  Microsoft  Windows
background colors are used, as set in the Display settings in the Control Panel.

Generations and Levels

Generation and Level  formatting definitions are  concatenated  with  the  formatting
defined in Styles.

Styles

Styles define the look of the different areas of a table or chart.

Member Formatting

Generation and Level  formatting definitions are  concatenated  with  the  formatting
defined in Styles.

Traffic Lights / Data Bars - highest level
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The  next  layer  is  Member  formatting  where  you  can  specifically  point  to  one  or  more
members  and  change  their  formatting  options.  Multiple  formats  do  not  overwrite
previous formats set in styles,  generation and levels,  but  appends  the  format  style.  For
example, in the styles format, an area of cell can have a negative  format defined as -#s. If
you format a member as a percentage with #s %, the result is -10 %.

Traffic  Lights  allow  you  to  set  the  color  of  cells  based  on  their  value.  For  example:
Negative cells can be set to red and positive cells to green. Colors defined here  overwrite
all the colors defined in previous layers.

Data Bars allow you to visualize the value of a cell as a bar.

Assigning a Template to the view

It is possible to define a previously defined and saved set of formats to the view or canvas by
assigning a template to the view or canvas.

Procedure
1. Click the FORMAT ribbon

2. In the Section Designs choose a predefined template

3. The template will be applied immediately to the view or canvas

Note: In the chapter Creating a new view, folder or canvas there  is a description  how  to
define templates.

Disabling format options

You can disable the formatting options.

Procedure
1. Right click inside the grid and select Options... from the context menu.

2. Click the Format tab.

3. Choose  to  enable  or  disable  the  Cell  Formatting,  Offspread  Formatting,  Header
Formatting and Level or Generation Formatting for Cells.

Note:  While  formatting  is  turned  off,  you  can  still  assign  or  change  formatting  to
members, however the effects will not be visible.

Formatting header options

You can set several  options  to  control  the  display  of  row  headers  and  column  headers.
These options are in addition to the Styles and Member formatting options.

Procedure
1. In the Options window, click the Headers tab.

2. Set the following options.
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The options are:

Member Names and Aliases in Rows

Displays the member name followed by its alias in the row headers.

Member Names and Aliases in Columns

Displays the member name followed by its alias in the column headers.

Display Type Mask

Sets  the  mask  for  displaying  members  and  aliases  in  the  row  and  column
headers.  This  mask  is  also  used  for  the  member  selection  dialog.  E.g.  #m  #a,
where #m is the member name and #a is the alias name.

Indent Row Headers

Displays the outline  structure  in the  row  headers.  By  default  a  full  stop  and   a
space is used for this option. You can replace the defaults with a symbol  of  your
choice.

Show Icons in Headers

Displays the Label,  Calculator,  Attribute  Dimensions,  Dynamic  Time  Series,  and
Virtual Dimensions symbols in the headers.

Indent Headers for Icons

Indents the headers to allow the display of icons.

Auto Size Headers

Automatically resizes the headers to create an exact fit. If this option is selected,
the splitter is disabled.

Show Splitter

Displays or hides the splitter.

Formatting header width and height

You can set the header width and height to resize automatically.

The width and height are set for the specific dimension. If you move the dimension to the
Offspread area and back to the Inspread area, the width and height are  set to the values
you have specified for that dimension.

Tip: The header height and width can manually be set by dragging  the  width  and  height
indicators.

Procedure
1. In the Options window, click the Headers tab.

2. Select Auto Size Headers.

Formatting backgrounds

You can change the formatting of backgrounds areas.

You can change the color of background areas such as:
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Offspread

Columns 

Rows

Table

Chart

Drill Through

Procedure
1. Right-click the screen area that you want and click Background from the Formatting

menu.

2. Select the color that you want.

Note: This color becomes the default for the Styles or Member formats.

Formatting styles

Styles are organized in a hierarchy.

The Default style is the highest level. All other styles use the setting from the

Default style. Settings in a lower level style overwrites higher level styles.

Auto style uses the setting from the higher-level style as the default

The available styles are:

Level 2 Level 3 Level 4 Level 5 Affects

Cell All table cells.

Zero Cells with zero values

Positive Cells with positive values

Negative Cells with negative values

Text Cells with text

Missing Cells with missing values

No access Cells the user has no access to due to
security  settings  in  the  OLAP
database server.

Error Cells  displaying  an  error  code  from
the OLAP database server.

Label Cells with members marked as labels
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Level 2 Level 3 Level 4 Level 5 Affects

in the database outline.

Data entry All cells on screen when in data entry
mode.

Read Only Cells the user has read-only access to
due  to  security  settings  in  the  OLAP
database server.

Atomic Cells  at  the  lowest  level.  No  other
cells  are  used  to  create  the  value  in
this cell

Aggregate Cells  that  are  an  aggregation  of
Atomic  cells.  Values  from  Atomic
cells make up the value in this cell

Changed

Value

Cells  for  which  the  user  can  change
the value during data entry.

Hold Cells that are put on hold.

Header The inspread row and column header
areas.

Row The row header area (Inspread).

Column The column header area (Inspread).

Offspread The  area  above  the  header  in  the
chart. The dimensions that define the
basis  of  the  inspread  members  are
not directly part of the table or chart.

Chart Graphic  display  of  data.  Charts
available  are:  Bar,  Line,  Area,  Pie,
Radar,  Bubble,  Scatter,  Range,  and
Map.

Chart Area Space on screen to place a chart.

Plot
Area

Space  in  a  chart  specifically  showing
data values

Axis Related to a category (X-axis) or value
(Y-axis).

Grid Lines within  a  plot  area  showing  the
relation  and  intersection  of  data
values.
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Level 2 Level 3 Level 4 Level 5 Affects

Maps Geographic  representation  of
location data.

Shapes Parts  that  make  up  maps  (for
example countries or regions).

Lines Lines can be available  in a shape file,
representing  rivers,  roads,  or
railroads.

Points Points  can  be  available  in  a  shape
file,  representing  cities  or  other
points of interest (offices,  customers,
etc.).

Labels Feature  names  for  charts  and  maps
or,  dimension  values  related  to  a
chart or charts.

Title Name for chart.

Legend Identifies  the  members  displayed  in
a chart or map.

Drill
Through

Space  on  screen  to  place  the  Drill
Through table.

Notes Space on screen to place the notes.

Title Background color for the title area.

Main Title The main title of the view.

Sub Title The sub title of the view.

Audit
Report

The Audit Report on a printed page.

Printed
Fonts

The  page  header  and  footer  area  on
printed pages.

Page Footer The  page  footer  area  on  printed
pages.

Page
Header

The  page  header  area  on  printed
pages.

Procedure
1. Select the FORMAT ribbon and click on the Styles button or right-click  in  the  table

and select Formatting > Styles.



57 Using Serviceware Performance Analytics

2. Select the format options that you want.

Tip: Click Reset All to reset all style formatting options.

Formatting generations and levels (Essbase only)

When  formatting  is  defined  for  Generations  as  well  as  Levels,  the  formatting  of
Generations will overwrite the Level formatting.

Procedure
1. Select the FORMAT ribbon and  click  on  the  Generations  &  Levels  button  or  right-

click in the table and select Formatting > Generations and Levels.

Level and Generation formatting overwrites Background and Style formatting.

2. Change the format options as desired.

Note:  If  you  move  a  member  with  specific  Generation  or  Level  formats  to  the
Offspread area, you can control how these settings are applied to the Inspread area.

Formatting levels (SSAS only)

When you use Microsoft Analysis Services as a data source, then you can format levels.

Procedure
1. Right-click in the table and select Levels.

2. Change the format options as desired.

Formatting fonts

You can change the font type and style. The formatting options are  applied to the display
and to the printed view. It is possible to change the text and background colors.

Procedure
1. Right-click and select one of the following:

• for a generation or level, Formatting > Generation and Levels > Style

• for a member, Formatting > Members > Style

2. Change the Font type, size or style.

Note: The display of Auto in the entry boxes means that the setting is derived from
the Style  for this member. A filled background  in  the  Font  Style  check  box  means
the font style is derived from the Style for this member.

3. To change color, click Text color and Back color.
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Formatting members

An individual member can be formatted.

You  can  also  right-click  in  the  table  and  select  Formatting  >  Members.  Then  select  the
members you want to format.

Member  formatting  overwrites  Background,  Style,  or  Generation  and  Level  formatting.
The default values for member formatting are derived from the Default style.

Procedure
1. Right-click the member you want to format, and select Formatting.

2. Select the formatting options that you want.

Formatting a cell

An individual cell can be formatted.

Procedure
1. Right-click the member you want to format, and select Formatting > Members.

2. Select the formatting options that you want.

Formatting prefix and display codes

You can determine how cell values are displayed.

The Prefix  is  left  aligned  and  can  be  used  for  such  things  as  currency  symbols  etc.  The
Display Code can be used to display negative values between brackets or to add a percent
sign to the cell values.

Procedure
1. Right-click a member and select Formatting > Members.

Note: The Display Code can be changed for a style, level or generation or a member.
The Prefix is only available for member formatting.

2. Type the codes that you want.

The default Prefix is empty Auto() and the default Display Code is Auto (#s). 

To display a percent sign next to the cell value, enter the Display Code: #s %. 

To display negative values between brackets enter the Display Code: (#s).

To add a dollar currency symbol in the prefix, enter $ in the Prefix field.

Date Time
It  is  possible  to  display  values  in  date  time  format.  This  is  achieved  by  converting  the
value of a cell to an appropriate date time value. 

The  value  is  the  number  of  days  since  01.01.1900.  Therefore  the  value  1  would  be
01.01.1900.
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It is also possible to define the output and input values of  the date. This allows numbers
in the following format to be supported 19000101 (01.01.1900).

Examples
The  following  table  contains  some  example  display  codes  and  describes  their
functionality.

Display Code Description Output

#s The  default  display  code  to  display  a
value

123

#s % The value is displayed as a percentage 123 %

#s $ The value is displayed as a currency 123 $

+#s;-#s;#s Positive, negative and zero based number
formatting.  Each  format  is  separated  by
semi-colon ";"

Positive: +123

Negative: -123

Zero: 0

+#s  %;-#s  %;#s
%

Positive, negative and zero based number
formatting for percentages. Each format is
separated by semi-colon ";"

Positive: +10 %

Negative: -10 %

Zero: 0 %

+#s $;-#s $;#s $ Positive, negative and zero based number
formatting  for  currency.  Each  format  is
separated by semi-colon ";"

Positive: +123 $

Negative: -123 $

Zero: 0 $

#d The  value  is  displayed  using  short  date
format.  This  value  is  taken  from  the
culture settings of the operating system.

The  possible  displyed  dates  are  from
01/01/1601 to 31/12/9999.

21/08/1984

#D The  value  is  displayed  using  long  date
format.  This  value  is  taken  from  the
culture settings of the operating system.

The  possible  displayed  dates  are  from
01/01/1601 to 31/12/9999.

21 August 1984

#d(DD-MM-
YYYY)

The  value  can  be  defined  in  a  custom
short date format

21-08-1984

#d(DD.MM.YYYY
;YYYYMMDD)

This format accepts two parameters: Date displayed as:

21.08.1984
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Display Code Description Output

Output format:
This is  the  format  to  be  displayed  in  the
table

Input format (optional):
This is the format in which the number is
stored

Note: If  no  input  date  format  is  defined,
the date is calculated by adding the value
to 01.01.1900

Date stored as:

19840821

Only the following input date format is supported YYYYMMDD.

Only dates from 01/01/1000 are supported when using the input date format.

Only English notations are supported when using date formatting.

Results
The formatting options are applied to the displayed view and the printed view.

Formatting decimal numbers

The number of decimal places can be set with formatting options.

Procedure
1. For a style, right-click and select one of the following:

• for a generation or level, Formatting > Styles.

• for a member, Formatting > Styles.

2. Change the number of decimals in the Decimals entry field.

Note: You can also type a negative value. The values in the cell will be rounded off  before
the comma.

Formatting scaling factor

To  improve  readability,  a  value  can  be  displayed  with  a  scaling  factor.  For  example,  to
display the actual values in units of 1,000 set the scaling factor to 0.001.

Values  in  the  database  are  not  changed  by  the  scaling  factor.  The  scaling  factor  only
controls the way values are displayed.

You can also set a scaling factor for each member from the Member Format dialog box.

Procedure
1. Select Options.
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2. Enter the scaling factor value.

Forcing read-only

When a cell  is read-only,  the cell  will  be  grayed out and cannot be edited when  starting
data entry. The OLAP database security determines if a cell  is protected from editing. It is
also possible to make a member Read Only using formatting.

Procedure
1. Select one of the following:

• For a style, Formatting > Styles.

• For a Level or Generation, Generation and Levels.

• For a member, Formatting > Members.

2. Select Force Read Only.

Note: A filled background in the  check  box  means  the  Force  Read  Only  style  is  derived
from the style for this member.

Formatting cell alignment

You can change the cell alignment with formatting options.

Procedure
1. Select one of the following:

• For a style, Formatting > Styles.

• For a Level or Generation, Generation and Levels.

• For a member, Formatting > Members.

2. Set the horizontal cell alignment to Left, Center,  Right,  Left and Right or Center and
Right.

3. Set the vertical cell alignment to Top, Center, or Bottom.

When  changing  the  vertical  alignment  for  individual  cells,  the  option  Quick  Row
Formatting on the Format tab of the Options dialog box should not be checked.

Left and Right specifies that the column headers closest to the data cells will be aligned to
the right, all other column headers will be aligned to the left.

Center  and  Right  specifies  that  the  column  headers  closest  to  the  data  cells  will  be
aligned to the right, all other column headers will be aligned in the center.

Note: Left and Right or Center and Right is only supported for the column header style. 
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Formatting column and row size

You can change the cell size by column or by row size with the formatting options.

Procedure
1. Select one of the following

• For a style, Formatting > Styles.

• For a Level or Generation, Generation and Levels.

• For a member, Formatting > Members.

2. Change cell width or height to adjust the column or row.

The unit of measure can be changed to characters, inches, or centimeters.

Note:  The  height  of  a  row  must  always  be  high  enough  to  display  one  line  of  all  the
different fonts and sizes in that row.
Using characters will  ensure that columns are  sized proportionally when the font or font
size is changed.

Displaying names

You  can  change  the  member  name,  as  it  is  displayed  on  screen,  without  changing  the
actual member or alias name in the outline of the OLAP database.

Procedure
1. Right-click a member and choose Change Display Name.

2. Type the new display name.

Note: To remove the display name and show the member or alias name again, right-click
the member with your secondary mouse button and choose Change  Display  Name
from the pop-up menu. Click Remove to remove the display name.
To reset all  display names to the original  OLAP database outline  names,  right-click
the window and choose Display Names > Remove All.

Quick formatting of rows

This is an option that controls how the row heights are  calculated. Be aware though, with
large tables, performance may be inhibited without using this option.

Procedure
1. Right-click and choose Options.

2. On the Format tab, de-select Quick Row Formatting.

Note:  The  height  of  the  entire  row  is  adjusted  to  accommodate  a  single,  changed  cell.
When  changing  the  vertical  alignment  for  individual  cells,  this  option  should  be
unchecked.
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Formatting borders and lines

Borders can be added to rows, columns and cells.  Borders can be set to all  areas  in  your
View.

The  orientation  of  borders  stays  the  same  when  you  move  members  on  your  screen.
Horizontal borders stay horizontal, vertical borders stay vertical.

Lines  and  white  spaces  can  also  be  added.  To  add  lines  and  white  space,  right-click  a
member and select Formatting.

Procedure
1. Right-click and click Formatting.

2. For a level or generation, select Generation and Levels.

For a member, select Members.

3. Do one of the following:

On the Borders tab select the border options that you want.

On the Lines tab select the line and white space options that you want.

Formatting precedence

You can control  what takes precedence when both rows and columns are  formatted. The
default setting is that columns take precedence over rows.

Procedure
1. Right click inside the grid and select Options... from the context menu.

2. Select the Format tab.

3. Select Apply Rows before Columns for rows to take precedence over columns.

Select Apply Columns before Rows. for columns to take precedence over rows

Formatting white space

You can improve the readability in the row or column area by adding white  space before
or after dimension members.

Tip: You can  format  the  space  around  a  member  by  selecting  Color  Cell  Spacing  on  the
Format tab of the Options window.

Procedure
1. Select the Headers tab in the Options window.

2. Under Automatic Group Spacing, type a value and select a unit of measure.
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Formatting number separators

You can change the characters used to display  the  decimal  separator  and  the  thousands
separator.

The default setting is derived from your Microsoft Windows setting.

Procedure
1. Select the Numbers tab in the Options window.

2. Type the characters that you want to use  for  the  Decimal  Separator  and  Thousand
Separator.

Formatting numbers

With the Group Size value you can control where to display the thousand separator.

Procedure
1. Click Options > Numbers.

2. From the Group  Size  menu,  select  where  you  want  the  thousand  separator  to  be
placed.

Traffic lights

You  can  apply  traffic  lights  to  all  members,  both  offspread  members  and  inspread
members, including members that you created with the calculator.  You  can  specify  how
the traffic light displays when the value is lower, in between, or higher than a  specified
value.

Procedure
1. Select  the  MEMBER  ribbon  and  click  on  the  Traffic  Light  button  or  right-click  the

member > Traffic Lights.

2. From the Based on menu select how the traffic light  is  calculated.  You  can  choose
from

Value

Specify values that are in the range of the values for the member.

Percentage

Specify values between 0 and 100. See Based on Percentage

Standard Deviation

Specify values that are based on normally distributed data. For example -1 and 1.
See Standard Deviation

3. In the Less than and More than fields enter the  lower  and  upper  value  limits  that
you want to use.

4. Select  how  to  display  the  traffic  light.  You  can  choose  any  combination  of  the
following options:
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Text Color 

Back Color 

Symbols

You  can  use  the  available  color  and  symbol  templates  or  set  your  own
combinations.

The next example shows a traffic light with colored text and symbols.

Swapping members that contain traffic lights

You  can  set  traffic  lights  for  offspread  members  just  as  you  do  for  inspread  members.
Traffic lights that are set for offspread members apply to the entire table.

Procedure
1. Swap a member that has the traffic light condition with an offspread member.

2. If you do not want the traffic light condition for offspread members to apply to the
entire  table, then on the Options tab of  the Traffic Light  dialog  box  select  Exclude
when in Offspread.

Changing traffic light settings

You can change the traffic light settings and values.

Procedure
Right-click a member name and select Traffic Lights.

Setting traffic light options

You can set several options that change the look and feel of traffic lights.

Procedure
1. In the Traffic Light dialog box, click the Options tab.

2. Select the options that you want:

Traffic Light Enabled

Select this option to enable the selected traffic light condition. When traffic light
conditions are set, clearing this option only removes the traffic light display.

Exclude when in Offspread
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Select this option to not apply traffic light conditions to the inspread area when
you drag the member with the traffic light condition to the offspread area.

Exclude Calculations

Select  this  option  to  exclude  from  traffic  light  conditions  any  values  that  you
computed using the calculator.

Treat Missing As Zero

Select this option if missing values should equal zero.

Create Color Ranges

Select this option to use colors to indicate the distance of the cell value between
the upper and lower value the cell value is.

Skip Groups for Ranges

When  you  have  stacked  dimensions,  the  members  of  the  outer  dimensions
group the cells in your view. In either option, the traffic lights affected are  based
on percentage or standard deviation and data bars.

If  Skip  Groups  for  Ranges  is  cleared,  then  the  range  of  values  that  are  found
within each individual group of cell derive the traffic lights.

If  Skip Groups for Ranges is selected, then the  range  of  values  found  across  all
groups of cells derive the traffic lights.

Symbol Position

Set the position of the symbol to the left or right of the value in the cell.  You can
also choose to only show a symbol instead of the value.

Use Text Color for

Use this option to specify whether the text color also applies to the symbol.

Example skip groups
The next examples show how the option Skip Groups for Ranges affects the traffic lights.

Skip Groups for Ranges is cleared
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Skip Groups for Ranges is selected
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Based on Percentage

The  option  Based  on  Percentage  allows  to  calculate  dynamic  bounds  based  on  the
minimum and maximum value within the given range. It determines if  a specific value is
within the lowest/topmost x percent of the range between minimum and maximum. 

First, we calculate the difference between minimum and maximum:

Delta = Maximum - Minimum

Then we calculate the bounds as 'x percent away from the minimum':

Bound = Minimum + Delta * X / 100

Now we can check if a specific value is above or below that calculated boundary. 

An Example: 

Looking at the values 50, 70, 80, 150. We get the 

Delta = 150 - 50 = 100.

Now setting a lower bound of 25%, we get: 

lower bound = 50 + 100 * 25 / 100 = 75

Thus, the value of 70 is below the bound, whereas the value of 80 is above the bound.

Standard Deviation

The option Standard Deviation allows to calculate dynamic bounds based on the standard
deviation within the set of  values. It determines if  a given value is far off  the average of
the values by comparing if it is below/above a certain factor of the standard deviation. 

First, we calculate the average value:

Average = Sum of all values / Number of values

Then we calculate for given values x_i the standard deviation:

Standard Deviation = SQRT(SUM((Average - x_i)² / Number of values))

The bound b_min/b_max defined in the traffic light now work as follows: 

Lower bound = Average + b_min * Standard Deviation

Upper bound = Average + b_max * Standard Deviation
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An Example: 

Looking at the values 5, 10, 15, 20, 50. We get the 

Average = (5 + 10 + 15 + 20 + 50) / 5 = 20.

Standard Deviation = SQRT(SUM((Average -  x_i)²)/ Number of  values)  =  SQRT(((20 -  5)²  +
(20-10)² + (20 - 15)² + (20-20)² + (20 - 50)²)  / 5) = SQRT(371)  19.26

Now lets say we define an upper bound of b_max = 1, then 

Upper bound = Average + b_max * Standard Deviation = 20 + 1 * 19.26 = 39.26

Thus, the value of 50 is above the bound (as it is far away from the other values),  whereas
all other values are below the bound.

Removing traffic lights

If you no longer need a traffic light, then you can remove it.

Procedure
1. Right-click the member and select Traffic Lights.

2. On the Traffic Light dialog box, click Remove.

Data Bars

You can apply Data Bars to all members, both offspread members and inspread members,
including  members  that  you  created  with  the  calculator.  You  can  specify  how  the  data
bars displays depending on the data bar type.

Procedure
1. Select  the  MEMBER  ribbon  and  click  on  the  Data  Bars  button  or  right-click  the

member > Data Bars.

2. In the Data Bar section of the dialog select the data bar type. 

Data Bar

Bars are displayed within the cell from left to right depending on their value. The
number is not displayed as text.

Variance Bar

Bars are displayed within the cell  using two different colors. One color (default:
red)  for negative  numbers and one color (default: green)  for  positive  numbers.
The number is not displayed as text.

3. In  the  Bar  Height  %  you  can  define  the  height  of  the  bars  in  relation  to  the  cell
height. Valid values are from 5 to 100.

4. In the Axis section  select  the  way  the  axis  is  calculated.  The  following  values  are
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available:

Automatic
The position of the axis is calculated based on the values.

Center in Cell
The axis is always in the middle  of  the cell.  Negative  numbers are  drawn on the
left-hand side of the axis. Positive numbers are drawn on the right-hand side.

None
This  option  draws  for  the  maximum  value  a  bar  using  100%  of  the  cell.  The
minimum value does not display a bar.

5. In the General section the following options are available

Data Bar Enabled

Select  this  option  to  enable  the  selected  data  bar  condition.  When  data  bar
conditions are set, clearing this option only removes the traffic light display.

Exclude when in Offspread

Select this option to not apply data bar conditions to the inspread area when you
drag the member with the data bar condition to the offspread area.

Exclude Calculations

Select  this  option  to  exclude  from  data  bar  conditions  any  values  that  you
computed using the calculator.

Skip Groups for Data Bars

When  you  have  stacked  dimensions,  the  members  of  the  outer  dimensions
group the cells in your view. In either option, the data bars affected are based on
percentage or standard deviation.

If  Skip  Groups  for  Ranges  is  cleared,  then  the  range  of  values  that  are  found
within each individual group of cell derive the data bars.

If  Skip Groups for Ranges is selected, then the  range  of  values  found  across  all
groups of cells derive the data bars.

The following picture displays a sample view using databars:

Figure 4 : Databar sample
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Sparklines

You can create sparklines for all dimensions. A sparkline displays a line  or bar chart inside
a  single  table  cell.  The  sparkline  is  typically  drawn  without  axis  or  coordinates  and
presents the general  shape  of  the  variation  of  a  member.  The  variation  is  typically  the
change of a value over time.

Procedure
1. Select  the  MEMBER  ribbon  and  click  on  the  Sparklines  button  or  right-click  on  a

member or on the table and select Sparkline…

2. To add a new sparkline click the Add button and enter the name for the sparkline  in
the field Member.

3. Click on the button …  at the right hand side  of  the  field  Data  Range.  The  member
selection  dialog  is  displayed  and  allows  you  to  define  the  members  for  the
sparkline. The dimension displayed is  always  the  innermost  column  dimension  of
the table.

4. In the Sparkline section of the dialog select the chart type.

Bar
Bars are  displayed within the cell  from  left  to  right  depending  on  the  member
list.

Line
A line is displayed within the cell

5. In the Colors section the color for the bars or the line  can be defined. For sparklines
of type bar a border can be drawn for each individual bar.

6. In the Points section special  points (members)  in the sparkline  can be highlighted.
The  following  values  are  available.  The  precedence  of  the  colors  is  from  top  to
bottom.

High Point

• Low Point

• Negative Point

• First Point

• Last Point

• Markers (line chart only)

7. In the Axis section  select  the  way  the  axis  is  calculated.  The  following  values  are
available:

Automatic
The minimum and maximum values define the scaling of  the  values  within  the
cell.

Value
An individual value defines the minimum/maximum value for the axis. 

Draw axis
Draws the axis as a single line from the left to the right border of the cell.

The following picture displays a sample view using a sparkline:
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Figure 5 : Sparkline sample

Additional Member Information in Table Cells

The data table  can display additional  member information  in  a  cell.  This  functionality  is
available for Essbase and SSAS databases. The name of  the attribute  dimension member
or attribute hierarchy member will be displayed respectively. 

The member information can be added as a new member to the table  by clicking on the
innermost column dimension or row dimension. The member selection dialog has a new
tab  named  “Attribute”.  In  this  tab  all  attribute  dimensions  (Essbase)  or  attribute
hierarchies (SSAS)  are  displayed. For every selected attribute  member  a  new  “member-
information member” is created.

The  position  of  this  new  “member-information  member”  depends  on  the  inspread
position of  this dimension. If  the selection is done in the innermost row dimension, the
innermost  column  dimension  will  get  a  new  member.  If  the  selection  is  done  in  the
innermost column dimension, the innermost row dimension will get a new member.

These new members have the same formatting possibilities than database or calculation
members. 

The  main  difference  of  a  “member-information  member”  compared  to  a  “calculated
member”  is,  that  a  calculated  member  is  directly  connected  to  its  dimension.  If  the
dimension is moved or swapped, the “calculated member” is moved as well.

A “member-information member” will stay in the column or row until  its base dimension
is moved or swapped and the base dimension will  not be  the  innermost  row  or  column
dimension.

The following picture displays a sample view showing the attribute Pkg Type.
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Figure 6 : Additional Member Information sample

Automation

The retrieval and selection of data can be automated.

Retrieving data manually

Use this option when navigating through very large outlines or when there is low network
performance.  Under  normal  conditions  automatic  data  retrieval  (the  default  setting)  is
able  to retrieve data as quickly as you can navigate  through the outline. However, when
the server or network performance causes some delays in the retrieval  process, switch to
manual retrieval and retrieve the data at the end of the navigation process.

Procedure
1. Right click inside the grid and select Options... from the context menu.

2. Click the Data tab.

3. The default setting is Automatically Retrieve Data. De-select this option to manually
retrieve data

4. Click Get Data.

Dynamic selection

A  DynaSelect  is  designed  to  automate  tasks.  With  a  dynamic  view  (a  View  with  a
DynaSelect) tasks can be performed automatically.

Dynamic views can be used to do such tasks as:

Checking sales persons who are behind budget (alerts monitoring)

Selecting markets with sales values over a certain value (value-based filters)

Displaying values from the current time period using substitution variables or UDA
(Essbase)

Printing  views  listing  only  products  behind  budget  for  each  region  (exception
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monitoring)

Setting up a view that displays the correct data entry cells in the case of  forecast or
budget entry

Setting up advanced member selections for example  all  cities with a population of
more than 1 million

All available functions can be incorporated into a dynamic view. Calculations in a dynamic
view  can  be  created  (and  deleted  again  if  needed),  members  can  be  selected  through
Properties (Microsoft Analysis Services only)  or  Substitution  Variables  (Essbase  only)  or
members can be selected by value. Members can be moved from the Offspread area and
back.

Limitation:  It  is  not  possible  to  record  changing  the  order  of  two  members.  But  it  is
possible to go into the Member Select Dialog. 
There one of the predefined order algorithms can be used, which can be recorded by the
DynaSelect.

Setting DynaSelect

There is no programming involved in setting up a dynamic view. You  can  teach  views  to
perform tasks by recording your actions.

When you have taught your view everything it needs to do, you can perform these tasks
at the following times:

On demand (F5)

When opening a view

When printing a view with a Print Range

When selecting another offspread member

Procedure
1. Right-click the table and click DynaSelect > Teach DynaSelect.

A red DynaSelect icon indicates that the DynaSelect is recording.

2. To stop recording, right-click Dynaselect > Stop Teaching.

3. To remove a  DynaSelect,  right-click  Dynaselect  >  Forget  DynaSelect.  A  DynaSelect
can be removed while it is recording or after.

Viewing DynaSelect

Dynamic views are automatically documented for you.

The actions of a DynaSelect can be viewed by using the View DynaSelect option.

Procedure
1. Right-click Dynaselect > View DynaSelect.

2. The View DynaSelect window displays all tasks that the view will perform.

Tip: If  you pause your pointer over the DynaSelect icon, you  will  also  see  all  tasks
happen when the DynaSelect is applied.
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Applying Dynaselect

You can run a DynaSelect at several occasions.

A DynaSelect can be run when:

Opening a view

Changing an Offspread member

Printing the View with a Print Range

On demand (by pressing F5)

Procedure
1. Right click inside the grid and select Options... from the context menu.

2. On  the  Data  tab,  click  Apply  DynaSelect  on  Load  and/or  Apply  DynaSelect  on
Offspread Changes.

3. To apply a DynaSelect on demand, press F5.

Results
When  a  DynaSelect  is  recorded,  the  complete  table  and/or  chart  layout  (including  the
calculations)  is  stored.  When  applying  a  DynaSelect,  this  initial  layout  is  restored  first.
After that, the recorded actions are re-played.

The only change to the initial layout can be in the offspread area. When the option Apply
DynaSelect on Offspread Changed is enabled, the new offspread layout is applied to the
initial layout.

Charts

Charts  are  a  graphical  way  of  presenting  information.  Use  charts  to  reveal  trends  and
relationships that are  not evident in tabular reports. For example, you can create  a chart
to visualize how actual sales compare to projected sales,  or to discover whether sales are
falling or rising over quarterly periods.

Use maps to display chart data geographically.  For example, create  a  map  to  show  sales
data for regional sales offices by city.

Use performance maps to visualize the behavior of  two members of  a dimension relative
to members of another dimension.

This  chapter  uses  two  elements:  data  series  and  category.  The  chart  below  describes
these two elements.
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Figure 7 : Charts

1. Data  Series  -  A  group  of  related  data  points  plotted  in  a  chart.  Each  series  has  a
unique color or pattern and is described in the legend.

2. Category  -  Groups  of  related  data  from  the  data  series,  plotted  on  the  x-axis.
Categories of  multiple  data series are  shown together using clustered  and  stacked
data markers

Chart types

To  choose  a  chart  type,  consider  what  you  want  the  chart  to  illustrate.  Different  chart
types and configurations emphasize different things.

Chart Type Icon

Bar chart

Line chart

Area chart

Pie chart

Radar chart

Bubble chart

Scatter chart

Range chart

Dial chart

Maps

Performance map
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Bar chart

Bar charts are  useful  to show the relative  performance of  different data  series  between
categories, or to show trends over time. Bar charts can be either vertical or horizontal. The
vertical bar chart can be called a column chart.

The example shows the relative performance of eight sales outlets over four quarters.

Figure 8 : Bar Chart

Line chart

Line  charts  show  the  trend  between  different  data  series  over  a  period  of  time.  The
example shows the sales trend for three different sales outlets over one year.

Figure 9 : Line Chart

Area chart

Area charts are useful for emphasizing the magnitude of change over time. The area chart
is based on the line graph.

The example  shows the relative  sales volume for three different  sales  outlets  over  one
year.
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Figure 10 : Area Chart

Pie chart

Pie  charts show the total  for the data  series  in  proportion  to  each  other.  Pie  charts  use
segments of  a circle  to  show  the  relationship  of  parts  to  the  whole.  To  highlight  actual
values, use  another chart type, such as a stacked area chart.  Pie  charts plot a  single  data
series.  To  avoid  multiple  charts  when  plotting  multiple  data  series,  use   a  100  percent
stacked chart.

The example shows the relative sales of three different product outlets for one year.

Figure 11 : Area Chart

Radar chart

Radar charts are  useful  as a comparative  tool  for charts that only have a few data  series.
Radar charts integrate multiple axes into a single radial figure. Data is plotted on each axis
and joined to adjacent axes by connecting lines.

The example shows the sales for six product outlets over one year.
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Figure 12 : Radar Chart

Bubble chart

Bubble  charts,  like  scatter charts,  use  data points  and  bubbles  to  plot  measures  along  a
scale. The size of the bubble represents a third measure.

The  example  shows  the  relative  sales  of  three  outlets  over  four  quarters.  The  X  axis
represents one outlet, the Y axis a second, and the size of the bubble represent the third.

The  symbols  in  a  bubble  chart  can  be  changed,  for  more  information  see  Formatting
members in a chart.

Figure 13 : Bubble Chart
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Scatter chart

In a scatter chart,  the data is displayed as a collection of  points,  each having the value of
one variable  determining the position on the horizontal  axis and  the  value  of  the  other
variable  determining the  position  on  the  vertical  axis.  In  the  example  the  sales  of  two
different products are compared for each month. The Y axis represent one product,  and X
axis the other. Each dot represent a store outlet for a particular month.

The  symbols  in  a  scatter  chart  can  be  changed,  for  more  information  see  Formatting
members in a chart.

Figure 14 : Scatter Chart

Range chart

A  range  chart  shows  how  an  initial  value  increases  by  a  series  of  intermediate  values,
culminating in a final value. An invisible column keeps the increases and decreases linked
to the heights of the values of previous columns. The example shows how the sales value
differs according to the outlet type.

Figure 15 : Range Chart

Format using Deltas option only works with non-composite  bars. This option allows AL to
use Zero Positive and Negative styles to define the color of the bars in the range chart.
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The color of the bar is painted related to the value of the previous bar. For example, if  the
value  of  a  single  bar  is  less  than  the  previous  bar  then  the  color  of  the  bar  will  be  as
defined in the Negative style.

Figure 16 : Range Chart Options

Figure 17 : Range Chart Styles
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Figure 18 : Format Using Deltas

Dial chart

A  dial  chart  shows  one  or  more  values  as  needles  on  a  circular  scale.  Dial  charts  are
especially suitable for creating visually appealing dashboards.

Figure 19 : Dial Chart

Maps

Maps show statistical information over a topological  or geographical  representation of  an
area.
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Performance map

In performance maps the data is shown by the area of  the data type. Performance  Maps
help to visualize  the  behavior  of  two  members  of  a  dimension  relative  to  members  of
another dimension. The size  of  the Performance Map areas indicates the relative  values
of  cells in the first column of  the table  view to the total  value of  the first column, while
the  coloring  mode  takes  the  properties  of  cells  from  the  second  column  to  color  the
areas.

Figure 20 : Performance Chart

Working with charts

Creating a chart

A chart is made from the members that are in the view of a table representation.

These members are selected using the table view Sort & Select dialog box.

When the table  has stacked dimensions in rows or in columns, the chart is based on  the
most inner dimensions. The outer dimensions are moved to the bottom of  the chart pane
with the  selected  members  retained.  If  you  have  multiple  rows  in  a  table,  the  chart  is
based on inner rows. You can use the outer rows as additional selection criteria.

Selecting a chart

When you select a chart, then you need to make sure that the members in the table  view
are what you need to display as a chart.

Procedure
1. Select LAYOUT ribbon or click the Chart View icon on the tool bar.

2. Select the chart type.

3. To change a member selection, click in the chart over the member.

Hint: Place the cursor over the member you want to change. If  the member details
show, you can change the member selection.
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4. In the Select Member dialog box, change the member selection.

Results
The table changes when selecting new members for the chart.

Note: You can select other members in the offspread dimensions when you have a chart
on screen. The same chart can be used for different member combinations.

Changing a chart type

You  can  change  the  type  of  chart  by  right-clicking  the  chart  and  choosing  a  style  that
better suits the data.

The chart type can be changed on the Chart Type tab on the Options dialog box.

Procedure
1. Right-click the chart and click Options.

2. From the Chart Type tab, click the required chart type.

3. Click OK.

Changing member properties for charts

You  can  change  settings  for  the  symbol,  color  shape  and  fill  pattern  for  members
depending on the chart type.

The chart symbols can be changed on the Chart tab on the Member Formatting dialog box.

Procedure
1. Right-click the member on the chart or table and click Formatting.

2. From the Chart tab, click the required color, symbol or fill pattern.

3. Click OK.

Selecting members in a chart

You  can  select  or  change  members  in  a  chart  by  clicking  the  members  and  making
selections in the Member Select dialog box.

Procedure
1. In the chart, click a member.

The Select Members dialog box appears.

2. Make the selection of  members, select items in the hierarchical  list,  and then click
OK.

You can also go back to the table  view by using the Table  button under the LAYOUT
ribbon to select other members.

Results
The new members appear in the chart.
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Changing the order of members in a chart

You can reorder members.

To reorder members, click a member and  use  the  up  and  down  arrows  on  the  Member
Select dialog box to change the position of the member relative to other members.

When  color  formats  are  not  set  from  members,  the  color  remains  with  the  order  of
placement.  If  the  first  member  is  blue,  when  you  move  the  first  member  to  the  third
position, the new first member is also blue.

Note: You can determine the individual  color  of  a  chart  member.  For  more  information
see Formatting members in a chart.

It is not possible to change the order of members in combination with DynaSelect.

Procedure
1. In the chart, click a member.

The Select Members dialog box appears.

2. Click the Order tab.

3. Click  the  member  whose  position  you  want  to  change,  and  then  click  the  up  or
down arrows to move the item relative to the other members.

4. Click OK.

Note: The order of  members  can  also  be  changed  by  moving  them  in  the  legend.
Click the member you want to move and drag it to its new position.

Formatting members in a chart

You can customize the formatting options for a member.

The following formatting options are available:

Color.

Symbol for Line and Radar charts.

Fill Pattern for bar, area, pie and map charts.

Line Width for line and radar charts.

Symbol Size for Line, Scatter and Radar charts. The option Symbol  on Lines must be
checked in the Chart Type tab of the Options dialog box.

Label Text. The option Display Values must be checked in the Chart Type  tab of  the
Options dialog box.

Label Back.

Display Label  sets or suppresses a label  to one or more points in the chart.  A  solid
background in this check  box  means  the  setting  is  derived  from  a  formatted  row,
columns or from the level or generation formatting.

Procedure
1. Right-click the symbol in the chart and click Formatting.
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2. Click the Chart tab.

3. Select formatting options and click OK.

Note: You can select the option Same  As  Table  from  the  drop-down  menu  to  apply  the
table formatting to the chart member.

Combining a chart with a table

Both a table and chart can be visible on screen at the same time.

4.5.2.8.1  Adding a chart to the current table view

You can add a chart to the current table view.

Procedure
1. In the LAYOUT ribbon, click Both.

2. To resize the chart, drag the splitter in the middle of the window.

4.5.2.8.2  Adding a table to the current chart view

You can add a table to the current chart view.

By default, the chart is shown on the right side  of  your screen. You can change this in the
Options dialog box, Layout tab. Select the place where you want the chart  to be placed on
screen.  You  can  choose  to  see  the  chart  on  the  top,  left,  right,  or  bottom  side  of  the
screen.

Procedure
1. Right-click the chart, and then click View As Table and Chart

2. To resize the table, drag the splitter in the middle of the window.

Changing the legend in a chart

By default, a legend is displayed in the chart.  You can hide or reposition the legend. You
can also add a title to the legend.

Tip: To hide the legend, right-click the chart and deselect the Legend option, or from the
pop-up menu, click Options and on the Chart Type tab, deselect Legend.

Procedure
1. Right-click the chart and then click Options.

2. On the Chart Options tab, in the Legend Position drop-down box, click the position
of the legend.

3. To add a title, in the Legend box type a title.

4. Click OK to close the dialog box.

To  change  the  appearance  of  the  legend,  right-click  the  legend  and  select  the
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Format Styles tab.

5. Change  the  legend  styles,  such  as  font  type,  size  and  style,  text  and  background
color, and borders.

6. After you have finished updating the legend options, click OK.  The legend appears
with a title.

Drilling up or drilling down in a chart

You can drill  up and drill  down to change the focus of  your  analysis  by  moving  between
levels of information.

Drill  up to compare results.  For example, you can examine  revenue  for  a  single  product
and then drill up to see revenue for the entire product line for comparison.

Drill down to see more detail. For example, you can drill down to the lowest-level item to
examine the impact of a single aspect of your business.

4.5.2.10.1  Drilling up

This section describes how to drill up.

Procedure
1. Right-click the member on which to drill.

2. From the pop-up menu, click Drill up.

4.5.2.10.2  Drilling down

This section describes how to drill down.

Procedure
1. Right-click the member on which to drill.

2. From the pop-up menu, click Drill down.

To  include  the  parent  in  your  chart,  click  Include  Children  Here  instead  of  Drill
down.

Note: You can also Drill up and Drill down by right-clicking the legend.

Adding a background image to a chart

You can add an image, that is stored in the Performance Analytics server repository, as a
background image to a chart.

Note:  For  information  about  adding  images  to  the  Performance  Analytics  Server
repository,  consult  the  Serviceware  Performance  Analytics  Server  Installation  and
Administration Guide.

Procedure
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1. Right-click the chart and then click Format Styles.

2. Click the Background tab.

3. From the Image menu select an image.

4. Choose an Image Mode:

To display the image in its original size, select Normal.

To display the image in its original  size  and repeat it so that it fills the available
space in the window, select Tile.

To stretch the image to fill the window size, select Stretch.

To stretch the image while maintaining the aspect ratio, select Stretch Ratio.

5. To move the image, set the Image Alignment using the Horizontal and

Vertical boxes and corresponding offsets.

6. To move the chart, set the Chart Margins.

Tip: To position the image next to the chart, set the top and left margin of  the chart
to higher values.

7. Click OK.

Results
The chart appears with a background image.

Customizing the axes of a chart

For a bar, line, area, or radar chart you can set the amount of ticks and labels on the x-axis
to improve the readability of the x-axis.

For a bubble or a scatter chart, you can set the y-axis as well as the x-axis.

For a dial chart you can set the amount of ticks on the axis to improve the readability.

There are  two scaling options, Automatic and Custom. The  Automatic  option  sets  the  y-
axis to the lowest and highest integer value in the chart.

The Custom options are:

Number of Labels

Number of Gridlines

Maximum Value

Minimum Value

Note: For the Number  of  Gridlines  option  to  be  active,  Vertical  Grid  or  Horizontal  Grid
must be enabled on the Chart Type tab of the Options dialog box.

Procedure
1. Click the Options icon on the tool bar.

2. Select the Chart Type tag.

3. To  change  the  orientation  of  labels  from  horizontal  to  vertical,  set  the  Vertical
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Labels check box.

4. To reduce the number of  labels on the chart increase the value of  the  Label  every
box.

5. To reduce the amount of ticks on the chart, increase the value of the Tick every box.

6. Select Scaling options:

Click Automatic to set the y-axis to the nearest integer value in the chart.

Click Custom to manually select the options.

7. Click OK.

Results
The chart displays with the options you set for label orientation and scaling.

Setting the origin of a chart to zero

For a line, dial, radar, or bubble chart, you can set the origin of the scale to zero.

Note: When setting the primary scale  to Zero Origin and the secondary scale  to  Same  as
Primary, the secondary scale will have a zero origin as well.

Procedure
1. Right-click a table or chart and click Options.

2. On the Chart Type tab, set the Scale Type to Zero Origin.

Generating a chart with two scales

If  you  need  to  plot  two  members  with  different  scales,  such  as  absolute  figures  and  a
percentage, a chart with two scales (two y-axes) can be created.

Procedure
1. To enable the second scale, right-click the chart and select Options.

2. On the Chart Type tab, under Secondary Chart, set the Enable check box.

The settings of the second scale  as well  as the settings for the primary chart can be
adjusted.

Tip: If you use the pull-down list with the second scale, you can also choose to make
the second scale identical  to the primary scale, or for both scales to have the same
origin.

3. When  you  have  a  second  scale  and  you  want  more  members  beyond  the  last
member on the second scale, adjust  the  Last  rows  used  option  on  the  Chart  Type
tab.

Tip: When the values of  the second scale  are  very different from the values of  the
primary scale, it might give a better overview to use the option Same Origin.

4. Click OK.

Results
The chart appears with both scales.
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Generating a chart with stacked dimensions

If  you have stacked dimensions  you  can  create  a  chart  using  these  stacked  dimensions.
Two stacked dimensions can be merged into one.

For example, if  your table  contains  the  dimensions  Scenario,  with  members  Actual  and
Prior,  and a dimension Year with 3 months, you can create  a chart  over  all  6  months.  By
merging columns, the chart displays the data over two stacked dimensions (with 2 times 3
months) as if it were one dimension with 6 months.

Procedure
1. Right-click the chart and select Options.

2. On the Chart Options tab, set the Merge Columns check box and click OK. 

Note: On the Options dialog box, on the Chart Type  tab,  you  can  check  the  option
Vertical Labels.

Small Multiples

It is possible  to create  small  multiples also known as a Trellis chart.  A small  multiple  can
be used to display each data series in its own chart.  This functionality is available  for bar,
line and area charts.

Note: Each chart will  always use  the same axis scaling. This is to enable  easy comparison
of the charts.

Multi-dimensional  small  multiples  can  be  created  by  stacking  rows  in  the  table  and
activating the merge rows option. The  small  multiple  option  can  be  activated  using  the
ribbon user interface or directly in the chart option dialog.

There are a number of  options that can be configured for small  multiples. If  the selected
chart  type  supports  small  multiples,  a  panel  will  be  displayed  in  the  option  dialog
containing all the available options.

The following options are available:

Show as a Small Multiple
Enables or disables the Small Multiple chart.

Height
Sets the height in pixels of each chart.

Width
Sets the width in pixels of each chart.

Number of charts per row
Defines how many charts are visible on each row. 0 means that all  charts will  be  on the
same row. This option is ignored when creating multi-dimensional small multiples.

Show Axis
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Controls the axis visibility. The possible values are.

o Outside
The axis is only displayed on the outside of  the small  multiple,  no axis will  be  shown
for the inner charts.

o Always
The axis is always visible for each chart.

o None
No axis will be displayed.

Series Color
Sets the color of the data series for each chart.

If  a  valid  matrix  can  not  be  created  due  to  values  being  suppressed  or  asymmetrical
selections, then the header for each chart will be displayed.

Swapping the axes for a table or a chart

You  can  swap  the  x-axis  and  y-axis  of  both  the  table  and  the  chart,  either  together  or
separately. To swap the x-axis with the y-axis,  drag the members and drop  them  on  the
other axis. Swapping the axes will change the chart from horizontal to vertical.

If only the chart should change, and not the table, use  Chart Options to set the Flip Data
on Axis check box. Only the axes in the chart will change, not the table.

Changing the axes for the table and chart

This section describes how to change the axes for the table and the chart.

Procedure
1. In the Table view, drag and drop members from one axis to the other.

The  x-axes  and  y-axes  have  changed  position.  The  data  on  the  axes  can  also  be
flipped.

2. To exchange data on an axis with the legend, in the Chart view, drag the members
from the axis to the legend.

The table and chart are now changed.

Changing the axes for the chart only

This section describes how to change the axes for the chart.

Procedure
1. To swap only the chart, and not the table, right-click the chart.

2. Click Options and then click the Chart Options tab.

3. Set the Flip Data on Axis check box and click OK. The selected axes are exchanged.
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Maps

One  of  the  most  important  features  of  Maps  is  that  a  map  can  be  associated  with
members in your database. Your data can overlay either a geographical  map or a physical
structure. An office, an aeroplane, or a ship are examples of structures.

The  association  of  a  database  to  a  map  is  done  during  the  installation  process  in  a
mapping file.

Associating data to a map

Maps are installed during the setup process. To link a table to a map do these steps:

Procedure
1. Select the members you want to display as a map.

For  example,  in  the  rows,  select  market  cities  and  in  the  columns  select  the
dimension that contains the data, such as products that you want to analyze.

2. Click the Chart button, and then click Map.

To deselect members from the map, right-click an item and click Deselect.

Results
A map is now shown, focused on the members that were selected  in  rows  of  the  table.
The column members are shown as a pie chart.

Placing a chart on a map

A map can display data either as a label, a chart (Pie or Bar), or as a Traffic Light condition.

Procedure
1. Click the Options button.

2. To display data as a chart, select the overlay type from the Options dialog box, Chart
Type tab.

When initially viewing a Map, the data is displayed as a Pie chart.

3. Click the Options button in the tool bar, or right-click the map and click Options.

4. On the Chart Type tab, select Bar Chart as the overlay.

You can also control additional settings for the chart,  such as Display Total,  3D-Look,
Legend and Outlined.

5. Set other chart options and click OK.

Results
Every shape that has a corresponding member in the table now shows a bar chart with the
data in the columns displayed as Bar charts.

Tip: When choosing None as the overlay type on the Chart Type  tab of  the Options dialog
box, the data will be displayed as a label when you check the option Display Total.
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Viewing traffic light conditions on a map

Traffic  Light  conditions  in  a  table  can  be  viewed  in  a  map.  The  shapes  in  the  map  are
colored either using the text color or the background color of the Traffic Light condition.

Procedure
1. In  the  Options  dialog  box,  select  the  Chart  Type  tab  and  set  Traffic  Light  as  the

overlay type.

2. Make sure Use Background Color is selected in the Traffic Light options.

3. Click OK.

Performance maps

A performance map is  a  chart  that  presents  data  by  using  different  sizes  and  colors  for
performance map areas. Performance maps visualize  the behavior of  two  members  of  a
dimension relative to members of another dimension.

A performance map is defined by the rows and the first two columns in a view. Each row
identifies a performance map area. The first column defines the size  of  the performance
map area. The second column defines the color of the performance map area.

The size of the performance map areas indicates to what extent the values of  cells in the
first column contribute to the total value of the cells in the first column.

If the performance map option Fixed Text Size  is not enabled, the size  of  the text in the
performance map areas corresponds to the size of the performance map areas.

The  colors  of  performance  map  areas  are  used  to  identify  values  of  cells.  This
identification can be defined in two ways:

By  using  the  Cell  Text  Color  or  Cell  Background  Color  via  either:  Traffic  Lights  or
Formatting.

By specifying the Lower Bound and Upper Bound via either Fixed Values or Standard
Deviation.

Creating a performance map

Create  performance  maps  to  visualize  the  behavior  of  two  members  of  a  dimension
relative to the members of another dimension. Performance maps enable  you to present
data by using different sizes and colors.

The  layout  of  performance  maps  can  be  customized  to  your  needs.  There  are  several
options available. All  options are  available  on the  Chart  Type  tab  on  the  Options  dialog
box. Some commonly used options can also be selected by right-clicking the performance
map.

Procedure
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1. Place two members of a dimension in the first two columns of a table.

The  member  in  the  first  column  determines  the  size  of  the  areas  of  the
performance map. The member in the second column determines the color  of  the
areas on the performance map.

2. Place a dimension in the rows.

Note:  Only  the  first  two  columns  are  taken  into  account  when  you  create  a
performance map.

3. After you have set up the table, click Chart > Performance Map.

You  can  now  set  options  for  the  performance  map,  including  options  that  are
specific  to  performance  maps,  such  as  Display  Caption,  Fixed  Text  Size,  Ordered,
and Add Hierarchy.

4. To display captions for member node items, set the Display Captions check box.

5. To display uniform text size for all items, set the Fixed Text Size check box.

6. To display members in the same order as they appear in the rows of  the table, set
the Ordered check box.

7. To group items according to the hierarchical  structure, set the Add Hierarchy check
box.

8. After you have finished setting options, including coloring options, click OK.

Results
The performance map appears.

Setting the performance map options

The layout of Performance Maps can be customized to your needs.

There are several options available. All options are available on the Chart Type  tab on the
Options dialog box. Some commonly used options can  also  be  selected  by  right-clicking
on the Performance Map.

The options that are specific to Performance Maps are:

Display Captions

The  Display  Captions  option  determines  whether  captions  are  displayed  when
Parents or Ancestors of the members are selected.

Fixed Text Size

The  Fixed  Text  Size  option  changes  the  size  of  the  text  that  is  shown  in  the
Performance Maps areas to one size. With this option turned on, the text size  is no
longer  dependent  on  the  size  of  the  areas  in  the  Performance  Map.  For  optimal
clarity, display the captions when you choose Fixed Text Size.

Ordered

The Ordered option determines in what order the areas in a performance map  are
displayed. By default the chart  areas  are  displayed  using  an  algorithm  that  makes
the  areas  as  square  as  possible.  If  you  select  the  option  Ordered  the  areas  are
displayed in the same order as the members in the rows, starting at the top-left and
ending at the bottom-right.
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Add Hierarchy

The Add Hierarchy option adds areas around child members if  a child member  and
its ancestor are selected, and, if the parent of that same child is not selected.

Procedure
1. Right-click the chart and click Options.

2. On the Chart Options tab, set the performance map options and click OK.

Results
The performance map options appear.

Setting coloring for performance maps

You can change the color options for a Performance Map with the Coloring Mode.

The Lower Bound and Upper Bound values allow you to specify an interval  by using fixed
values. The Create Color Range option lets you choose to create a blended color range.

Procedure
1. Click the Options button.

2. Select the Chart Type tab.

3. Check the Fixed Values option.

4. Use the side scroll bar to access the color options.

5. Change the color options for the Lower Bound Color,  Mean Color,  and Upper Bound
Color.

6. Click OK.

Data entry

Data entry gives you the ability to do data modeling and forward planning based on actual
data. Data entry is subject to the security set for the database. You can enter data to the
cells allowed by the OLAP server. All other cells are grayed out and cannot be edited.

Entering data in SSAS and Essbase

Data entry is available  when the required members are  selected and Data Entry mode is
active.

Microsoft Analysis Services and Essbase require  the user to explicitly send the data. IBM
Cognos TM1 values are directly updated as they are entered.

To enter data directly into the OLAP database, do the next procedure.

Procedure
1. Select the NAVIGATE ribbon and click Data Entry or right-click  the  table  and  select
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Start Data Entry.

This action puts you in Data Entry mode. You can still  change  the  selections  in  the
table and navigate through your data.

2. Type either a new value directly in any editable  cells,  or press F2 or Enter to make
the cursor active in a cell and type the new value.

Or, press F2 or Enter when the cursor is on an editable cell.

3. After  you  have  entered  new  values,  press  Send  Data  to  send  the  changes  to  the
OLAP Server. Or right-click the table and select Send Entered Data.

A confirmation screen that asks Are you sure you want to send entered data to your
Database? is shown to verify that you are ready to make these changes:

Select Yes to send the data to the server.

Select No to ignore all changes and restore the old values.

Note: You can also right-click and select Cancel Data Entry or press the Esc button to
ignore changes.

If  you cancel  the data entry, another confirmation screen displays  to  give  you  one
more chance to discard your changes or to make  them  take  effect.  It  asks  Are  you
sure you want to cancel the entered data?

Select Yes to cancel the newly entered data and restore old values.

Select No to prevent the discarding of your changes. You have another chance to
send the new data or restore the old values.

Note: When the cursor is on a cell,  press the Delete  button on the keyboard to set
the value of the cell to Missing. Cells with a new value are highlighted.

Note:  See  Spreading  for  more  information  about  entering  large  amounts  of  data
automatically.

4. To stop the data entry, click Stop Data Entry or right-click the screen and select Stop
Data Entry.

Entering data in IBM Cognos TM1

Data entry is available  when the required members are  selected and Data Entry mode is
active.

IBM Cognos TM1 with sand boxing enabled requires the user to explicitly send the
data.

Data entry in IBM Cognos TM1 is subject to IBM Cognos TM1 security.

When the cell  is greyed out editing is not allowed in a cell  or a cell  is not  a  stored
value, the cell is grayed out. A grayed-out cell  cannot be edited. White  cells can be
edited.

Cells that have changed values because of data entry, are indicated with a color.

In  data  entry  mode,  you  can  still  change  the  selections  in  the  table  and  navigate
through your data.
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Procedure
1. Right-click the table.

2. Select Start Data Entry from the shortcut menu.

This action puts you in Data Entry mode.

3. Type either a new value directly in any editable  cells,  or press F2 or Enter to make
the cursor active in a cell and type the new value.

4. Click Send Data.

Spreading

Spreading is a process that distributes entered values across a range of selected cells.  This
distribution occurs according to the spreading option that is set.  Spreading  is  performed
while in Data Entry mode and provides a quick and clear view of how new data affects the
values in cells.

The following spreading options are available:

No Spreading

Data can only be entered at the lowest level.  Spreading can  not  be  applied  to  the
cells of a consolidated cell.

Equal Spread

o A specified input value to one consolidation cell  is  distributed  to  the  leaves  of
the  consolidation  cell.  The  distributed  values  are  in  proportion  to  the  initial
value of the leaves.

o A specified input value for a range of cells is distributed equally across the range.

o A specified input value for  a  range  of  consolidation  cells  is  distributed  equally
across the range. The values of  the leaves of  the consolidation cell  are  changed
in proportion to their initial value.

Equal Leaves Spread

o A specified  input  value  for  one  consolidation  cell  is  distributed  equally  to  the
leaves of the consolidation cell. The distributed values are  spread equally across
the leaves.

o A specified input value for a range of  consolidation cells is repeated across  the
range.  The  distributed  values  are  spread  equally  across  the  leaves  for  each
consolidation cell.

Repeat

o A specified input value for a range of cells is copied to all cells across the range.

o A  specified  input  value  for  a  range  of  consolidation  cells  is  copied  to  all  cells
across the range. The values of  the leaves of  the consolidation cell  are  changed
in proportion to their initial value.

Repeat Leaves

A  specified  input  value  for  a  consolidation  cell  is  copied  to  all  leaves  of  the
consolidation  cell.  The  specified  value  can  be  either  copied  to  all  leaves  of  the
consolidation cell or to only those leaves that contain values by using the All  Leaves
spreading action.
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Percentage Change

The initial  cell  value is multiplied by the specified percentage. The product of  that
multiplication can then replace, be added to, or be subtracted from the existing cell
value.

Straight Line

A range of cells is populated by a linear interpolation between a start value and an
end  value.  If  applied  to  a  range  of  consolidation  cells  then  the  interpolation
happens on the consolidation cells. The leaf cells are changed in proportion to their
initial value.

Growth Percentage

A range of cells is populated by a percentage change interpolation. The initial  value
is sequentially increased to all cells by the specified growth percentage.

Relative Proportional  Spread

A specified input value for a consolidation cell is distributed across the leaves of the
consolidation  cell.  The  distributed  values  are  in  proportion  to  the  leaves  of  a
referenced consolidation cell.

Relative Growth  Percentage

Populates the leaves of  a consolidation cell  from a percentage  change  input  value
for the consolidation cell. The change to the values of  the leaves is in proportion to
the leaves of a referenced consolidation cell.

The second part of  the Spreading Options menu lists the Spreading Actions you can take
when applying spreading:

Replace

The entered data replaces the existing data.

Add

The entered data is added to the existing data.

Subtract

The entered data is subtracted from the existing data.

All Leaves

Only available for Types Equal Leaves Spread and Repeat Leaves.

The value is distributed to all  leaves of  the  consolidation  instead  of  only  to  those
that contain values.

General spreading procedure

The general procedure for spreading data is the same for each spreading type.

Note: Spreading type can also be set using the IBM Cognos TM1 spreading shortcut codes
entered directly into a cell. See Data spreading codes for more information.

Procedure
1. Open the view in table mode.

2. Enter Data Entry mode.
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3. Select the consolidation cell or range of cells on which you want to perform the data
spreading.

4. Select one option from the Spreading type menu and one from the Spreading action
menu.

5. Enter the new data to be spread.

6. Exit Data Entry mode.

Pick lists

If you want to perform data entry with predefined values, then use pick lists. Pick lists are
not available by default.

You have to set up the TM1 cube to support pick lists.  For more information, see the IBM
Cognos TM1 Developer Guide.

Procedure
1. Create a view and select dimensions and inspread and offspread members in such a

way that you have cells in your view that support pick lists.

2. Right-click on a cell > Data Entry.

3. Click the pick list menu button    and select a predefined value from the list.

Spreading options

There are two methods you can use to spread data across cells and leaves:

Type the spreading control  codes (also called data spreading syntax  expressions or
shortcuts) directly into a cell.

Use the Spreading Types and Spreading Action menus from  the  Spreading  Options
 menu.

Data spreading codes

Each data spreading control code consists of the following components: a method code, a
data action (optional), direction indicators, and method parameter.

The letters are abbreviations and indicate the spreading types. The signs are  optional  and
indicate the spreading action.

Consider the following when using spreading control codes:

If the data you entered does not start with one of  the spreading control  codes, the
Spreading Options menu determines the way in which data is updated.  When  two
numbers are needed separate the numbers using a colon (:).

If the entered data starts with a valid spreading control  code, all  options set in the
Spreading Options menu are overruled

Spreading  Control
Code

Spreading Menu Option Example

S+,~<n> Equal Spread S+100
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Spreading  Control
Code

Spreading Menu Option Example

LS+,~*<n> Equal Leaves Spread LS~*100

P+,~<n> Proportional Spread P100

R+,~<n> Repeat R100

LR+,~*<n> Repeat Leaves LR*100

P%+,~<n> Percentage Change P%+10

Keep <n> Percentage of original value keep 90

Increase, Inc <n> Increase by n percentage change Inc 10

Decrease, Dec <n> Decrease by n percentage change Dec 10

SL+,~<n1:n2> Straight Line SL100:200

GR+,~<n1:n2> Growth Percentage GR20:80

RP+,~<n> Relative Proportional Spread RP100

R%+,~<n> Relative Growth Percentage R%+5

Operands Equivalent spreading action

None Replaces original value with specified value

<n>k Multiplies specified value by 1000

<n>m Multiplies specified value by 1,000,000

Add, +<n> Adds a specified value n to the original value

Subtract, Sub, ~<n> Subtracts a specified value n from the original value

asterisk (*) All  Leaves.  Valid  only  when  using  Equal  Leaves  Spread  or
Repeat Leaves.

Examples of data spreading

The following examples of  spreading will  help you formulate  the  appropriate  spreading
measures for your data.

Using No spreading
The  No  spreading  type  disables  spreading.  Spreading  is  not  applied  to  the  leaves  of  a
consolidation cell.

Using Equal spread
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The  Equal  Spread  type  distributes  a  specified  value  equally  across  selected  cells.  The
values in the leaves of consolidation cells are changed in proportion to their initial value.

This example replaces the highlighted cells with a value of 1000 spread equally across the
cells.

The result is as follows

Procedure
1. Enter Data Entry mode.

2. Select Equal Spread from the Spreading type menu.

3. Select Replace from the Spreading action menu.

4. Select the cell or range of cells to which you want to apply equal spread.

5. Type the value to spread, for example 1000.

6. Press Enter or click outside the cell.

The  value  1000  is  divided  equally  over  the  selected  cells  and  the  values  in  the
leaves also change.

7. Select Stop Data Entry Mode to exit data entry mode.

Spreading code: S1000

Using Equal Leaves Spread
The Equal Leaves Spread option distributes a specified value equally across all  leaves of  a
consolidation cell.

This example  replaces the  highlighted  cells  with  a  value  of  1000 and  spreads  the  value
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equally to the leaves of each cell.

The result is as follows:

Procedure
1. Enter Data Entry mode.

2. Select Equal Leaves Spread from the Spreading type menu.

3. Select Replace from the Spreading action menu.

4. Select the All Leaves option from the Spreading Action menu.

5. Select the cell or range of cells to which you want to apply an equal leaves spread.

6. Enter the value to spread, for example 1000, in the consolidation cells.

7. Press Enter or click outside the cell.

8. The value 1000 is entered into the selected cells and divided equally to all  leaves of
that cell.

9. Select Stop Data Entry Mode to exit data entry mode.

Spreading code: LS+*1000

Using Proportional Spread
The  Proportional  Spread  option  distributes  a  specified  value  across  selected  cells  in
proportion to the original value.

This  example  replaces  the  highlighted  cells  with  a  value  of  1000  spread  proportionally
across the cells and to the leaves of the cells.
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The result is as follows:

Procedure
1. Enter Data Entry mode.

2. Select Proportional Spread from the Spreading type menu.

3. Select Replace from the Spreading action menu.

4. Select the range of cells to which you want to apply a proportional spread.

5. Enter the value to spread, for example 1000, in the cell.

6. Press Enter or click outside the cell.

7. The 1000 value is spread to the selected cells in proportion to the original values.

8. Select Stop Data Entry Mode to exit data entry mode.

Spreading code: P1000

Using Repeat
The Repeat option copies the value you type and pastes  it  to  all  the  selected  cells.  The
values in the leaves of consolidation cells are changed in proportion to their initial value.

This example replaces the highlighted cells with a value of  1000. The value is also spread
proportionally across the leaves of each cell.
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The result is as follows:

Procedure
1. Enter Data Entry mode.

2. Select Repeat from the Spreading type menu.

3. Select Replace from the Spreading action menu.

4. Select the cell or range of cells for which you want the same value repeated.

5. Enter the value to repeat, for example 1000, in the cell.

6. Press Enter or click outside the cell.

7. The 1000 value is written to all the selected cells.

8. Select Stop Data Entry Mode to exit data entry mode.

Spreading code: R1000

Using Repeat Leaves
The Repeat Leaves option copies a specified value to all the leaves of a consolidation cell.

If  the  All  Leaves  spreading  type  is  left  unchecked,  Repeat  Leaves  updates  only  those
leaves that initially contain a value. To force  the values into all  leaves of  a consolidation
regardless of their initial value, use the All Leaves option.

The Repeat Leaves option populates all leaves, including all members of the offspread.

This example  enters a value to  all  leaves  of  a  consolidation  cell,  even  if  the  leaf  is  not
visible.
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Note: In  the  example  the  consolidation  cells  have  21 offspread  members  that  do  not
show.  The  value  of  1000  populates  all  21  members,  and  therefore  the  value  21,000,
shows in the leaves of the consolidation cell.

The result is as follows:

Procedure
1. Enter Data Entry mode.

2. Select Repeat Leaves from the Spreading type menu.

3. Select Replace from the Spreading action menu.

4. To enter the value to all  leaves of  a consolidation cell,  select the All  Leaves option
from the Spreading Action menu. 

5. To enter the value to only those leaves that originally contained a value,  leave  All
Leaves deselected.

6. Select the consolidation  cell  or  range  of  consolidation  cells  to  which  you  want  to
repeat the same value.

7. Enter the value to repeat, for example 1000, in the cell.

8. Press Enter or click outside the cell.

9. The value 1000 is written to all leaves in the offspread of the selected cells.

10.Select Stop Data Entry Mode to exit data entry mode.

Spreading code: LR*1000

Using Straight Line
The Straight Line option populates selected cells by linear interpolation between a  start
value and an end value.
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This example replaces the highlighted cells with a straight line range of values.

The result is as follows:

Procedure
1. Enter Data Entry mode.

2. Select Straight Line from the Spreading type menu.

3. Select Replace from the Spreading action menu.

4. Select the range of cells to which you want the spread to apply.

5. Type the start and end values separated by a colon. For example, to enter a spread
that starts at 300 and ends with 500, type 300:500.

6. Press Enter or click outside the cell.

7. The  values  from  the  start  to  the  end  values  are  spread  over  the  leaves  of  the
selected cells. The consolidated cell is updated.

8. Select Stop Data Entry Mode to exit data entry mode.

Spreading code: SL300:500

Using Percentage Change
The Percentage Change option changes the current cell  values by a specified percentage.
The product of  that multiplication can then replace, be  added  to,  or  be  subtracted  from
the existing cell values.

This  example  increases  the  value  of  the  highlighted  cell  and  all  leaves  of  the
consolidation cell by 10%.
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The result is as follows:

Procedure
1. Enter Data Entry mode.

2. Select Percentage Change from the Spreading type menu.

3. Select Add from the Spreading action menu.

4. Select the consolidation cell for which you want the increase to occur.

5. Type the percentage to use when spreading, for example, to increase the values by
10%, enter 10.

6. Press Enter or click outside the cell.

7. The  value  is  increased  by  the  percent  value  for  the  consolidation  cell  and  for  all
leaves of the cell.

8. Select Stop Data Entry Mode to exit data entry mode.

Spreading code: P%+10

Using Growth Percentage
The  Growth  Percentage  spreading  type  uses  an  initial  value  and  a  growth  percentage
value to sequentially increment the initial value over a range of cells.

This example adds a growth value of 10% to the initial value of 41,362 and increments this
value in the highlighted cells.
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The result is as follows:

Procedure
1. Enter Data Entry mode.

2. Select Growth Percentage from the Spreading type menu.

3. Select Replace from the Spreading action menu.

4. Select the range of cells to which you want the spread to apply.

5. Enter the initial value and the percentage change to use  when spreading, separated
by a colon. For example, to start the range of values at 41,362 and to change by 10%,
enter 41362:10.

6. Press Enter or click outside the cell.

7. The values begin at the initial  value, and  are  changed  by  the  percent  amount  and
spread over the specified cells, based on the action you chose.

8. Select Stop Data Entry Mode to exit data entry mode.

Spreading code: GR41362:10



109 Using Serviceware Performance Analytics

Using Relative Proportional
The  value  of  a  target  consolidation  cell  together  with  its  leaves  can  be  changed  in
proportion to the values of a source consolidation cell and the leaves of that cell.

The Relative Proportional Spread type populates values into the leaves of  a consolidation
cell in proportion to the values of a source or reference cell.

The source cells can be in another part of the cube but must have the same consolidation
of members as the target cells to which you want the new values to be populated.

This  example  changes  the  value  of  sales  for  M02  to  500,000,  but  keeps  the  same
proportions as the M01 sales figures.

The result is as follows:

Procedure
1. Enter Data Entry mode.

2. Click  the  target  consolidation  cell  to  which  you  want  the  new  values  to  be
populated.

3. Select Relative Proportional Spread from the Spreading type menu.
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4. Select Replace from the Spreading action menu.

5. Select Months from the How to Spread menu.
Note: Tip: Place the cursor over the header bar of  the member you want to change.
The name of the member type shows.

6. Select Displace.
The Select Data Entry Displacement Member selection box shows.

7. Select January from the  Select  Data  Entry  Displacement  Member  selection  box  to
use for the initial values.

8. Press OK or click outside the cell.

9. Type the value 500000 in the target consolidation cell.
The value of  the target consolidation  cell  is  updated  along  with  the  values  of  the
leaves.

10.Select Stop Data Entry Mode to exit data entry mode.

Using Relative Growth Percentage
The value of a target consolidation cell and the its leaves can be changed by a percentage
value in relation to the value of a source consolidation cell and the leaves of that cell.

The  Relative  Growth  Percentage  type  spreads  values  to  the  leaves  of  a  target
consolidation  cell  by  applying  a  percentage  adjustment  to  the  leaves  of  a  source  or
reference cell.

Relative Growth Percentage increments the values in the leaves of the reference cell  by a
user-specified percentage. The resulting values are then spread to the leaves

of the consolidation from which you initiated spreading.

This  example  changes  the  value  of  sales  for  February  to  that  of  January  plus  10%.  The
January proportions are also kept.

The result is as follows:
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Procedure
1. Enter Data Entry mode.

2. Click  the  target  consolidation  cell  to  which  you  want  the  new  values  to  be
populated.

3. Select Relative Growth Percentage from the Spreading type menu.

4. Select one option from the Spreading action menu: Replace, Add or Subtract.

5. Select  the  same  member  type  as  the  target  consolidation  cell  from  the  How  to
Spread menu.
Note: Place the cursor over the header bar of  the member you want to change. The
name of the member type shows.

6. Select Displace.
The Select Data Entry Displacement Member selection box shows.

7. Select the source member to use for the initial values.

8. Press OK or click outside the cell.

9. Type the percentage value to use for the target consolidation cell.

10.Press Enter or click outside the cell.

11.Select Stop Data Entry Mode to exit data entry mode.

Protecting cells from change
Cells can be protected from being edited when in data entry mode. The color of    the  cell
changes to indicate  a protected cell.  The value of  the cell  does not  change  if  it  is  in  the
selection of cells during Data Spreading.

A single cell without any leaves can be set to Hold,  a consolidation cell  can be set to Hold
Leaves.

Note: The Hold Leaves option protects the leaf  cells at the lowest level  (leaf  level  cells).
Only the leaf  level  cells change color  to  indicate  that  the  values  will  not  change  during
data entry. To see leaf level cells, ensure that the lowest members for all  Dimensions are
selected in both the offspread and inspread.

A consolidation cell  cannot be set with the Hold command. Any data change  results  in  a
data entry warning that indicates that data entry failed.
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The highlighted cell  has been set with the Hold Leaves command. A change to the value
of the higher consolidation cell has no effect of the value of the held cell.

The result is as follows:

Releasing a hold on a cell

After protection has been placed on a cell, you can release it from protection.

Procedure
1. Right-click the cell with the hold on it.

2. Select the level of release you want to use:

Release Hold to remove the hold from the current cell only.

Release Leaf Holds to release the holds on the leaf level cells in the View.

Release All Holds to release all holds in the View regardless of their levels.

A confirmation displays to verify that you really want to release all  the  holds in this
view.

3. The  color  of  the  cell  changes  to  indicate  that  the  value  in  the  cell  may  now  be
changed as a result of spreading.
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Entering data in SSAS

When  you  use  data  sources  that  are  based  on  Microsoft  Analysis  Services  you  have
several options for spreading data.

When  using  Microsoft  Analysis  Services,  the  Spreading  Options  menu  displays  on  the
right side  of  the screen during Data Entry. You can indicate  what  to  spread  and  for  each
member, if the spreading is weighted or equal.

To set a spreading option  in Microsoft Analysis Services:

Procedure
1. Select the type of spreading:

To spread the entire value over the members, select Entire Value.

To  distribute  the  value  over  the  members  using  the  difference  between  the
previous value and the entered value, select Difference.

2. For each dimension, you can indicate  if  the spreading is distributed equally among
the members or spread over the existing members based on their original value:

To spread the data equally over the existing members, select Equal.

To spread the data based on the original values in the cells, select Weighted.

Spreading examples
The following table shows how the different spreading options work in Microsoft Analysis
Services:

Setting Origina
l Value
Q1

Entere
d
Value
Q1

Value to
spread

Jan Original
Value = 600

Feb Original
Value = 300

Mar Original 

Value = 100

Difference
/ Equal

1000 1100 100 +33=633 +33=333 +33=133

The  value  1100  is  entered  in  Quarter  1.  100  is  spread  equally  over  the  three
months

Difference
/ Weighted

1000 1100 100 +60%=660 +30%=330 +10%=110

The  value  1100 is  entered  in  Quarter  1.  100 is  spread  weighted  over  the  three
months

Entire
Value/
Equal

1000 1100 1100 1100/3=366 1100/3=366 1100/3=366

The  value  1100 is  entered  in  Quarter  1.  1100  is  spread  equally  over  the  three
months.

Entire
Value/

1000 1100 1100 600+60%
=660

300+30%
=330

100+10%
=110
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Weighted

The  value  100 is  entered  in  Quarter  1.  1100 is  spread  weighted  over  the  three
months

Displace spreading value
To  spread  the  data  based  on  another  member  from  the  dimension,  use  the  Displace
option.

Refreshing data

To  reduce  network  traffic  and  improve  performance,  Data  Entry  mode  does  not
immediately refresh calculations when you enter new values.

When  Refresh  Data  in  Entry  Mode  is  on  and  a  value  of  a  cell  is  changed,  calculations
depending on this value are also updated.

Example:  a  calculation  column  called  Variance%  is  based  on  the  values  in  the  column
Actual.  When  the  values  of  Actual  changes,  the  result  in  the  Variance%  column  also
changes.

Force refresh data

You can enforce to refresh the data while you are in Data Entry mode.

Procedure
1. Click the Options icon.

2. Click the Data tab.

3. Select the Refresh Data in Entry Mode checkbox.

Refreshing data with Essbase

When you use data sources that are  based on Essbase, after changing  data  in  Data  Entry
mode,  you  may  need  to  recalculate  to  ensure  that  all  Essbase  calculations   and
consolidations are updated and that your database is consistent again.

To recalculate a database from within the application:

Procedure
1. Right-click the View tab.

2. Select Database > Execute.

The  Execute  menu  offers  the  default  calculation  script  and  any  other  calculation
scripts available based on the Essbase security and the user authorized access.

3. Select a script and click Execute.

Essbase recalculates the database using the selected script.  Recalculation may take
some time.
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Executing TI processes with TM1

When you use data sources that are based on TM1, you may want to execute  TI processes
defined in your TM1 database server.

To execute TI processes from within the application:

Procedure
1. Right-click the View tab.

2. Select Database > Execute.

The Execute menu offers a list of  TI processes available  in the TM1 server based on
the TM1 security and the user authorized access.

3. Select a process
When defined, the process-specific parameters are displayed on the right hand side
and their values can be set there prior to the execution.
Note:  The  equal  character  (=)  and  the  semicolon  (;)  can  neither  be  used  as  the
parameter name, nor for its value and will be removed automatically.

4. Click Execute.

TM1 executes the selected process. This may take some time.

Note: TI processes are supported only for TM1 servers connected via the REST API.

Pasting data from the clipboard

Data  that  is  copied  to  the  clipboard  from  another  application  can  be  pasted  to  a  view
when in Data Entry mode.

You have the following possibilities:

Data on the clipboard can come from the same application or another application.

Clipboard data pastes starting from the data entry cursor  position.  If  the  clipboard
data contains more rows or columns of  data, it is  pasted  to  the  right  or  bottom  of
the cursor.

The  values  on  the  clipboard  are  inserted  and  the  selection  rectangle  shows  the
portion of the table affected.

Enhanced Input Functionalities

A number of functions are provided to enhance the data entry. These include functions for
incremental data entry as well as input accelerators (hotkeys) for entering specific values to the
entry cells.

Note: These input accelerators are currently not available for TM1 databases. This is due to the
existing logic within the TM1 database for spreading. The existing data spreading codes should
be used instead.

Incremental Data Change

To enter a value like 10000 the user can just enter this value into the cell. If the cell already
contains a
value (e.g. 9800), an incremental value can be entered (e.g. 200+) to get the new value (10000).
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AL allows the following incremental functions:

"<number>+"
"<number>–"
"<number>*"
"<number>/"

By entering a "<number>", the existing value is overwritten.
This number may be any digit or sequence digits from 0 to 9 as well as the decimal and
thousands separator (like comma (,) or period (.)).

Input Accelerators

Numbers can be entered by using input accelerators (similar to hotkeys).
The syntax is
"<number><Accelerator>"

The following accelerators are supported:

K or k Example: Type 3K to obtain 3.000
T or t Example: Type 3T to obtain 3.000
M or
m 

Example: Type 3M to obtain 3.000.000

B or b Example: Type 3B to obtain 3.000.000.000
% When a percentage character is entered without an operator,

the value typed in is applied as a percentage to the current value.
%+ ... When the operators ("+", "–", "*", "/") are used, the percentage figure is added,

subtracted, multiplied, or divided.

Gantt Charts

You can create a Gantt chart to analyze the progress of projects.

Figure 21 : Sample Gantt chart

Database prerequisites

For creating a Gantt chart, the structure of the underlying OLAP database needs to have a
dimension that fulfills the following criteria:

It contains two members for the start date and end date of projects.

It can also contain any number of members  for milestone dates  and milestone statuses,
e.g.  you could define the members  MS1, MS2 and MS3 for the dates  and the members
MS1_Status, MS2_Status and MS3_Status for the corresponding statuses.

It may also contain additional members that are not relevant for the Gantt chart.
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(The names of the required members are not important, they can be mapped in the Gantt
options dialog.)

Creating a Gantt chart

For creating a Gantt chart, start off with a view where your Gantt dimension is in the column
headers and the members for Start Date and End Date are currently selected.

Now right click on the member for the start date and choose the context menu entry "Gantt...".
The Gantt options dialog will appear with the start date automatically selected. Next click on the
member for the end date in the grid to also map this member.

You can also choose the context menu entry "Gantt..." anywhere else in the view or use the
"Gantt" button in the ribbon and then select the members for start date and end date.

Set all other options as required and then save your settings. The next chapter will explain the
available options.

Note: Only one Gantt chart is possible per view.

Gantt options

The Gantt options dialog consists of the sections "Dates and milestones", "Time period" and
"Layout".

Dates and milestones

This section allows to map the Gantt Start Date and End Date fields to the correct members of
the database. Click in the field of the dialog and then on the member in the grid to change a
mapping.

You can also use the Selection buttons next to the two milestone fields to select the members
for the milestone dates and statuses. A member selection dialog will open for selecting these
members. Make sure to apply the same order in both fields. (i.e. if for dates MS1, MS3 and
MS4 are selected, make sure that the statuses are selected in the same order as the second
status will apply to the second date.)
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Figure 22 : Gantt dialog - Dates and milestones

Time period

In this section you can decide between three different options for the calculation of the displayed
time period:

Automatic
The time period will be set by taking the earliest start date and the latest end date. 

Manual
The start date and end date can be set manually.

Dependent on Actual Date
The  start  date  and  end  date  can  be  set  by  giving  the  amount  of  months  that  shall  be
subtracted and added to the current date.

Layout

In this section you can define the layout of the Gantt chart.

Grid
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The grid options let  you define the date format  of the headers  as  well  as  the  frequency,
color and style of vertical grid lines.

Current date
By  checking  this  option  you  can  enable  a  vertical  grid  line  that  represents  the  current
date. The color and line style can be customized.

Milestones
You can choose between different milestone symbols,  define the color of the symbol and
decide if milestone labels should be displayed in the Gantt chart.
The  option  "Use  member  format"  will  use  the  color  defined  in  the  Chart  tab  of  the
Formatting dialog (for the milestone status member).
The option "Use traffic  light  color"  will  use the color that  is  defined  for  the  traffic  light  of
each milestone status.

Bars
The bar options let you define the color, height and border of the Gantt bars.
The  option  "Use  chart  formatting"  will  use  the  color  defined  in  the  Chart  tab  of  the
Formatting dialog (for the project member).

Figure 23 : Gantt dialog - Layout
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Editing a Gantt chart

For editing a Gantt chart, use the "Gantt..." option in the context menu or the "Gantt" ribbon
button. The Gantt options dialog will appear and let you change the settings.

Removing a Gantt chart

For removing a Gantt chart, open the Gantt options dialog for the chart that shall be deleted and
use the button "Remove" in the lower left corner.

Dashboards

A dashboard is built on a canvas that contains panels.  The panels contain  views  that  can
communicate with each other, enabling you to create dashboard applications.

The following illustrations show a dashboard with four panels that contain views.

Figure 24 : Dashboard

Creating a canvas

This section explains you how to create a canvas.

Procedure
1. Select the  New section in the backstage.

2. Select the template location either My Templates or Shared Templates.

3. Select one of the templates to create a canvas.

4. The new canvas contains one panel.  For information on how to add more panels to
the canvas, see Adding panels.

5. You can do the following:
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To  prevent  the  panel  from  changing  size  or  position,  click  the  Views  arrow
button on the toolbar and then click Lock Panels.

To change the position of the panel, click and drag the handle  of the panel.

To change the size of the panel, click and drag the borders of the panel.

To automatically arrange the panels, click the Views arrow button on the toolbar
and then click Auto Arrange Panels.

Saving a canvas

Use the following instructions to save the canvas.

Procedure
You can either

Save the canvas with its current name by clicking the Save icon in the mini toolbar or
by clicking the ribbon VIEW and select Save.

Save the canvas with a different name by clicking the VIEW  ribbon and then clicking
Save Canvas As.

Adding panels

To add more panels to the canvas, you must create or open views.

Procedure
1. Create  or  open  a  view  on  the  canvas.  For  more  information,  see  Working  with

connections in Performance Analytics client.

2. Right-click on the view tab, and then click Move View to New Panel.

Closing a panel on the canvas

You can close an unwanted panel.

Procedure
In the unwanted panel, click on the Close Panel button in the Panel Ribbon.

Synchronization between panels

You  can  synchronize  views  in  different  panels.  For  example,  you  can  synchronize
between a table and charts that are based on the same data on different panels.

Note: To synchronize  views between panels,  the panel  views must connect to  the  same
data source.

You  can  specify  synchronization  between  panels  after  changes  in  the  offspread,  the
inspread, or in both.
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You can select the panels that synchronize  with each other by  specifying  a  channel.  The
default  channel  is  called  Default.  If  you  have  more  than  two  panels  and  you  want  to
prevent the synchronization from always using the same channel,  then you must specify
another channel.

Procedure
1. In a panel,  click the  Show  all  open  Views  arrow  button   and  then  click  Panel

Options.

2. On the Selections tab, select the trigger to synchronize:

Synchronize Offspread Selections

Synchronize Inspread  Selections

3. In the Using Channel  box, specify the channel  for the communication between the
panels.

Note: You must specify the same synchronization options in  all  panels  that  you  want  to
synchronize.

Display options

You can change the look and feel of both the canvas and the panels.

For example,

You can specify whether you want the offspread or tab bar to display in the panels.

You can specify that the panels inherit the display options.

You can specify the color of the background or a background image for the canvas.

Display Components
Use  this  option  to  select  or  clear  the  respective  display  component.  The  following
components are available:

Offspread

Table

Row Headers

Column Headers

Splitters

Data Entry Panel

Chart Bar

Drill Through Bar

Notes

Tab Bar

Border
Use this option  to  specify  the  size  and  style  of  the  border  panel.  The  following  border
options are available:

Padding
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Adornment

Background
Use the background options to specify the background color,  or an image for the canvas.
The following background options are available:

Color

Image

Image Mode

Image Alignment
Use the image alignment options to set the position  of  the  image.  The  following  image
alignment options are available:

Horizontal

Vertical

Offset

Setting the display options for the canvas

The display options that you set for the canvas is applied to all panels on the canvas.

Except for the image and background color because these only  apply  to  the  canvas.  You
can change the display options of each panel individually.

Procedure
1. On the CANVAS ribbon in the Section Canvas click on the small options button.

2. On the Display tab, set the display options for the canvas.

Setting the display options for the panels

The display options that you set for the canvas are applied to all panels on the canvas. You
can change the display options of each panel individually.

Procedure
1. In a panel  click the  Show  all  open  Views  arrow  button  ,  and  then  click  Panel

Options.

2. On the Display tab, set the display options for the panel.

Adding a background image to a canvas

You can add an image, that is stored in the Performance Analytics Server repository, as a
background image to a canvas.

Note:  For  information  about  adding  images  to  the  Performance  Analytics  Server
repository,  consult  the  Serviceware  Performance  Analytics  Server  Installation  and
Administration Guide.

Procedure
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1. On the CANVAS ribbon in the Section Canvas click on the small options button.

2. Click the Display tab.

3. From the Image menu select an image.

4. Choose an Image Mode:

To display the image in its original size, select Normal.

To display the image in its original  size  and repeat it so that it fills the available
space in the window, select Tile.

To stretch the image to fill the window size, select Stretch.

To stretch the image while maintaining the aspect ratio, select Stretch Ratio.

5. To  move  the  image,  set  the  Image  Alignment  using  the  Horizontal  and  Vertical
boxes and corresponding offsets.

Results
The canvas appears with a background image.

Open view in a new window

If a view is embedded in a canvas and contains a view title,  the view can be opened in a
separate browser window or browser tab.

This can be achieved by a double click on the view title. 

Sort and select members

To display the data in a view you want to analyze, you can select the members.

If  you only want to sort members in an ascending or descending way  please  see  Sorting
members by value.

In addition to sorting members in ascending or descending order you can use the sort and
select functionality in a view. Sorting and selecting data is done in the Sort & Select dialog



125 Using Serviceware Performance Analytics

Sorting and selecting members

If  you want to sort and select members, then  you  must  display  the  Sort  &  Select  dialog
box.

Procedure
There are the following ways of displaying the Sort & Select dialog box:

Click on the Sort & Select button in the ribbon MEMBER.

Select the MEMBER tab in the ribbon and the Sort & Select Button.

Right-click in a view and choose Sort and Select.

If you right-click an inspread member the Sort & Select dialog box will  be  displayed with
the member you right-clicked on selected in the Member field.

Otherwise the Member field will display <No Selection>.

If the Member field displays <No Selection>, you can click an inspread member to select a
member

Sort and select options

The Sort & Select dialog box offers several  options  to  sort  and  select  the  members  you
want to analyze in a view.

The following options are available:

Sort

Options

Retrieve Data from

Top / Bottom

Range

Setting the way to sort members
The Sort section in the Sort & Select dialog box allows you to specify  how  the  members
are sorted.

Procedure
1. To  open  the  Sort  &  Select  dialog  box,  select  the  MEMBER  tab  in  the  ribbon  and

select the Sort &  Select  button  or  click  on  the  Sort  &  Select  button  in  the  ribbon
MEMBER.

2. In the Sort section specify how you want the selected members to be sorted.

The options are:

o None

o Ascending

o Descending

Setting sort options
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The Options section on the Sort & Select dialog box allows you to set certain options.

Procedure
1. Open the Sort & Select dialog box.

2. In the Options section specify how  you  want  the  selected  members  to  be  sorted.
The options are:

Include Missing Values

Use  this  option  to  display  a  list  of  members  that  have  missing  values  in  the
database. For example, it can be used in your search to  include  customers  who
did not buy products or products that did not sell in a given period.

Retain Current Selection

This option allows you to sort on a member and  keep  your  current  selection  at
the same time.

Sort within Hierarchy

This option allows you to sort a member in ascending or descending order, while
respecting the hierarchy of the dimension.

If the member is sorted, the children are sorted underneath their parents. In the
result, the hierarchy of the dimension is not changed.

Note:  The  Sort  within  Hierarchy  option  is  only  available  when  sorting  in
Ascending or Descending order.

Add Total at End / Use Dynamic Total

If  you want to display the static total  for all  members, select this option.  Select
the  Use  Dynamic  Total  if  you  want  the  total  to  change  when  the  selected
members change. If  the selection contains stacked dimensions, the added  total
has to be dynamic.

Note: When you perform a new sort action, the total  at end will  be  replaced.  If
you want to keep the calculation, rename it.

Specifying where to retrieve data from
The Retrieve Data from section in the Sort & Select dialog box allows you to specify from
what members the data should be used from.

Procedure
1. Open the Sort & Select dialog box.

2. In  the  Retrieve  Data  from  section  you  can  specify  from  what  members  the  data
should be used. The options are:

Selected Members

If you select this option, the selected members will  only change if  other criteria
on the Sort & Select dialog box are met.

Entire Dimension

If you select this option, all members in the dimension will be selected.

All Lowest Members

If you select this option, all lowest members in the dimension will be selected.
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Selecting the top or bottom members, percentages, or values 
The Top / Bottom section in the Sort & Select dialog box allows you to select the members
that meet one certain criteria.

The following criteria are available:

Top or bottom members

Top or bottom percentages

Top or bottom values

Procedure
1. Open the Sort & Select dialog box.

2. In the Top / Bottom section  you  can  specify  the  following  options  from  the  drop-
down menu in combination with the value field:

Top n Members

This option allows you to specify a number of  members with the highest values.
N  in  the  drop-down  menus  is  the  variable  that  represents  the  number  of
members.

Bottom  n  Members

This option allows you to specify a number of  members with the lowest values.
N  in  the  drop-down  menus  is  the  variable  that  represents  the  number  of
members.

Top n %

This option allows you to specify the top members that together make up the
specified  percentage  of  the  total  value  of  all  members.  N  in  the  drop-down
menus is the variable that represents the percentage

Bottom n %

This option allows  you  to  specify  the  bottom  members  that  together  make  up
the specified percentage of  the total  value of  all  members. N in the drop-down
menus is the variable that represents the percentage.

Top n Value

This  option  allows  you  to  specify  the  top  members  that  together  make  up  at
least  the  specified  value.  N  in  the  drop-down  menus  is  the  variable  that
represents the value.

Bottom n Value

This option allows you to specify the bottom members that together make up at
least  the  specified  value.  N  in  the  drop-down  menus  is  the  variable  that
represents the value.

Specifying the range of values for selecting members
The  Range  section  on  the  Sort  &  Select  dialog  box  allows  you  to  specify  the  range  of
values for the members to be selected.

Procedure
1. Open the Sort & Select dialog box.
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2. Enable the Range option and specify the range using the from and to fields.

Example sorting and selecting

The  purpose  of  this  example  is  to  explain  how  you  can  use  sorting  and  selecting.  The
following screen capture defines the starting situation in a view.

In this example we want to include the top two regions for the product "Colas" in the first
quarter  from  the  months  dimension.  We  are  interested  only  in  those  regions  that  sell
between 2000 and 5000 dollars. In addition we would like to show missing values.

Procedure
1. Open the Sort & Select dialog box.

2. Specify the following in the Sort & Select dialog box:

Set the Sort option to None

Set the Options to Include Missing Values.

Set the Retrieve Data from option to Entire Dimension.

Set the Top / Bottom option to Top n Members. Specify a value of 2.

Specify a Range from 2000 to 5000.

The Sort & Select dialog box should look like this:
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3. Click OK.

The selection of  members in the view changes to  meet  the  criteria  that  we  set  in
the Sort & Select dialog box:

Only the top 2 members which fall in the specified range are displayed.

Also the member with a missing value is displayed.

Copying and pasting data

Data copied to the clipboard can be pasted to other applications or from one area on the
table  to  another  area.  When  you  copy  data,  you  can  choose  to  include  or  exclude  the
header information.

Procedure
1. Right-click the data.

2. Select Extras from the shortcut menu.

To copy data without headers, select Copy without Headers.

To copy data and include headers, select Copy. The result changes depending on
whether you are in Data Entry mode:

When you are not in Data Entry mode, the entire table is copied to the clipboard.
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For more information on Data Entry, see  Data entry.

When you are in Data Entry, the selection rectangle defines which area is copied.

Note: After copying data, you can immediately paste it to another location.

Selecting the copy and paste area

You can create the copy-paste selection in several ways.

Use one of these methods to make the copy-paste selection area:

Use the shift key + arrow keys

Use the mouse to highlight the area

Hold the Shift key, and click the top left cell and then on the bottom right cell

Specifying the scaling factor for copy and paste

A scaling factor specifies how you want a value to  change  after  a  paste.  For  example,  if
the OLAP value is 678 and a scaling factor of 0.01 is applied, the displayed value is 6.78.

A scaling factor is set in the Member Formatting menu or in the Options > Number menu.
For more information see Formatting scaling factor.

The scaling factor is applied  when  you  copy  and  paste  a  value  in  Data  Entry  mode.  The
scaling factor is also applied if  the cell  in which the value gets pasted has a scaling factor
format.

When copying and pasting in Microsoft Excel,  the value  6.78 is  pasted  independently  of
the format used (for example  Microsoft Excel  8.0 Format BIFF8, SYLK, Unicode Text).  Use
Edit  >  Paste  Special  in  Microsoft  Excel  to  display  the  different  format  contents  of  the
clipboard.

Using drag and drop to copy and paste

The Fill  Handle  is a  small  square  at  the  bottom  of  the  selection  rectangle.  If  you  hover
over  the  Fill  Handle  the  cursor  changes  into  a  cross.  When  you  drag  across  a  selection
using  the  Fill  Handle,  you  can  either  copy  or  extend  the  numbers  using  the  selection
rectangle.

Procedure
1. Select a cell or range of cells.

2. Select the Fill Handle and drag the Fill Handle in one direction.

The selection rectangle expands while you drag.

Note:  When  one  cell  is  selected,  the  Fill  Handle  can  be  dragged  horizontally  and
vertically,  to fill  an entire  selection at once. When multiple  cells  are  selected,  the
Fill Handle can be dragged in only one direction.

3. Release the mouse button.
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Note:

If only one cell  is selected, the content of  that cell  is copied into all  the  cells of
the new selection rectangle.

If  more than one cell  is selected, the trend in the numbers will  continue  in  the
newly selected cells.

For  example,  start  with  three  values:  100,  110  and  120,  you  can  select  these
values and use the Fill  Handle  to  drag  the  selection  rectangle  so  it  includes  all
months.

When the Fill  Handle  is released,  the  newly  selected  area  is  filled  with  values
that  follow  the  same  trend  as  the  initial  values.  The  values  selected  now  run
from 100 to 170. The numbers increase by 10.

If  more values are  selected and the Fill  Handle  is  dragged  while  pressing  Shift,
the old selection of values is repeated.

For example, if three cells with values 100, 110 and 120 were selected, then the
new selection is 100, 110, 120, 100, 110, 120, and so on

Transfer data from a view to a Microsoft Excel spreadsheet

You can transfer data from a view to a Microsoft Excel spreadsheet.

You can do this in two ways:

By exporting to a spreadsheet.

By copying and pasting to a spreadsheet.

Microsoft Excel data is either stored in Binary Interchange File Format (BIFF8),  also known
as Microsoft Excel  8.0 Format (XLS)  or in Office  Open XML format (XLSX). When using the
copy functionality,  a table  in a view is copied  in  Microsoft  Excel  8.0 Format.  This  means
that the formatting of  cells,  members, and styles is applied when pasting a table  from  a
view in Microsoft Excel. When exporting to a spreadsheet the format is depending on the
selected file type (XLS or XLSX).

Please  note  the  following  when  copying  a  table  from  a  view  to  an  Microsoft  Excel
spreadsheet:

Spacing used in member  formatting  or  in  the  Automatic  Group  Spacing  option  on
the  Headers  tab  of  the  options  dialog  box  is  not  applied  when  pasting  in  the
Microsoft Excel format.

Microsoft  Excel  has  32  colors.  When  colors  used  in  the  formatted  view  are  not
supported in Microsoft Excel, these colors will  be  approximated from the Microsoft
Excel color palette when pasting in the Microsoft Excel format.

3D Borders or 3D lines used in member or style formatting in a view are represented
as thin lines when pasting in the Microsoft Excel format.

Icons used in a view are not supported in the Microsoft Excel format.

A  drill  through  pane  in  a  view  is  not  supported  in  the  Microsoft  Excel  format.
However, a drill through pane can be copied and pasted separately.
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The  default  border  styles  none  and  dashed  in  a  view  are  displayed  as  default
Microsoft Excel borders.

Members  formatted  with  border  style  none  are  displayed  with  default  Microsoft
Excel borders.

Members  formatted  with  the  border  style  dashed  are  displayed  with  dashed
borders when pasting in the Microsoft Excel format.

An Microsoft Excel  Workbook sheet contains a maximum of  256 columns and 65536
rows  in  Microsoft  Excel  8.0  Format  (XLS)  and  a  maximum  of  16384  columns  and
1048576 rows in Office Open XML Format (XLSX).

When a scaling factor is used in a view, the scaled values are  applied when pasting
in the Microsoft Excel format.

Changed column  width  or  row  height  in  a  view  is  not  supported  in  the  Microsoft
Excel format.

Exporting a view to a Microsoft Excel workbook

You can export a view to a Microsoft Excel workbook.

Procedure
1. Right-click in a table and click Extra > Export to Microsoft Excel Workbook

The Export to Microsoft Excel Workbook dialog box opens.

2. Set the options you prefer.

3. Click Export.

By default,  the Microsoft Excel  spreadsheet is  saved  in  the  My  Documents  folder.
The name of the Microsoft Excel Workbook is the same as the name of the view.
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Options for exporting to a Microsoft Excel workbook
In the Export to Microsoft Excel Workbook dialog box you can set options.

Option Purpose

Views The Views menu allows you to export:

This View 

Some Views

If  you  select  this  option,  the  Select  Views  to  Print  is
displayed.  Select  the  views  you  want  to  export  and
click OK.

All Views

Member Range The  Member  Range  menu  allows  you  to  export  the
views:

As displayed on screen 

According to Print Range

Set the print range by clicking Print Range. 

When you have made a DynaSelect and  you  choose  to
print  According  to  Print  Range,  the  DynaSelect  will
apply to all members you select. 

Add The  Add  section  on  the  Export  to  Microsoft  Excel
Workbook dialog box allows you to add the following:

Table of Contents

Adds a table of contents to the spreadsheet.

Formatting
The  formatting  of  the  view  is  transferred  to  the
spreadsheet.

Offspread
The selected offspread dimensions are displayed in the
spreadsheet.

Row and Column Headers

Row  and  column  headers  are  displayed  in  the
spreadsheet.

Options You  can  set  the  following  options  for  the  Microsoft
Excel spreadsheet:

Dimension Names
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This option allows you to show  or  hide  the  dimension
names  from  the  offspread  area  when  exporting  to  a
Microsoft Excel spreadsheet.

Repeating Headers

This option allows you to repeat the member names in
the outer  inspread  dimensions.  When  dimensions  are
stacked  in  the  inspread  area,  the  names  of  the
members  in  the  outer  dimensions  are  repeated  in
every  row  or  column  in  the  exported  Excel
spreadsheet.

Copying and pasting data to a spreadsheet

You can copy and paste from a view to Microsoft Excel.

Procedure
1. Right-click a table in a view.

2. Click Extra > Copy without Headers if you only want the data to be copied.

If  you  also  want  the  member  names  and  the  names  of  the  set  dimensions  to  be
copied, click Copy.

3. In Microsoft Excel do one of the following:

Click Edit > Paste to paste  the table  in Microsoft Excel  8.0 format while  retaining
the formatting.

Click  Edit  >  Paste  Special,  then  select  the  desired  format  to  paste  the  table
without formatting.

Note: When pasting in Microsoft Excel  8.0 format, only  the  displayed  offspread
dimensions  are  pasted.  When  pasting  in  a  different  format,  all  dimensions
(visible, hidden and ignored) are pasted.

Pasting special formats in Microsoft Excel 8.0 format

You can paste the contents of the clipboard in another format.

For  example,  if  you  do  not  want  the  Performance  Analytics   formatting  to  be  applied,
select Edit > Paste Special and select the SYLK format, as seen in this example of  the same
table  pasted  in  SYLK  format  with  all  Offspread  dimensions.  Note  that  when  pasting  in
Microsoft Excel  8.0 format,  only  the  displayed  Offspread  dimensions  are  pasted.  When
pasting in a different format, all dimensions (visible, hidden and ignored) are pasted.

Calculations

The calculator enables you to create calculations.

The basic functions include multiplication (*), division (/), addition (+) and subtraction (-).



135 Using Serviceware Performance Analytics

You can create the following calculations:

General

Mathematical

Statistical

General functions

This section describes the general functions available in the calculator.

General  functions  can  be  either  static  or  dynamic.  For  more  information  see  Creating
dynamic functions.

Function Explanation

Variance This function calculates the difference between members:

( A - B ) 

This function verifies whether an expense tag was added. In
that case, A and B are switched.

Variance % This function calculates the difference between members in
percentages:

( (A - B) / B ) * 100

This function verifies if  an expense tag was added. If  this is
the case, the formula is

( ( B - A ) / abs ( B ) ) * 100

Growth This function calculates the difference between members:

( A - B ) 

This function verifies whether an expense tag was added. In
that case, A and B are switched.

Growth % This function calculates the difference between members in
percentages:

( ( A - B) / abs (B) ) * 100

This function does not verify if an expense tag was added.

Ratio This function divides members:

A / B
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Function Explanation

Round Rounds the  value  of  a  specified  member,  which  is  not  the
same  as  changing  the  number  of  decimal  places.  When
changing  the  amount  of  decimals,  only  the  display  code
changes. Using the Round function, the new value is used. In
this example, the
value is  rounded  to  1 decimal  place.  It  is  allowed  to  use  a
negative number of decimals.

Count This function counts the number of members entered in the
function:

Count (10, 20, 30) = 3

Missing values are not counted.

Distinct Count This  function  counts  the  number  of  distinct  values  in  the
function;

Count (10, 20, 20) = 2

Percentage  of  Total
(see note below)

This  function  calculates  the  percentage  by  which  the
selected members contribute to the selected Dimension.

Rank 
(see Note below)

This function assigns an order within a specified member.

Rank % 

(see note below)

This  function  assigns  an  order  from  1-100%  within  a
specified member. The rank is expressed as a percentage of
the highest rank.

Cumulative

 (see note below)

This  function  counts  the  cumulative  values  of  a  specified
member.

Cumulative % 

(see note below)

This  function  counts  the  cumulative  values  of  a  specified
member, expressed as a percentage of the final total.

Dynamic Total This  function  counts  the  total  number  of  members.  If  the
selection changes, the dynamic total will change as well.

Dynamic Count This  function  counts  dynamically  the  number  of  members
entered in the function:

 Count (10, 20, 30) = 3

Dynamic  Distinct
Count

This  function  counts  dynamically  the  number  of  distinct
values in the function: 

Count (10, 20, 20) = 2

Note: The results of the general  functions Percentage  of Total,  Rank, Rank %,  Cumulative
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and Cumulative % are derived from values of the Members on the opposite axis.

Statistical functions

This  section  describes  the  statistical  functions  available  in  the  calculator.  Statistical
functions can be either static or dynamic.

Note: Statistical functions are based on a population and not on a probability distribution.

Function Explanation

Average This function calculates the average value of  the specified
members.

Median This  function  calculates  the  median  of  the  specified
members.

Mode This  function  calculates  the  mode  of  the  specified
members.

Min This  function  returns  the  smallest  value  in  a  specified
range.

Max This function returns the largest value in a specified range.

Standard Deviation This  function  calculates  the  standard  deviation  of  the
specified members.

Statistical Variance This  function  calculates  the  statistical  variance  of  the
specified members.

Statistical Z This  function  calculates  the  statistical  Z  of  the  specified
member.

Dynamic Average This  function  calculates  the  dynamic  average  value  of
specified members.

Dynamic Median This function calculates  the  dynamic  median  value  of  the
specified members.

Dynamic Mode This function calculates the dynamic mode of  the specified
members.

Dynamic Min This  function  dynamically  returns  the  smallest  value  in  a
specified range.

Dynamic Max This  function  dynamically  returns  the  largest  value  in  a
specified range.

Mathematical functions

This section describes the mathematical functions available in the calculator.
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Function Explanation

Abs This  function  makes  a  value  of  a  specified  member
absolute. This means that negative becomes positive.

Power This  function  calculates  the  result  of  a  specified  member
raised to a power.

Square Root This function returns  the  square  root  value  of  a  specified
member.

Root This function returns the entered root value of  a specified
member.

Log This  function  determines  the  logarithm  of  a  specified
member.

Adding calculations

You can use the calculator in a view to create  calculations that return values that are  not
strictly defined by your cube and dimension structures.

For  example,  if  a  dimension  includes  the  members  Q1  and  Q2,  you  can  create  a
calculation that sums the values of these members to return a value for 1st Half Year.

Calculations that you create  can be used like  any other member. They can be formatted,
moved, used in other calculations, or used in the offspread.

Calculations do not have levels or generations.

Procedure
1. Select the MEMBER ribbon an click the Add button in the Calculation section,

or right-click a table and choose Calculator.

2. To enter a member name in the calculator, click the member in the data window.

3. To enter a mathematical operator in the calculator, click the corresponding operator
button.

4. To enter a number, click the appropriate number button.

5. To enter a function, click f(x),  and then click the desired function in the drop-down
menu.

6. After entering the entire calculation, click = to save the calculation and calculate  the
value.

Example: creating a calculation for the 1st Half Year
To illustrate a simple calculation, consider a dimension with the members Q1 and Q2.  The
following  steps  allow  you  to  create  a  calculation  for  1st  Half  Year,  the  sum  of  these
members.

Procedure
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1. Select the MEMBER ribbon an click the Add button in the Calculation section.

2. Click in the equation box on the calculator.

3. Click member Q1.

4. Click the + button.
If you do not press the + button or any other of  the operator buttons between two
members or values, a plus sign is added automatically.

5. Click member Q2.

6. Change  the  calculation  name  to  1st  Half  Year  in  the  Name  field,  located
immediately above the calculation box on the calculator.

7. Click the = button to add the calculation.
The calculation is added to your table. A new member called 1st Half  Year is added
to the columns and shows the sum of Q1 and Q2

The new calculation is stored when you save the view and will  be  available  the next time
you open the view.

Calculations are  added as members of  a dimension, but will  only  appear  in  this  view.  If
you look at the dimension in the Select Members dialog box, all calculations will be found
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at the end.

All  buttons respond to the same keys on your keyboard.  Pressing  the  +  key  will  make  a
plus sign appear in the calculator. If you move your pointer over the member you can see
its calculation in the tooltip.

You  can  also  view  the  calculation  by  right-clicking  the  member  and  choosing  Member
Information.

Nesting operations

In the calculator you can use nested operations. Using brackets, you can nest operations.

Creating a calculation with nested operations

As  an  example,  the  percentage  share  of  the  combined  regions  northern  Europe  and
southern Europe compared to the whole of Europe will be calculated.

For this calculation we need a formula that looks like this:

100 * (Northern Europe + Southern Europe) / All Europe

The function Ratio % is available and gives the same result, but is not used for the sake of
this example. See the section General functions.

In this example, the calculated member was formatted with a ‘%' sign.

Procedure
1. In a view, open the calculator.

2. Click 1, 0, and 0 to enter 100.

3. Click *.

4. Click (.

5. Click the member Northern Europe.

6. Click +.

7. Click the member Southern Europe.

8. Click ).

9. Click /.

10.Click the member All Europe.

11.Change the name to N+S % of Europe.

12.Click =.

The calculation is added.

13.Click x, to close the calculator.

Your table and its calculation look like this:
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Creating dynamic functions

General  and  statistical  functions  can  be  either  static  or  dynamic.  These  calculations
automatically change if the member selection changes.

The static functions do not change once a function is made.

Dynamic  functions  are  aware  of  each  other.  If,  for  example,  a  Dynamic  Total  and  a
Dynamic Max are added, the value of  the Dynamic Total  will  be  ignored when calculating
the Dynamic Max.

Be aware of the order of  calculations when using dynamic functions. It may be necessary
to adjust the order in which the calculations are performed. See Managing the calculation
sequence.

When  making  a  dynamic  calculation,  the  inspread  dimension  to  which  the  calculation
should be added, has to be chosen.

Procedure
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1. Open the calculator.

2. Choose a dynamic function, for example Dynamic Total.

3. Click =.

4. Select a dimension in the Select Dimension dialog box.

5. Click OK to confirm the chosen dimension.

Combining dynamic functions

With the dynamic functions, many combinations can be made.

In this section, you see an example  of  this.  A customized Dynamic Rank  is  created  using
the functions Dynamic Min, Dynamic Max and Rank.

The market for which the Sales values are  most unequally spread, will  give  ‘Rank  1'  as  a
result.  The  market  for  which  the  Sales  values  are  most  equally  spread,  will  give  the
highest rank as result.

For  this  example  we  assume  you  have  a  view  open  that  shows  the  children  of  Europe
vertically and the Net Sales Revenue of three months horizontally

Procedure
1. Open the calculator.

2. Click f(x).

3. Choose Dynamic Max and subtract Dynamic Min.

The calculation  is  added,  showing  the  difference  between  the  maximum  and  the
minimum value.

4. In the calculator, click f(x).

5. Choose Rank and select the calculation Difference.

6. Rename this calculation to Dynamic Counted Rank.
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The Rank is added to the member selection.

When selecting other members, these calculations will change accordingly.

It is possible  to make this dynamic rank in one calculation. The  formula  looks  like:
Rank (Dynamic  Max-Dynamic  Min)

Dynamic calculations can be moved to the offspread. The calculation will  remember
the selected inspread members.

Using relative and absolute members in functions

The  calculator  can  also  work  with  relative  members  as  opposed  to  absolute  members.
This means  the  calculator  will  include  members  based  on  their  position  in  the  rows  or
columns and not by name.

Before clicking on a member to insert it into the calculation, first switch on the R/C  button
in the calculator. This will enable the row/column mode. Members are  inserted relatively
until the R/C button is clicked again and the row/column mode is turned off.

In  the  next  example,  a  ratio  between  two  products  is  made.  The  two  products  to  be
compared are  the first  two  products  in  the  columns.  In  this  example  Cooking  Gear  and
Lanterns.

Procedure
1. In the calculator, click R/C.

2. Click the column Cooking Gear.

3. Click /.

4. Click the column Lanterns.

5. Change the name to Compare.

6. To add the calculation, click =.

The added calculation looks like this:

Products[1] / Products[2].
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Results
The Calculation shows relative members, based on position.

When changing the products in the columns to  Packs  and  Sleeping  Bags,  the  calculation
will automatically show the comparison between Packs and Sleeping Bags.

The selected members change and the calculation automatically shows new results.  The
calculation  itself  does  not  have  to  be  changed.  The  view  will  automatically  adapt  the
calculation to this new selection and display the correct results.

Note:

R/C  calculations  are  able  to  deal  with  positions  beyond  the  number  of  selected
members.  The  positions  beyond  the  number  of  selected  members  for  that
dimension will be taken as missing values.

If you have created an invalid calculation because the calculation includes itself,  the
calculation displays #error.

R/C calculations can be moved to the offspread. The calculation will  remember the
selected inspread  members.
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Creating cross-dimensional calculations

Calculations can also use member combinations rather than single  members. This allows
cross-dimensional calculations to be made

An  example  of  such  a  calculation  is  a  percentage  of  total  market  calculation.  Here  you
need to divide a certain member by a member for Market.

Procedure
1. In the calculator, click f(x).

2. Select the Ratio % function.

3. Click the member GROSS SALES REVENUE.

4. Click the member GROSS SALES REVENUE again.

5. Click the member All EUROPE.

6. Change the name to % of market.

7. Click =.

The calculation should look like this:
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Results
The result will be a column (or row) with the percentages compared to the total market.

Following the steps above, you can see that if you click a member and immediately after,
you click a member of another dimension, you can start specifying a combination.

All members of that combination are shown with an arrow (->) in between.

Alternatively you can click a cell  in the table. The calculator will  then insert all  members
in the table that make up the combination of this cell.

Managing the calculation sequence

When  multiple  calculations  have  been  added  to  a  view,  the  order  in  which  those
calculations  are  performed  may  become  important.  It  is  possible  that  a  result  of  a
calculation influences another calculation.

Procedure
1. Select the MEMBER tab in the  ribbon  and  click  the  expander  symbol  in  the  lower

right  corner  of  the  Calculations  section  or  right-click  in  a  view  and  select
Calculations.

The Calculated Members dialog box appears.

By  default  the  calculation  order  is  set  to  the  order  in  which  the  calculations  are
added.

2. To change the order, select a calculation  and  press  the  up  or  down  arrow  buttons

  .

3. Click Close.

Viewing calculations

You can view calculations in several ways.

The following ways are available:

By moving over a calculated member.

By right-clicking on a calculated member and selecting Member Information.

The Formula field displays the calculation.

If  the  member  is  not  displayed  on  the  screen  or  if  you  want  an  overview  of  all
calculations,  use  the  Calculated  Members  dialog  box.

Right-click in a view and select Calculations. 

The Calculated Members dialog box appears.
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Select the calculation you want to view and select Member Info. 

The Formula field displays the calculation.

Procedure
Move the mouse cursor over a calculated member. The tooltip displays the calculation.

Editing calculations that are visible

After creating a calculation you can edit it. To change a calculation you will need to open it
in the calculator. This section explains editing a calculation of a calculated member that is
displayed on screen.

Procedure
1. Right-click the calculated member for which you want to change the calculation.

2. Choose Calculator.

The calculation will now appear in the calculator and can be changed.

3. When you are ready with your changes to the calculation you can:

Activate the changes by clicking the = button.

Clear the calculation by clicking the C button.

Close the calculator by clicking the X button.

Note:  You  can  also  change  the  calculations  using  your  keyboard.  All  buttons  of  the
calculator  will  respond  to  the  corresponding  keys  on  your  keyboard,  including  the
Backspace key.

Editing calculations that are not visible

After creating a calculation you can edit it.  To change a calculation you need to open it in
the calculator. This section explains editing a calculation  of  a  calculated  member  that  is
not  displayed  on  screen.  A  calculated  member  can  be  not  visible  because  it  is  not
selected in the view.

Procedure
1. Right-click the view and choose Calculations.

The Calculated Members dialog box opens.

2. Select  the  calculated  member  for  which  you  want  to  change  the  calculation  and
click Open.

The calculation will now appear in the calculator and can be changed.

3. When you are ready with your changes to the calculation you can:

Activate the changes by clicking the = button.

Clear the calculation by clicking the C button.

Close the calculator by clicking the X button.

Note: You can also change  the  calculations  using  your  keyboard.  All  buttons  of
the  calculator  will  respond  to  the  corresponding  keys  on  your  keyboard,
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including the Backspace key.

Using multiple arguments in the Rank function

The  Rank  function  in  the  calculator  allows  you  to  assign  an  order  within  a  specified
member.

It  is  possible  to  use  multiple  arguments  in  the  Rank  function.  This  allows  you  to  rank
multiple members at once, in the order that they are specified.

Example: one argument in the Rank calculation
This example shows how to use one argument in the Rank calculation.

The screenshot shows one ranked member Quantity.

Rank  1  is  calculated  from  the  cell  values  of  member  Quantity  and  the  shown  camping
gear. Because the value 20 appears three times, rank 1 is applied three times.

The value 10 appears two times and is therefore applied two times starting at rank 4.

Example: multiple arguments in the Rank calculation
This example shows how to use two arguments in the Rank calculation.

The screenshot shows the situation where two members are ranked: Quantity and Return
and Allowances.
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The values of the calculation Rank 2 are determined by the following:

1. First the cell values of member Quantity are ranked.

2. For the values of  member Quantity that are  equal  for the shown camping goods,  a
second order that uses the member Return and Allowances is made.

Although the value 10 appears  twice  for  the  member  Quantity  and  the  shown  camping
goods, these values 10 rank differently. This is because the ranking of the member Return
and  Allowances  influences  the  ranking  of  the  values  of  the  member  Quantity.  This  is
similar for the value 20.

Example: multiple arguments in the Rank calculation with changed sign
This example shows how to use two arguments in the Rank calculation.

The screenshot show the situation when two members are  ranked: Quantity  and  Return
and Allowances.
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The  values  of  the  member  Return  and  Allowances  and  the  shown  camping  gear,  have
changed their signs from positive to negative. The reason for this could be that you want
the best-selling camping gear  with  the  lowest  number  of  returns  to  appear  high  in  the
ranking.

Deleting calculations that are visible

You can delete calculations that are visible in a view.

Procedure
1. Right-click the calculated member and choose Delete.

2. You will be asked to confirm the deletion of this member.

The  calculation  will  be  removed  from  the  selection  and  also  deleted  from  the
dimension. It will no longer be available.

If  the calculation is used in other calculations, these will  be  removed  as  well.  The
confirmation  will  give  a  list  of  all  those  automatically  deleted  and  dependent
calculations.

Deleting calculations that are not visible

You can  delete  calculations  that  are  not  visible  in  a  view.  A  calculated  member  can  be
invisible because it is not selected in the view.

Procedure
1. Right-click the view and choose Calculations.

The Calculated Members dialog box opens.

2. Select the calculated member you want to delete and click Delete.

3. You will be asked to confirm the deletion of this member.

The calculation will be removed from the selection and also deleted from the dimension.
It will no longer be available.
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If  the  calculation  is  used  in  other  calculations,  these  will  be  removed  as  well.  The
confirmation  will  give  a  list  of  all  those  automatically  deleted  and  dependent
calculations.

Printing Views

There are  many options for  printing  your  views.  In  addition  to  the  typical  print  options
you can preview the printing job, work with headers and footers,  and define page breaks
and a variety of other options.

Using the Print dialog box

This section explains how to print a view.

Note:

The settings in the Print dialog box  are  saved  on  the  local  machine  under  the  currently
logged on Windows user. However, this does not apply to the settings that can be made
under "Options". These are saved directly in the view.

Procedure
1. Open the view.

2. In the Backstage click on Print or from the toolbar, click the print icon   .

The Print dialog box displays:
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On the Print dialog box you can set the following details about your print job:

Printer Settings

To change the default printer setting for the selected printer,  click Change.  The
standard print setup menu displays where you  can  set  any  of  the  usual  printer
options such as paper  size,  paper  source,  and  other  properties  of  the  selected
printer.

Margins

To change the margins for the print job, click Margins.

The  Paper  Margins  dialog  box  displays  where  you  can  set  the  margins  or  click
Default to return to the default margins of .05 inches.

Orientation

The  default  orientation  is  portrait.  To  change  the  orientation  for  all  views  to
landscape, select Print Landscape.

To define a specific orientation for specific views, see Printing the same view for
multiple members.

Print range

To specify the amount of  material  to  print,  use  the  Print  Range  options  on  the
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Print menu. You can specify the material to print based on the views or using the
members:

o Views

To print the current view, select This View.

When This View is selected, the Options button becomes available  so you
can set specific print options for this view that are  distinct from the rest of
the table views.

To specify more than one view, select Some Views.

To print all views, select All Views.

o Member Range

By default, the members included in the print job are  those defined by the
Print  Range  views.  When  According  to  the  Print  Range  is  selected,  click
Print Range to specify the members to use for the print job. See Printing the
same view for multiple members.

To override the According to the Print Range and use the members defined
by the preview, select  As  displayed  on  the  screen  and  click  Preview.  See
Using the Print Preview.

Add

The  Add  options  specify  when  a  Front  Page,  Table  of  Contents,  Headers  and
Footers, Document Title, or a Front Page Image are added to the print job. When
these options are  selected, they are  generated  at  print  time.  The  alignment  of
Document Title and Image can also be defined here. To define their content, see
Using the Print Preview. To suppress these additional pages, clear  these boxes.

Print

When the print options are complete, select Print to initiate the printing.

Save as PDF

To save the print job as a PDF  file,  indicate  the  members,  print  range,  and  any
additional settings such as Table of Contents and Document Title  to be included,
and click Save As PDF.

Email as PDF

To e-mail PDF files click the Email as PDF button on the print menu.

Page Preview

The Page Preview area on the Print menu shows a  visual  representation  of  the
available views.

Preview

Click the Preview button on the Print menu to see a sample of how your print job
will look. See Using the Print Preview for more information.

Using the Print Preview

The print preview toolbar has buttons.

Button Purpose

Click  the  Print  button  to  specify  the  number  of  pages  to  print,  the
number of copies to print, and to initiate printing.
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Click the PDF button to save a view as a PDF or send the PDF as an e-
mail.

To send the print  preview  to  the  clipboard  in  EMF  format,  click  the
Copy button.

To return to the Print dialog box, click the Setup button.

Click the Full page to display the entire page.

In  print  preview,  click  the  magnifying  glass  to  continually  zoom  in.
Right-click the magnifying glass anywhere to zoom out. Use the drop
down menu to select a set zoom percentage.

Go to the First Page in the print preview.

Go to the Previous Page in the print preview.

Go to the Next Page in the print preview.

Go to the Last Page in the print preview.

Close the print preview.

Using the Print tab on the options dialog box

The  Print  Options  dialog  contains  3  panels.  Each  panel  contains  a  group  of  settings
defining how the view prints.
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Defining Headers and Footers

This section explains how to define headers and footers.

You can insert codes that generate  variable  data, for example  Document Name and Page
Number.

Code Meaning

#N Document Name

#v View Name

#V View Name including the path

#P Path of the View without the view name

#S Server Name

#B Database Name

#u User Name

#o Offspread

#f Scaling Factor Value
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#p Page Number

#n Number of Pages

#d Short Date

#D Long Date

#t Short Time

#T Long Time

#l New Line

#L(<Image Name>) Image

For example: Company #l Demo Database will be printed as: 

Company

Demo Database

When using the code #o, the following additional codes can be printed:

#o(n)  =  only  the  offspread  member  of  the  n-th  offspread  dimension  is  printed,
where n is a number.

#o(name) = only the offspread member of dimension name is printed, where name
is the name of the dimension.

#o(Time  Series)  =  the  offspread  member  for  Dynamic-Time-Series  is  printed
(Essbase only)

When using the code  #L(<Image  Name>),  specify  the  image  name  located  in  the  image
directory of the AL Server inside the brackets.

The image's height can be defined in the Styles > Printed  Fonts  >  Page  Header/Footer  >
Cell  Height.  The  width  of  the  image  will  be  adjusted  according  to  the  originial  image
height & width ratio.

Procedure
1. Click Print > Options.

2. For each section of the Header and Footer, enter the text you want to include.

Use the pull-down menu to insert  codes  that  generate  variable  data,  for  example
Document Name and Page Number.

Breaking Pages Based on Rows and Columns

When you have stacked dimensions in the rows or in the columns, you can print the table
per group.

Procedure
1. To specify the level at which column breaks occur in the print job, enter the level  to

use at the Print > Options > Layout > Column Breaks Level option.

The pull-down menu lists the available levels.
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2. Select Level 1 to use the first dimension, Level 2 for the second, and so on.

For example, if Product is your first dimension and you select Column Breaks Level
1, the pages will be divided in a page per group based on the most outer dimension,
that is, each product has its own page.

Follow the same procedure to set the Row breaks for printing using the Row Breaks
option on the Print > Options > Layout.

Note: When the groups are larger than one page, use the Fit to Page  option to make
each group have its own page.

Fitting a print job to one page

You can force your print job to fit onto a single page.

When you have a table and a chart on screen, the Fit To 1 Page option puts the table  and
the chart on one page.

Procedure
1. Select the Print > Options > Layout > Fit To Page option.

When this option is not selected the view uses the number of pages it needs.

2. This option must be set for each view.

By default, when a table and chart display on a screen, the printed version puts the
table  and  chart  on  separate  pages.  To  force  the  table  and  screen  onto  the  same
page, select Fit To Page.

Fitting to X by Y pages

You can specify the total number of pages to use.

You do this with the Fit to X by Y option. The first value entered is the width in number of
pages to use. The second value is the length in number of pages.

Procedure
1. When  both  the  Fit  X  by  Y  option  is  selected  and  Row  or  Column  Breaks  are

specified,  the  Row  and  Column  breaks  are  applied  first.  Then  the  Fit  to  X  by  Y
number of pages is used.

2. When  printing  a  view  as  few  pages  as  possible  are  printed.  This  means  when
entering a value of, for example, 3 by 2, and the table fits on one page, the print will
consist of only one page. Apart from the table, the print will  in this case  consist of  a
maximum of three pages wide and two pages long.

Note: 

It is not necessary to enter a number in both fields. When entering, for example,
only 3 in the first field, the  report  will  have  a  maximum  width  of  three  pages.
The length is automatically calculated by the number of pages needed.

The Fit To X by Y option does not work for charts.
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Printing comments

You can add existing view or cell comments to your printout.

For more information, see  Adding a comment.

When  comments  are  printed,  the  formatting  is  also  printed  (background  and  font
formatting).

Print View Comments

Procedure
1. Click Print > Options > Comments > Print View Comments.

2. Specify the position where you want the comments to print:

Before View

After View

On Same Page

The  option  On  Same  Page  is  available  only  when  Fit  To  Page  is  also  selected,  or
when the Fit to option is set to 1 by 1.

Print Cell Comments

Procedure
1. Click Print > Options > Comments > Print Cell Comments.

2. Specify the position where you want the comments to print:

Before View

After View

Please note that only the latest comment of a cell will be shown.

Specifying Table Headings, Offspread, Backgrounds, and Alignment in print jobs

You can specify the way table and offspread headings display in your print job.

Procedure
1. Click Print > Options > Layout.

2. You can select the following options:

Repeat Table Headings

By default the row and column headers repeat on all  pages of  a printed view. To
prevent the rows from repeating and having only the  first  page  display  column
and row headers, clear the Repeat Table Heading option.

Repeat  Offspread

By default, offspread members are repeated on larger views.

To prevent offspread members from being  repeated  across  all  pages,  clear  the
Repeat Offspread option.

Print  Background

By default the background of  the table  is formatted and printed. To prevent the
background formatting from being included when you print, clear this option.
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Center Table

By default the table is center aligned when printed. To align the table  to the left
instead, clear this option.

Indicating color

You can select the hue for printing jobs.

Procedure
1. Click Print > Options > Color & Styles > Color Settings.

2. You can select the following options:

Print in Color

Print in Gray Scale

Print in Black & White

Specifying the view orientation

By default all views print in Portrait mode.

To change the default orientation for all  views, select the Print Landscape option on the
Print menu.

Procedure
1. To  specify  a  different  orientation  for  a  specific  view,  open  the  view  and  set  the

Print Range > Views to This View.

2. Click the Options and select the orientation for this view only:

Default

Use  the  setting  made  on  the  Print  menu.  If  the  Print  Landscape  option  is
selected, use Landscape for this View. If it is cleared, use Portrait.

Portrait

Use Portrait for this view only.

Landscape

Use Landscape for this view only.

Printing the same view for multiple members

You can print the same view for more than one offspread member.

Procedure
1. Click the Print button.

2. At the Member Range option, select According to Print Range.

By default the selected members  are  the  same  as  the  offspread  selection.  In  this
way the print range selection changes when a member in the offspread selection is
changed.

3. To select the members, click Print Range.
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Define the dimensions to use and the way to print them using these options.

To reveal all dimensions, click Show All.

To print a dimension, select it and click Show.

To prevent a dimension from printing, select it and click Hide.  Please  note  that
members  of  hidden  dimensions  selected  here  will  be  hidden  in  Table  of
Contents.

To  specify  the  order  for  printing  dimensions,  use  the  up  and  down  arrow
buttons 

 to  arrange  dimensions  from  the  top  (prints  first)  to  the  bottom
(prints last).

To  select  multiple  members  as  selected  in  the  offspread  selection,  click  the
member and click Select.

Use  the  Reset  button  to  set  the  print  range  to  the  selected  members  in  the
offspread dimensions.

To sort the members, click the Order tab. See Sorting the order of members.

The number of combinations of Print Range members displays at the bottom of  the
Dimensions dialog.

To print a document with multiple  pages per view, use  the Print Range > According
to Print Range  option on the individual  views to set  their  individual  print  options.
The Page preview shows that the view will be printed with multiple pages.
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Page Numbering in Wide Views

When a view  is  wider  than  one  page,  the  page  numbering  is  adjusted  first  across  then
down.

If, for example, your view is six  pages wide and four pages long, the numbering starts on
the top left page and proceeds in a horizontal  and successively in a vertical  way until  the
last page is reached, as shown here:

Printing an audit report

If an audit report is available for your view, you can print it. See Enabling audit reports.

Procedure
1. Click the Print > Options > Layout > Print Audit Report.

Using Print Ranges with DynaSelect

You  can  use  the  DynaSelect  automated  tasks  feature  along  with  the  Print  options  to
automatically prepare views for printing.

When you use the According to the Print Range, print option, the DynaSelect applies to all
the members you select.

Comments

Comments  allow  you  to  attach  text,  images  or  files  to  a  view  or  a  specific  cell.  The
availability of  the comments ribbon or certain options within  the  ribbon  can  vary  based
on authorization and security settings.

Note: It is not possible to add comments to calculated members or attribute dimensions.

Comments Panel

The  Comments  Panel  will  appear  by  choosing  one  of  the  four  possible  options  in  the
Panel Position section. The options are:

Left

Right
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Top

Bottom

Clicking the selected position again  will  make  the  Comments  Panel  disappear.  Saving  a
also saves the Comments Panel settings. This includes both the position and the visibility.

Display Options
Comments are displayed in ascending order sorted by creation date. Date  and User name
of the last editor are saved for every comment. Comment content not exceeding a certain
length  will  be  fully  displayed.  Any  additional  content  will  be  hidden.  The  option  Read
more at the bottom of the comment will make the complete content visible.

Comments Tab
The Comments Tab displays the view or cell  comments based on the chosen context. The
Cell context displays comments of the cell that is currently selected.

Descendants Tab
The Descendants Tab is only visible for the Cell context. This tab displays comments for all
descendants of the current cell. Please note that only the latest comment of  a cell  will  be
shown.

Comments Editor
The comments editor contains a toolbar and a text area

Toolbar

The toolbar offers the following functionality using buttons and dropdown menus:

Save

This function will save the comment and close the editor.

Font family / Font size

Bold / Italic / Underline

Text color / Background color

Text alignment

Clean formatting

This function clears all formatting for the selected text.

Styles

This function lets you apply predefined style templates to the selected text.

Merge comments

This function combines the comments of all descendants within one dimension into
a new comment that will then be attached to the current cell.  The dimension has to
be chosen when using this function. The original  comments are  not deleted. Please
note that only the latest comment of a cell will be shown.

Attachments

This function allows to attach one or multiple  files to  a  comment.  When  attaching
files the maximum file size and allowed file  types should be considered. These can
be configured in the comment settings in the AL Explorer. If  any of  these conditions
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are  not  met  a  warning  is  displayed  and  the  user  is  prevented  from  saving  the
comment.

Text Area

The text area allows fast and easy editing of comment content. The maximum text length
can be limited in the comment settings.  When  exceeding  that  limit,  a  warning  showing
the  current  text  length  and  the  maximum  text  length  will  be  displayed.  Saving  the
comment  will  not  be  possible  while  the  length  exceeds  the  limit.  The  text  area  also
allows  to  paste  text  or  pictures  from  the  clipboard.  Using  this  functionality  embeds  an
image within the text rather than adding an attachment.

Context

Comments can be added for the following context options:

Cell

View

Grid Comments

Adding grid comments
Grid  comments  offer  the  possibility  to  display  the  latest  comment  of  a  member  in  an
additional table column or row.

Procedure
1. Click on Add grid comment

2. Click  on  the  column  or  row  header  of  the  member  that  you  want  to  add  a  grid
comment for.

A new comment column or row will be added.

Removing grid comments
Existing  grid  comments  can  be  removed.  Removing  a  grid  comment  only  removes  the
comment column or row from the table, it does not delete the comments.

Procedure
1. Click on Remove grid comment

2. Click on the comment column or row header that you want to remove.

Display logic of grid comments
Grid comments only show the text of  the  latest  comment  of  each  element.  Formatting,
pictures or attachments are not displayed. 

A comment will be displayed until

a new comment is created for the element.

the current displayed comment is modified.

the current displayed comment is deleted.
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Note: Should the latest comment of  an element not contain any text (e.g. comment only
contains a picture),  the second latest comment will  be  displayed instead if  containing at
least one text character. If  no comment containing text exists for an element, the cell  in
the comment row or column does not display anything.

Settings

Highlight
Activating  this  option  will  highlight  any  cell  that  either  has  a  comment  defined  or  has
descendants with comments. The following symbols will appear:

Cell contains a comment yellow speech bubble icon

Descendant(s)  of  the  cell  contains  a
comment

white speech bubble icon

Cell and descendant(s) contain a comment yellow  and  white  speech  bubble  icon
(stacked)

Full Date and Time
Activating  this  option  will  display  an  absolute  date  and  time  for  each  comment  (e.g.
"18.09.2016 13:37") rather than the time span that has elapsed since the last modification
(e.g. "5 minutes ago").

Show context
Activating this option will display the current context (of the cell or view) at the top of the
Comments Panel.

Value changed hints
When saving a cell  comment the current value of  that cell  will  also  be  saved.  Activating
the option Value  changed  hints  will  display  a  warning  in  the  Comments  Panel  that  the
value  has  changed  since  the  comment  has  last  been  modified.  It  will  also  display  the
original value of the cell.

Adding a comment

Procedure
1. Activate the Comments Panel by selecting an option in the Panel Position section.

2. Click into the text box "New comment..."

The comments editor will open.

3. Write a comment.

4. Click on the Save button.

The comment will be saved and displayed on top of the list.

Adding a View comment

With a view comment it is possible to define a view specific description to a view.
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Procedure
1. Activate the Comments Panel by selecting the COMMENTS tab in the ribbon menu.

2. In the Context section click the View button.

The comments editor will open.

3. Write a comment.

4. Click on the Save button.

The comment will be saved and displayed on top of the list.

Modifying a comment

Procedure
1. Activate the Comments Panel by selecting an option in the Panel Position section.

2. Click on the arrow at the top right position of the comment.

3. In the menu that opened click on Edit.

The comments editor will open.

4. Edit the comment.

5. Click on the Save button.

The comment will be saved and displayed on top of the list.

Deleting a comment

Procedure
1. Activate the Comments Panel by selecting an option in the Panel Position section.

2. Click on the arrow at the top right position of the comment.

3. In the menu that opened click on Delete.

A confirmation popup will ask if you really want to delete the comment.

4. Click on Yes.

The comment will be deleted.
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5.  Using AL Anywhere

AL  Anywhere  is  a  client  containing  limited  functionality  that  will  be  enhanced  in  the
future.

It  has  been  designed  and  implemented  to  run  on  multiple  devices,  such  as,  desktops,
laptops, tablets and smart phones.

The AL Anywhere client can be started by  calling  the  following  URL  in  a  supported  web
browser.

Example: https://<SERVERNAME>/EVAnywhere

Devices and Screen Size

The client has been designed and implemented to target different devices, for example,
desktops,  tablets  and  smart  phones.  Depending  on  the  screen  size  of  the  device,  the
layout will change slightly to make optimal use of space. 

Examples:

On a smart phone, the tabs are  available  through a drop down menu, on a desktop
they are always visible. 

The backstage menu is always visible  if  there  is  enough  space,  it  is  collapsed  and
has to be expanded on small devices. 

On smaller screens there are only icons displayed in the menu, and no text.

Add To Home Screen

When  using  tablets  and  smart  phones,  for  the  best  possible  user  experience  it  is
recommended that  Anywhere is added to the home screen.

This improves the look and gives the same feel as using a native app.

Gestures and Device Input

There are a number of touch gestures supported to enhance the user experience.

The following inputs are supported on desktops, tablets and smart phones.

Please note, on Windows touch based devices, sometimes Tablet Mode may need to be
activated for the best possible user experience.

Action Function (Area) Description

Tap / Left Click

Members in table rows Opens the member select dialog

Members in table
columns

Opens the member select dialog

Members in offspread Opens the member select dialog

Members in chart Opens the member select dialog

https://<SERVERNAME>/EVAnywhere
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Menu items Performs an action for example, swapping
between table and chart, or opens further
dialog

Options in the options
dialog

Option settings are changed, such as suppress
rows and columns, or drop down menus are
opened

Buttons in dialogs Dialogs such as the member selection and
options dialog contain a number of buttons. For
example, OK, Cancel or Apply. These buttons
can be tapped

On views in backstage
area

Views can be opened by tapping on them

Search and text input Tapping on a text input field, for example the
search in the member select dialog will open
the device keyboard

Long Tap / Right Click

Members in table
(while calculator is
open)

Opens the member select dialog for the
calculator

Drag Select ( Tap and Drag / Left Mouse Down and Drag )

Members in the
member select dialog

Finger / Mouse can be dragged over members
in the member select dialog to select or
deselect

Drag and Drop ( Tap and Drag / Left Mouse Down and Drag )

Members in table rows Swap members or dimensions

Members in table
columns

Swap members or dimensions

Members in offspread Swap members or dimensions

Members in chart ( axis
/ legend / chart
element / chart
offspread / small
mulitple row and
column headers )

Swap members or dimensions

Resize areas ( Tap and Drag / Left Mouse Down and Drag )

Splitter between Table
and Chart

Resize Table / Chart area

Left border of
options / member
select dialog

Resize dialog

Resize cells ( Left Mouse Down and Drag - Mouse only )
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Members in table rows Resize cell height or width

Members in table
columns

Resize cell height or width

Views

All member selections and options are stored in an item called a "View".

Opening Views

To open a view, navigate to the view you wish to open and click or tap on the item.

The following view locations are supported:

Recent Views

Contains a list of recent views that have been opened

Shared Views

Contains a list of views from the shared repository

My Views

Contains a list of views for the logged in user

Shared Templates

Contains a list of view templates from the shared repository

My Templates

Contains a list of view templates for the logged in user

Please note that local views are not supported. 

Searching for Views

It  is  possible  to  search  for  views  in  My  Views  and  Shared  Views.  The  search  is  case
insensitive  and  always  searches  in  the  current  selected  folder  and  child  folders.  All
elements that contain the value entered into the Search Field will be shown in the results
list.

Saving Views

There are two possibilities for saving a view:

Save

If you are  authorized to save a specific view, you may use the "Save" button in the
Backstage menu.

Save As

If you have the generic authorization to save views under a different name (even if
you  might  not  be  allowed  to  change  the  original  view),  you  will  be  offered  the
menu option "Save As" in the Backstage. This menu allows  you  to  choose  a  folder
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and  a  name  for  the  new  copy  of  the  view  (it  will  only  show  folders  that  you  are
authorized to save to).
Saving  a  view  inside  the  "Shared  Templates"  or  "My  Templates"  location  will
automatically save it as a view template. Vice  versa, saving a view template  in any
of the non-template locations will save it as a view.

Closing Views

If  you  want  to  close  a  single  view,  you  can  do  this  for  the  currently  displayed  view  by
clicking / tipping on the X next to the name in the open document tabs.

If  you  want  to  close  all  open  views,  you  can  use  the  menu  option  "Close  all"  in  the
backstage.

For both options, you will be asked if you want to save open changes, if applicable.

Applying Templates to Views

The AL Anywhere supports applying a view template to an existing view.
This is done by going to the "Format" tab and clicking on "Templates", which will open a
dropdown-menu with all your available templates from both the "Shared Templats" and the "My
Templates" location.

Clicking on a template will then automatically apply all the styles defined in the view template to
the current view.

Please note that so far only general formatting options are supported for view templates in AL
Anywhere. Member-, Generation- and Level-specific formats in view templates will not be
applied.

Menu

The menu is visible across the top of the device display.

The menu items are grouped into the following tabs:

Navigate

Contains all the functionality related to view navigation

Member

Contains the calculator

Layout
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Contains all the functionality related to view layout

Chart

Contains all the functionality related to the chart

Format

Contains all the functionality related to formatting

Quick Menu

Offers icons to quickly undo, redo, reload the view or switch to fullscreen mode

Navigate

This menu contains all view navigation functionality.

The following items are currently available:

Suppress Rows

Suppress missing rows

Suppress Columns

Suppress missing columns

Export Data

Opens the export data dialog

Comments

Opens the comments dialog

Options

Opens the navigate options dialog

Member

This menu contains all member functionality.

The following items are currently available:

Calculator

Databars

Sparklines

Layout

This menu contains all view layout functionality.

The following items are currently available:

Table

Shows the table only

Chart

Shows the chart only

Both
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Shows the table and chart at the same time

Title

Shows or hides the title

Offspread

Shows or hides all offspread selections

Options

Opens the layout options dialog

Chart

This menu contains all chart functionality.

The following items are currently available:

Chart Type

Will open a drop down menu to select a different chart type

Display Values

Shows or hides values in the chart

Legend

Shows or hides the legend

Merge Columns

Activates or de-activates the "Merge Columns" functionality

Merge Rows

Activates or de-activates the "Merge Rows" functionality

Small Multiple

Activates or de-activates the "Small Multiple" functionality

Color

Will open a drop down menu to select a different color palette

Options

Opens the chart options dialog

Format

This menu contains all format functionality.

The following items are currently available:

Templates

Select one of your available templates to apply it to the current view.

Decimals

The number of decimals to display for number values. 

Show data in 1000

Toggles the default scaling factor to 0.001 to show data in thousands.

Indent row headers

Indent the row headers using the string specified in the options.



172Using AL Anywhere

Show Icons in Headers

Shows the icons in the headers.

Options

Opens the format options pane. 

Quick Menu

The quick menu contains general options that are needed on a regular basis.

The quick menu contains the following menu items:

Undo

Performs an undo operation on the last performed action

Redo

Performs a redo operation on the last performed action

Reload

Reloads the stored version of the view

Full Screen

Displays the current view in  full  screen  mode,  this  is  especially  useful  on  smaller
devices.

To return, press the icon again.

Members

Members can easily be added, removed or moved within a view.

Selection

To open the member selection dialog, tap or click on a member in  the  view.  This  opens
the member selection dialog for the dimension that the member belongs to. For example
"Products".

To  add  a  new  member,  click  or  tap  on  the  member  you  wish  to  add  to  the  view.  The
member will be highlighted, indicating that the member will be added to the view.

To  remove  a  member  from  the  view,  click  or  tap  on  a  selected  member  (highlighted
member). The member will  no longer be highlighted indicating that the member will  be
removed from the view.

It is possible to drag select with the mouse or finger and select more than one member at
a  time.  This  is  especially  useful  when  adding  or  removing  information  quickly,  for
example adding 3 months of a quarter in one go.

The following buttons are available to manipulate the selection quickly.

Lowest From *

Selects the lowest members from the selected member

All Lowest *

Selects all members on the lowest level

Select All

Selects all the members

Deselect All
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Removes all the member from the selection

Expand All

Expands all members to display all descendant members

Collapse All

Collapses the member tree

To apply the changes from the member selection the OK button can be used.

To apply the changes and keep the member selection dialog open, the Apply button can
be used.

Changes can be canceled by using the Cancel button.

* Those buttons are additive - meaning that the selection will be added to the already existing
selection.

Hierarchies

The AL Anywhere can select alternate hierarchies of dimensions via the Member Select.
When opening the Member Select on a dimension that has multiple hierarchies, you can select
a hierarchy by clicking on the dropdown-arrow at the top.

This will open a dropdown-menu with all the available hierarchies.
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Search

It is possible  to search for members in  the  member  selection  dialog.  The  search  results
are  displayed  based  on  the  text  that  is  entered  into  the  search  field.  Simply  select  or
deselect members within the search result.

It is possible  to perform a Select All  or Deselect All  on the search results.  The action will
be additive for this case.

Order

The order of  the selected members  can  be  changed  using  the  order  tab.  To  change  the
order of the members, select the member and click the Move Up or Move Down buttons.
It  is  possible  to  select  multiple  members  at  the  same  time  and  move  them  with  the
buttons.

Keep Selection keeps only the selected members in the selection.

Remove Selection removes the selected members from the selection.

Chart

It  is  possible  to  have  members  visible  in  the  table  but  hidden  from  the  chart.  This  is
especially  useful  when  yearly  totals  are  included  in  the  table  but  a  trend  over  time
comparison is required in the chart.

Clicking  on  the  members  in  the  chart  shows  the  member  select  dialog.  The  dialog
contains a tab called Chart.  If  the  member is highlighted it will  be  shown  in  the  chart  &
table. If  the member is  not  highlighted  it  will  not  be  shown  in  the  chart,  but  it  will  be
shown in the table.

Calculations

The calculations can be reached by clicking the MEMBER > Calculator ribbon menu.

It opens a panel with two tabs.

Note:  Calculator  panel  can  only  be  opened  on  devices  that  provide  a  virtual  screen
resolution of 700 x 700 pixels or more.

Calculator Tab
In this tab there is the calculator panel in which you can define a formula.

List Tab
In this tab you can organize your calculations.

The Calculator Panel

Name Field
The calculatur panel consists of a name field where the name of  the calculation can
be entered.

Formula Editor
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Below the name field there is a formula editor. Here the user can enter the formula
formula with digits, operators, functions and members.

Function Buttons
Below the formula editor there  is a row of  calculator  buttons,  that  gives  access  to
the calculator's functions.

Key Pad
The last area of the panel is the key pad that gives the user to enter formulas.

The Name Field

The name field can contain UTF-8 characters and must be unique within the dimension.

 

It  is  not  allowed  to  have  the  same  name  of  a  calculation  within  one  dimension
twice.

It is allowed to have the same name of a calculation in different dimensions.

It  is  not  allowed  to  give  the  calculation  the  same  name  as  the  internal  member



176Using AL Anywhere

name of a member within the dimension.

It is allowed to give  the calculation the same name as an  alias  name  of  a  member
within the dimension.

The Formula Editor

In the formula editor a calculation formula can be defined.
If AL Anywhere is used on a Desktop Browser, you can also use the keys on your keyboard.
Only the keys that are available on the key pad are allowed in the calculation editor and
also the backspace key.

If AL Anywhere is used on a touch device the software keyboard is suppressed. Formulas
can only be entered by using the key pad.

A calculation consists of different tokes. Tokens are numbers (123...) , operators (+, -, /) or
function names.

If the formula is invalid, the first symbol of the invalid formula is red as well as the rest of
the tokens in the formula.

On the bottom of the formula field there is a function hint. It gives basic information
about the currently focused function.

In the screen shot below the function hint reads Ratio %(Profit, Sales)
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The Functions Keypad

Below the formula editor there are five buttons.
From left to right these are

Variance() function

Variance %() function

Ratio() function

Ratio %() function

Functions Menu

5.7.1.3.1  The Functions Menu

By clicking the functions menu, the key pad will be replaced by a list of function
categories, such as Standard, Statistical, Mathematical, Dynamic and Other.
By clicking one of these categories a second menu will show with the different functions.

The screenshot as an example shows the Standard category and its functions.
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Next to the functions name there is an info button. Clicking this button leads to the
function's descriptions, where the use of the functions is described.

Furthermore on top left there is an back arrow, to return to the previous function sub
menu and also an X to close the functions window and directly return to the key pad.

By clicking one of the names the specific function can be added to the formula editor.
When the information button is pressed in the function description panel there is also an 
INSERT button to add the function to the formula.

The Calculator Keypad

The calculator keypad has the following keys

The numbers 0 - 9 to add values

A point (.) to write decimal numbers

A comma (,) to separate function parameters

The operations plus (+), minus (-), divide (/), multiply (*)

Parenthesis for the formula and also for functions

Left and right arrows to move the cursor to the previous / next token

The DEL button is used to delete the token after the current cursor position

The C button is used to delete the complete formula

The R/C button is used to toggle between normal mode and Row/Column mode

Equals (=) to save the current formula. This key can only be pressed if the formula of
the calculation is valid
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5.7.1.4.1  The R/C Button

When the R/C button is not clicked, members are referenced by its name in the formula.
This is the default.
When the R/C button is clicked, members are referenced by their ID within the grid,
starting at index 1.

R/C and normal mode can be combined in one formula.

The Calculation List

The calculation list shows all calculations that are available in the current view.

The order of  the calculations in the list represent their evaluation order. This means the
first calculation will be evaluated first, the second will be evaluated second and so on.

The List tab has the following buttons:

NEW
Create a new empty calculation

EDIT
Edit the currently selected calculation in the Calculator panel

RENAME
Rename the currently selected calculation by opening a rename dialog

DELETE
Delete the currently selected calculation(s)

MOVE UP
Move the selected calculation(s) up in the list to change their evaluation order

MOVE DOWN
Move the selected calculation(s) down in the list to change their evaluation order

Working with calculations

The following section gives a brief description how to define a calculation

Creating a calculation

Click on MEMBER > Calculator

Enter a name in the name field

Click members in the grid or offspread to add items to the formula

Use the keypad to enter numbers, operators and functions

Click "="

Editing a calculation

Click on the small calculator icon in the grid / offspread

or

Click on MEMBER > Calculator
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Select the List Tab

Select a calculation

Click EDIT

Cross Dimensional References

Cross dimensional references are used to lock certain coordinates of your cube. 

Imagine you have a grid like

Market: East

Product: Cola

Year: Year 2020

By clicking the grid items after another (East, Cola and Year 2020) the calculator will  create
the following element in the calculation editor: East->Cola->Year 2020

Adding Members that are not visible at the moment

It might be required that the calculation should also contain a member that is not visible
in the grid at the moment.

It  can  be  done  by  performing  a  right  click  /  long  tap  on  a  member,  while  being  in  the
Calculator Panel.  By that an additional  member select panel  will  open, where a member
of the clicked dimension can be selected. 

Exporting Views

The AL Anywhere can export views to one of these supported file types:

PDF

XLSX

CSV

You can find the dialog to configure the export options by going to the "Navigate" tab and
clicking on "Export Data".

A detailed description of all the options that can be configured in this dialog can be found in the 
Printing Views chapter.
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If you have multiple views opened, an additional accordion will appear in the "General" tab.

Here you can configure which of the opened views you want to include in your exported report.

Please note that not all configuration options are supported for all of the available file types,
however when selecting the file type, the unsupported options will become disabled
automatically.

Comments

There is a commenting feature available for the AL Anywhere to link text comments to data
cells. 

You can find the panel to manage cell comments by going to the "Navigate" tab and clicking on
"Comments":

You can manage comments by selecting different cells with the panel opened. Cells with
existing comments are highlighted when the panel is open.

Notes

Please be aware that this is a different comments implementation than the one in the AL client.
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This means that not all features are already available.
Not yet available are rich text formatting and attachments for cell comments.

Attention: You can view existing comments created with the comments feature in the AL client
(stripped from any rich text formatting) but editing and saving the comments in the AL Anywhere
will remove the rich text permanently.

Charts

The following chart types are supported:

Bar

Line

Area

Pie

Radar

Bubble

Scatter

Range

Dial

PowerBI Visual

The AL Anywhere is available as a Visualization for Microsoft Power BI. 

The Performance Analytics Setup and Installation Guide describes how to setup and install the
visual. For the following description, we assume that the Visual is available in Power BI.. 

Overview

The  Serviceware  Performance  Analytics  Visual  allows  to  add  multi-dimensional  data
retrieved via the Performance Analytics server to a  Power  BI  report.  The  Visual  is  using
the AL Anywhere client and it's API to allow an interaction between Power BI and the AL
Anywhere. 

The typical  Use-Case is to open up  a  specific  Performance  Analytics  view  and  provide  a
point of view from Power BI.  Furthermore, the Visual  allows to use  the full  functionality
available to the AL Anywhere inside Power BI while  configuring which options should be
available to a consumer.

The  Power  BI  Visual  supports  the  same  languages  as  the  Serviceware  Performance
Analytics.

Getting started
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1. Add the Performance Analytics Visual to your report. 

2. In the format tab, you can now configure  the connection to the Performance Analytics
server. 

Note that you do not need to specify a port if you use the default port (80 for http, 443 for
https). 

Your AL Anywhere should show the login screen / backstage now and is ready to be used.

Configuration

Connection: Configure  the Connection to the Performance Analytics server. All  data  is
loaded  live  from  the  server  and  the  visual  cannot  work  without  a  connection.  The
connection must match the Endpoint  configured  for  the  REST  API  of  the  Performance
Analytics server. Note that you do not need to specify a port if  you use the default port
(80  for  http,  443  for  https),  i.e.  you  just  need  the  hostname  (e.g.  "localhost",
"myserver")  for  the  connection,  but  you  can  also  add  a  port  ("localhost:7111",
"myserver:9000").

Permissions: Control  the UI (e.g. hide the menu)  as  well  as  the  behavior  (e.g.  disable
changing the selection) of the AL Anywhere. This allows to display a view in "read-only"
mode if you disable all options.

Views: Allows to specify the path to a view that is opened when loading the visual.  You
can  right-click  a  view  in  the  backstage  to  copy  the  path  of  the  view  to  the  clipboard
(works only with https connections). Note that if you specify in the permissions to hide
the  backstage,  it  is  strongly  recommended  to  specify  a  view  here.  If  you  configure  a
member selection, it will be applied to the view upon loading.

Dimensions / Members (on the fields tab): Allows  to  use  the  data  inside  Power  BI  to
specify a member selection for the view that is currently open. 
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o Add the columns containing the member names to the Members field.

o For  each  column  that  you  added,  add  the  dimension  name  to  the  Dimensions
property.  Note  that  the  Dimensions  property  is  a  comma-seperated  list  of
dimensions. 

The  dimensions  must  appear  in  the  same  order  as  the  member  columns.  The  member
columns must contain the member names (it does not work with aliases). 

Note that a dimension can appear multiple times, to merge the selections together.
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Now you can apply filters or  slice  the  data  inside  Power  BI.  The  resulting  members  are
passed  to  the  Visual  and  will  be  applied.  Note  that  for  Ingrid-Dimensions,  it  will  only
apply to the default selection, not to asymmetrical selections.

Applying filters through a flatlist
One of the ways we can have data represented is by a table where every member is listed
together with its parent.
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Based on this, we can  pass either a single selection (e.g. for the offspread), 

or a multiple selection (for the inspread)  to our visual.

Applying filters through a hierarchy
There's also the possibility of having the data in a table  where every column represents a
generation.
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Based on this model, in order to select a single  member, the Single selection  switch must
be ON.

Example: Single member selection

As  it  can  be  seen  in  the  screenshot  above,  when  selecting  the  member  "Colas"  in  the
slider from the left, it's children are also selected, but because the  Single selection  switch
is on, the selection that is passed to the view is only the "Colas" member. Based  on  the
order of  the columns passed to the visual,  the member of  the last dimension containing
only one member will be selected. In the example, there  are  multiple  members selected
for the third column, but only one (Colas) for the second column.

Example: Multiple member selection

If  we want to pass  a  multiple  selection,  the  Single  selection  switch  must  be  OFF.  In  the
screenshot above, the members Cola, Root Beer and its children are  selected and passed
to the visual but, due to a limitation of PowerBI, their parents (Colas and Product) are  also
selected.
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Note that if  you don't want "Product" to be selected, you should only  pass  generation  2
and 3 to the visual and the first generation will always be excluded.

Sorting the selected members
It is possible to have the members sorted by one of the next criteria:

- Power Bi Custom - keeps the order provided by Power BI

- Outline Order - sorts members according to the outline order in the database.

- Reverse Outline Order -  sorts members in a reverse  way according to the outline  order
in the database.

- Sort - sorts members alphabetically.

- Reverse Sort - sorts members in reverse alphabetic order.

- Sort within Hierarchy - sort members in ascending or descending order, while  respecting
the dimension hierarchy.

- Reverse Sort within Hierarchy - members are sorted in reverse  alphabetical  order within
their hierarchies

Known Differences

While most of the views look very similar in  AL Anywhere and the Desktop Client,  there
are some differences that one should be aware of: 

Handling of 3D borders.

At most one border is displayed between cells.  Hence, spacing required for the 3D
effect  are  not  shown  in  Anywhere.  One  can  achieve  the  3D  effect  by  manually
adding spaces between the elements. 

Personalized Outlines

The AL Anywhere supports personalized outlines. Depending on your database and datasource
configurations users that have restricted access to certain members in an outline will now either
see those members as labels (without data behind them) or not at all.
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6.  Notices

Subject to change without notice.

All  rights  reserved.  No  part  of  this  document  may  be  reproduced,  translated  or
transmitted  in  any  form  or  by  any  means,  electronic,  optical  or  mechanical,  including
photocopy, recording, or any information storage system, for any purpose other than the
purchaser's personal use, without the prior written consent of cubus AG.

cubus  AG  assumes  no  responsibility  for  typographical  errors  or  inaccuracies  in  this
documentation or for the use, reliability, interoperability, merchantability, or fitness for a
particular  purpose  of  the  software  product  and/or  programs  described  herein.  This
manual is subject to periodic updates. cubus AG reserves the right to modify,  augment, or
improve this document as well as the products and/or programs described herein.
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7.  Trademarks

Microsoft, Excel,  Windows and Windows Server are  trademarks or registered trademarks
of Microsoft Corporation.

All  other  names  of  companies,  products  and/or  services  are  trademarks  of  their
respective owners.

The following terms are trademarks or registered trademarks of other companies:

Adobe,  the  Adobe  logo,  PostScript,  and  the  PostScript  logo  are  either  registered
trademarks or trademarks of Adobe Systems Incorporated in the United States, and/
or other countries.

Microsoft,  Windows,  Windows  NT,  and  the  Windows  logo  are  trademarks  of
Microsoft Corporation in the United States, other countries, or both.

Hyperion  and  Essbase  are  registered  trademarks  and  Hyperion  Solutions  is  a
trademark of Oracle.

IBM,  the  IBM  logo,  ibm.com,  TM1,  and  Cognos  are  trademarks  or  registered
trademarks  of  International  Business  Machines  Corp.,  registered  in  many
jurisdictions worldwide. 

Java  and  all  Java-based  trademarks  and  logos  are  trademarks  or  registered
trademarks of Oracle and/or its affiliates.
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